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MANUAL PURPOSE AND STRUCTURE

Windows Users

The documentation explains and describes how to use the M16C toolchain
to program an M16C MCU.

You can use the tools either with the graphical Embedded Development
Environment (EDE) or from the command line in a command prompt
window.

Structure

The toolchain documentation consists of a User's Guide (this manual)
which includes a Getting Started section and a separate Reference Guide.

First you need to install the software and make it run under the licence
manager FLEXlm. This is described in Chapter 1, Software Installation and
Configuration

After installation you are ready to follow the Getting Started in Chapter 2.

Next, move on with the other chapters which explain how to use the
compiler, assembler, linker and the various utilities.

Once you are familiar with these tools, you can use the Reference Guide
to lookup specific options and details to make full use of the M16C
toolchain.
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SHORT TABLE OF CONTENTS

Chapter 1: Software Installation and Configuration

Guides you through the installation of the software. Describes the most
important settings, paths and filenames that you must specify to get the
package up and running.

Chapter 2: Getting Started

Overview of the toolchain and its individual elements. Describes the
relation between the toolchain and specific features of the M16C. Explains
step-by-step how to write, compile, assemble and debug your application.
Teaches how you can use projects to organize your files.

Chapter 3: C Language

The TASKING M16C C compiler is fully compatible with ISO-C. This
chapter describes the specific M16C features of the C language, including
language extensions that are not standard in ISO-C. For example, pragmas
are a way to control the compiler from within the C source.

Chapter 4: Assembly Language

Describes the specific features of the assembly language as well as
'directives', which are pseudo instructions that are interpreted by the
assembler.

Chapter 5: Using the Compiler

Describes how you can use the compiler. An extensive overview of all
options is included in the Reference Guide.

Chapter 6: Using the Assembler

Describes how you can use the assembler. An extensive overview of all
options is included in the Reference Guide.

Chapter 7: Using the Linker

Describes how you can use the linker. An extensive overview of all
options is included in the Reference Guide.

Chapter 8: Using the Utilities

Describes several utilities and how you can use them to facilitate various
tasks. The following utilities are included: control program, make utility
and archiver.



Manual Purpose and Structure XIII

• • • • • • • •

Appendix A: Flexible Licence Manager (FLEXlm)

TASKING products are licensed through FLEXlm. This chapter provides
information about this license system and how to solve possible problems.
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CONVENTIONS USED IN THIS MANUAL

Notation for syntax

The following notation is used to describe the syntax of command line
input:

bold Type this part of the syntax literally.

italics Substitute the italic word by an instance. For example:

filename

Type the name of a file in place of the word filename.

{ } Encloses a list from which you must choose an item.

[ ] Encloses items that are optional. For example

cm16c [ -? ]

Both cm16c and cm16c -? are valid commands.

| Separates items in a list. Read it as OR.

... You can repeat the preceding item zero or more times.

,... You can repeat the preceding item zero or more times,
separating each item with a comma.

Example

cm16c [option]... filename

You can read this line as follows: enter the command cm16c with or
without an option, follow this by zero or more options and specify a
filename. The following input lines are all valid:

cm16c test.c

cm16c -g test.c

cm16c -g -E test.c

Not valid is:

cm16c -g

According to the syntax description, you have to specify a filename.



Manual Purpose and Structure XV

• • • • • • • •

Icons

The following illustrations are used in this manual:

Note: notes give you extra information.

Warning: read the information carefully. It prevents you from making
serious mistakes or from loosing information.

This illustration indicates actions you can perform with the mouse. Such as
EDE menu entries and dialogs.

Command line: type your input on the command line.

Reference: follow this reference to find related topics.



User's GuideXVI
M

A
N

U
A

L
 S

T
R

U
C

T
U

R
E

RELATED  PUBLICATIONS

C Standards

• C A Reference Manual (fifth edition) by Samual P. Harbison and Guy L.
Steele Jr. (2002, Prentice Hall)

• The C Programming Language (second edition) by B. Kernighan and D.
Ritchie (1988, Prentice Hall)

• ISO/IEC 9899:1999(E), Programming languages - C [ISO/IEC]
More information on the standards can be found at
http://www.ansi.org

• DSP-C, An Extension to ISO/IEC 9899:1999(E), 
Programming languages - C [TASKING, TK0071-14]

MISRA C

• Guidelines for the Use of the C Language in Vehicle Based Software
[MISRA]
See also http://www.misra.org.uk

TASKING Tools

• M16C C Compiler, Assembler, Linker Reference Guide
[TASKING, MB299-024-00-00]

• M16C C++ Compiler User's Guide
[TASKING, MA299-012-00-00]

• M16C CrossView Pro Debugger User's Guide
[TASKING, MA299-041-00-00]

M16C

• M16C Group Specification [Renesas]

• M16C/60/20 Series Software Manual [Renesas]
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1.1 INTRODUCTION

This chapter guides you through the procedures to install the software on
a Windows system or on a Linux or UNIX host.

The software for Windows has two faces: a graphical interface (Embedded
Development Environment) and a command line interface. The Linux and
UNIX software has only a command line interface.

After the installation, it is explained how to configure the software and
how to install the license information that is needed to actually use the
software.

1.2 SOFTWARE INSTALLATION

1.2.1 INSTALLATION FOR WINDOWS

1. Start Windows 95/98/XP/NT/2000, if you have not already done so.

2. Insert the CD-ROM into the CD-ROM drive.

If the TASKING Showroom dialog box appears, proceed with Step 5.

3. Click the Start button and select Run...

4. In the dialog box type d:\setup (substitute the correct drive letter for
your CD-ROM drive) and click on the OK button.

The TASKING Showroom dialog box appears.

5. Select a product and click on the Install button.

6. Follow the instructions that appear on your screen.

You can find your serial number the Invoice, Delivery Note, or Picking
Slip delivered with the product.

7. License the software product as explained in section 1.4, Licensing
TASKING Products.
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1.2.2 INSTALLATION FOR LINUX

Each product on the CD-ROM is available as an RPM package, Debian
package and as a gzipped tar file. For each product the following files are
present:

SWproduct-version-RPMrelease.i386.rpm

swproduct_version-release_i386.deb

SWproduct-version.tar.gz

These three files contain exactly the same information, so you only have
to install one of them. When your Linux distribution supports RPM
packages, you can install the .rpm file. For a Debian based distribution,
you can use the .deb file. Otherwise, you can install the product from the
.tar.gz file.

RPM Installation

1. In most situations you have to be "root" to install RPM packages, so either
login as "root", or use the su command.

2. Insert the CD-ROM into the CD-ROM drive. Mount the CD-ROM on a
directory, for example /cdrom. See the Linux manual pages about mount

for details.

3. Go to the directory on which the CD-ROM is mounted:

cd /cdrom

4. To install or upgrade all products at once, issue the following command:

rpm -U SW*.rpm

This will install or upgrade all products in the default installation directory
/usr/local. Every RPM package will create a single directory in the
installation directory.

The RPM packages are 'relocatable', so it is possible to select a different
installation directory with the --prefix option. For instance when you
want to install the products in /opt, use the following command:

rpm -U --prefix /opt SW*.rpm

For Red Hat 6.0 users: The --prefix option does not work with RPM
version 3.0, included in the Red Hat 6.0 distribution. Please upgrade to
RPM verion 3.0.3 or higher, or use the .tar.gz file installation described
in the next section if you want to install in a non-standard directory.
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Debian Installation

1. Login as a user.

Be sure you have read, write and execute permissions in the installation
directory. Otherwise, login as "root" or use the su command.

2. Insert the CD-ROM into the CD-ROM drive. Mount the CD-ROM on a
directory, for example /cdrom. See the Linux manual pages about mount

for details.

3. Go to the directory on which the CD-ROM is mounted:

cd /cdrom

4. To install or upgrade all products at once, issue the following command:

dpkg -i sw*.deb

This will install or upgrade all products in a subdirectory of the default
installation directory /usr/local.

Tar.gz Installation

1. Login as a user.

Be sure you have read, write and execute permissions in the installation
directory. Otherwise, login as "root" or use the su command.

2. Insert the CD-ROM into the CD-ROM drive. Mount the CD-ROM on a
directory, for example /cdrom. See the Linux manual pages about mount

for details.

3. Go to the directory on which the CD-ROM is mounted:

cd /cdrom

4. To install the products from the .tar.gz files in the directory
/usr/local, issue the following command for each product:

tar xzf SWproduct-version.tar.gz -C /usr/local

Every .tar.gz file creates a single directory in the directory where it is
extracted.
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1.2.3 INSTALLATION FOR UNIX HOSTS

1. Login as a user.

Be sure you have read, write and execute permissions in the installation
directory. Otherwise, login as "root" or use the su command.

If you are a first time user, decide where you want to install the product.
By default it will be installed in /usr/local.

2. Insert the CD-ROM into the CD-ROM drive and mount the CD-ROM on a
directory, for example /cdrom.

Be sure to use an ISO 9660 file system with Rock Ridge extensions
enabled. See the UNIX manual pages about mount for details.

3. Go to the directory on which the CD-ROM is mounted:

cd /cdrom

4. Run the installation script:

sh install

Follow the instructions appearing on your screen.

First a question appears about where to install the software. The default
answer is /usr/local.

On some hosts the installation script asks if you want to install SW000098,
the Flexible License Manager (FLEXlm). If you do not already have FLEXlm
on your system, you must install it otherwise the product will not work on
those hosts. See section 1.4, Licensing TASKING Products.

If the script detects that the software has been installed before, the
following messages appear on the screen:

       *** WARNING ***

SWxxxxxx xxxx.xxxx already installed.

Do you want to REINSTALL? [y,n]

Answering n (no) to this question causes installation to abort and the
following message being displayed:

=> Installation stopped on user request <=
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Answer y (yes) to continue with the installation. The last message will be:

Installation of SWxxxxxx xxxx.xxxx completed.

5. If you purchased a protected TASKING product, license the software
product as explained in section 1.4, Licensing TASKING Products.

1.3 SOFTWARE CONFIGURATION

Now you have installed the software, you can configure both the
Embedded Development Environment and the command line environment
for Windows, Linux and UNIX.

1.3.1 CONFIGURING THE EMBEDDED DEVELOPMENT

ENVIRONMENT

After installation, the Embedded Development Environment is
automatically configured with default search paths to find the executables,
include files and libraries. In most cases you can use these settings. To
change the default settings, follow the next steps:

1. Double-click on the EDE icon on your desktop to start the Embedded
Development Environment (EDE).

2. From the Project menu, select Directories...

The Directories dialog box appears.

3. Fill in the following fields:

• In the Executable Files Path field, type the pathname of the
directory where the executables are located. The default directory is
$(PRODDIR)\bin.

• In the Include Files Path field, add the pathnames of the
directories where the compiler and assembler should look for
include files. The default directory is $(PRODDIR)\include.
Separate pathnames with a semicolon (;).

The first path in the list is the first path where the compiler and
assembler look for include files. To change the search order, simply
change the order of pathnames.
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• In the Library Files Path field, add the pathnames of the
directories where the linker should look for library files. The default
directory is $(PRODDIR)\lib. Separate pathnames with a
semicolon (;).

The first path in the list is the first path where the linker looks for
library files. To change the search order, simply change the order of
pathnames.

Instead of typing the pathnames, you can click on the Configure...

button.

A dialog box appears in which you can select and add directories, remove
them again and change their order.
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1.3.2 CONFIGURING THE COMMAND LINE

ENVIRONMENT

To facilitate the invocation of the tools from the command line (either
using a Windows command prompt or using Linux or UNIX), you can set
environment variables.

You can set the following variables:

Environment
Variable

Description

PATH With this variable you specify the directory in which

the executables reside (default: c:\cm16c\bin).

This allows you to call the executables when you

are not in the bin directory.

Usually your system already uses the PATH variable

for other purposes. To keep these settings, you

need to add (rather than replace) the path. Use a

semicolon (;) to separate pathnames.

CM16CINC With this variable you specify one or more additional

directories in which the C compiler cm16c looks for

include files. The compiler first looks in these

directories, then always looks in the default

include directory relative to the installation

directory.

ASM16CINC With this variable you specify one or more additional

directories in which the assembler asm16c looks for

include files. The assembler first looks in these

directories, then always looks in the default

include directory relative to the installation

directory.

CCM16CBIN With this variable you specify the directory in which

the control program ccm16c looks for the

executable tools. The path you specify here should

match the path that you specified for the PATH

variable.

CCM16COPT With this variable you specify options and/or

arguments to each invocation of the control program

ccm16c. The control program processes these

arguments before the command line arguments.

LIBM16C

LIBR8C

With this variable you specify one or more

alternative directories in which the linker lkm16c
looks for library files for a specific core. The linker

first looks in these directories, then always looks in

the default lib directory.
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DescriptionEnvironment
Variable

LM_LICENSE_FILE With this variable you specify the location of the

license data file. You only need to specify this

variable if your host uses the FLEXlm licence

manager.

TASKING_LIC_WAIT If you set this variable, the tool will wait for a license

to become available, if all licenses are taken. If you

have not set this variable, the tool aborts with an

error message.

TMPDIR With this variable you specify the location where

programs can create temporary files. Usually your

system already uses this variable. In this case you

do not need to change it.

Table 1-1: Environment variables

The following examples show how to set an environment variable using
the PATH variable as an example.

Example for Windows 95/98

Add the following line to your autoexec.bat file:

set PATH=%path%;c:\cm16c\bin

You can also type this line in a Command Prompt window but you will
loose this setting after you close the window.

Example for Windows NT

1. Right-click on the My Computer icon on your desktop and select
Properties from the menu.

The System Properties dialog appears.

2. Select the Environment tab.

3. In the list of System Variables select Path.

4. In the Value field, add the path where the executables are located to the
existing path information. Separate pathnames with a semicolon (;). For
example: c:\cm16c\bin.

5. Click on the Set button, then click OK.
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Example for Windows XP / 2000

1. Right-click on the My Computer icon on your desktop and select
Properties from the menu.

The System Properties dialog appears.

2. Select the Advanced tab.

3. Click on the Environment Variables button.

The Environment Variables dialog appears.

4. In the list of System variables select Path.

5. Click on the Edit button.

The Edit System Variable dialog appears.

6. In the Variable value field, add the path where the executables are
located to the existing path information. Separate pathnames with a
semicolon (;). For example: c:\cm16c\bin.

7. Click on the OK button to accept the changes and close the dialogs.

Example for UNIX

Enter the following line (C-shell):

setenv PATH $PATH:/usr/local/cm16c/bin
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1.4 LICENSING TASKING PRODUCTS

TASKING products are protected with license management software
(FLEXlm). To use a TASKING product, you must install the license key
provided by TASKING for the type of license purchased.

You can run TASKING products with a node-locked license or with a
floating license. When you order a TASKING product determine which
type of license you need (UNIX products only have a floating license).

Node-locked license (PC only)

This license type locks the software to one specific PC so you can use the
product on that particular PC only.

Floating license

This license type manages the use of TASKING product licenses among
users at one site. This license type does not lock the software to one
specific PC or workstation but it requires a network. The software can then
be used on any computer in the network. The license specifies the
number of users who can use the software simultaneously. A system
allocating floating licenses is called a license server. A license manager
running on the license server keeps track of the number of users.

See Appendix A, Flexible License Manager (FLEXlm), for more information.

1.4.1 OBTAINING LICENSE INFORMATION

Before you can install a software license you must have a "License Key"
containing the license information for your software product. If you have
not received such a license key follow the steps below to obtain one.
Otherwise, you can install the license.

Windows

1. Run the License Administrator during installation and follow the steps to
Request a license key from Altium by E-mail.

2. E-mail the license request to your local TASKING sales representative. The
license key will be sent to you by E-mail.



Software Installation and Configuration 1-13

• • • • • • • •

UNIX

1. If you need a floating license on UNIX, you must determine the hostid and
hostname of the computer where you want to use the license manager.
Also decide how many users will be using the product. See section 1.4.7,
How to Determine the Hostid and section 1.4.8, How to Determine the
Hostname.

2. When you order a TASKING product, provide the hostid, hostname and
number of users to your local TASKING sales representative. The license
key will be sent to you by E-mail.

1.4.2 INSTALLING NODE-LOCKED LICENSES

If you do not have received your license key, read section 1.4.1, Obtaining
License Information, before continuing.

Step 1

Install the TASKING software product following the installation procedure
described in section 1.2.1, Installation for Windows, if you have not done
this already.

During installation you will be asked to run the License Administrator. Or,
start the License Administrator (licadmin.exe) manually.

In the License Administrator follow the steps to Import a license key

received from Altium by E-mail. The License Administrator creates a
license file for you. If you prefer to create a license file manually, goto
Step 2.

Step 2

Create a file called "license.dat" in the c:\flexlm directory, using an
ASCII editor and insert the license key information received by E-mail in
this file. This file is called the "license file". If the directory c:\flexlm
does not exist, create the directory.

If you wish to install the license file in a different directory, see section
1.4.6, Modifying the License File Location.

If you already have a license file, add the license key information to the
existing license file. If the license file already contains any SERVER lines,
you must use another license file. See section 1.4.6, Modifying the License
File Location, for additional information.
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The software product and license file are now properly installed.

See Appendix A, Flexible License Manager (FLEXlm), for more information.

1.4.3 INSTALLING FLOATING LICENSES

If you do not have received your license key, read section 1.4.1, Obtaining
License Information, before continuing.

Step 1

Install the TASKING software product following the installation procedure
described earlier in this chapter on the computer or workstation where
you will use the software product.

As a result of this installation two additional files for FLEXlm will be
present in the flexlm subdirectory of the toolchain:

Tasking The Tasking daemon (vendor daemon).
lmtools.exe FLEXlm utilities (Windows).

Step 2

If you already have installed FLEXlm v8.4 or higher (for example as part of
another product) you can skip this step and continue with step 3.
Otherwise, install SW000098, the Flexible License Manager (FLEXlm), on
the license server where you want to use the license manager.

The installation of the license manager on Windows also sets up the
license manager daemon to run automatically whenever a license server
reboots. On UNIX you have to perform the steps as described in section
1.4.5, Setting Up the License Daemon to Run Automatically.

It is not recommended to run a license manager on a Windows 95 or
Windows 98 machine. Use Windows XP, NT or 2000 instead, or use Solaris
or Linux.

Step 3

If FLEXlm has already been installed as part of a non-TASKING product
you have to make sure that the bin directory of the FLEXlm product
contains a copy of the Tasking daemon (see step 1).
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Step 4

Use the License Administrator or manually insert the license key obtained
by E-mail in the license file, which is being used by the license server.
This file is usually called license.dat. The default location of the license
file is in directory c:\flexlm for Windows and in
/usr/local/flexlm/licenses for UNIX.

If you wish to install the license file in a different directory, see section
1.4.6, Modifying the License File Location.

If the license file does not exist, you have to create it using an ASCII
editor.

If you already have a license file, add the license information to the
existing license file. If the SERVER lines in the license file are the same as
the SERVER lines in the license key, you do not need to add this same
information again. If the SERVER lines are not the same, you must use
another license file. See section 1.4.6, Modifying the License File Location,
for additional information.

Step 5

On each PC or workstation where you will use the TASKING software
product the location of the license file must be known. If it differs from
the default location (c:\flexlm\license.dat for Windows,
/usr/local/flexlm/licenses/license.dat  for UNIX), then you
must set the environment variable LM_LICENSE_FILE. See section 1.4.6,
Modifying the License File Location, for more information.

Step 6

Now all license information is entered, the license manager must be
started (see section section 1.4.4). Or, if it is already running you must
notify the license manager that the license file has changed by entering the
command (located in the flexlm bin directory):

lmreread

On Windows you can also use the graphical FLEXlm Tools (lmtools): Start
lmtools (if you have used the defaults this can be done by selecting Start

-> Programs -> TASKING FLEXlm -> FLEXlm Tools). On the
Start/Stop/Reread tab, click on the ReRead License File button. Another
option is to reboot your PC.

The software product and license file are now properly installed.
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Where to go from here?

The license manager (daemon) must always be up and running. Read
section 1.4.4 on how to start the daemon and read section 1.4.5 for
information how to set up the license daemon to run automatically.

If the license manager is running, you can now start using the TASKING
product.

See Appendix A, Flexible License Manager (FLEXlm), for more information.

1.4.4 STARTING THE LICENSE DAEMON

The license manager (daemon) must always be up and running. To start
the daemon complete the following steps on each license server:

Windows

On Windows, the installation procedure configures the license manager to
start automatically after a reboot, and starts the license manager for you. If
you choose not to do this during installation, follow these steps:

1. From the Windows Start menu, select Programs -> TASKING FLEXlm

-> FLEXlm Tools.

The license manager tool appears.

2. On the Start/Stop/Reread tab, select FLEXLM License Manager for
TASKING.

3. Click on the Start Server button.

4. Close the program by selecting Exit from the File menu.

UNIX

1. Log in as the operating system administrator (usually root).

2. Change to the FLEXlm installation directory (default
/usr/local/flexlm):

cd /usr/local/flexlm

3. Start the license manager daemon by typing the following:

bin/lmgrd -2 -p -c licenses/license.dat \

   -l /var/tmp/license.log -local &
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The -2 and -p options restrict the use of the lmdown and lmremove

license administration tools to the license administrator. You can omit
these options if you want. Refer to the usage of lmgrd in Appendix A,
Flexible License Manager (FLEXlm), for more information.

1.4.5 SETTING UP THE LICENSE DAEMON TO RUN

AUTOMATICALLY

To set up the license daemon so that it runs automatically whenever a
license server reboots, follow the instructions below that are appropriate
for your platform, on each license server:

Windows

On Windows, the installation procedure does this for you. If you choose
not to do this during installation, follow these steps:

1. From the Windows Start menu, select Programs -> TASKING FLEXlm

-> FLEXlm Tools.

The license manager tool appears.

2. On the Config Services tab, select FLEXLM License Manager for
TASKING.

3. Enable the Use Services check box.

4. Enable the Start Server at Power Up check box.

5. Close the program by selecting Exit from the File menu. If a question
appears, answer Yes to save your settings.

UNIX

In performing any of the procedures below, keep in mind the following:

• Before you edit any system file, make a backup copy.
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SunOS4

1. Log in as the operating system administrator (usually root).

2. Append the following lines to the file /etc/rc.local. Replace
FLEXLMDIR by the FLEXlm installation directory (default
/usr/local/flexlm):

FLEXLMDIR/bin/lmgrd -2 -p -c FLEXLMDIR/licenses/license.dat \

    -l /var/tmp/license.log -local &

SunOS5 (Solaris 2)

1. Log in as the operating system administrator (usually root).

2. In the directory /etc/init.d create a file named rc.lmgrd with the
following contents. Replace FLEXLMDIR by the FLEXlm installation
directory (default /usr/local/flexlm):

#!/bin/sh

FLEXLMDIR/bin/lmgrd -2 -p -c FLEXLMDIR/licenses/license.dat \

    -l /var/tmp/license.log -local &

3. Make it executable:

chmod u+x rc.lmgrd

4. Create an 'S' link in the /etc/rc3.d directory to this file and create 'K'
links in the other /etc/rc?.d directories:

ln /etc/init.d/rc.lmgrd /etc/rc3.d/Snumrc.lmgrd

ln /etc/init.d/rc.lmgrd /etc/rc?.d/Knumrc.lmgrd

num must be an appropriate sequence number. Refer to you operating
system documentation for more information.

1.4.6 MODIFYING THE LICENSE FILE LOCATION

The default location for the license file on Windows is:

c:\flexlm\license.dat

On UNIX this is:

/usr/local/flexlm/licenses/license.dat
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If you want to use another name or directory for the license file, each user
must define the environment variable LM_LICENSE_FILE.

If you have more than one product using the FLEXlm license manager you
can specify multiple license files to the LM_LICENSE_FILE environment
variable by separating each pathname (lfpath) with a ';' (on UNIX also ':'):

Example Windows:

set LM_LICENSE_FILE=c:\flexlm\license.dat;c:\license.txt

Example UNIX:

setenv LM_LICENSE_FILE

/usr/local/flexlm/licenses/license.dat:/myprod/license.txt

If the license file is not available on these hosts, you must set
LM_LICENSE_FILE to port@host; where host is the host name of the
system which runs the FLEXlm license manager and port is the TCP/IP port
number on which the license manager listens.

To obtain the port number, look in the license file at host for a line starting
with "SERVER". The fourth field on this line specifies the TCP/IP port
number on which the license server listens. For example:

setenv LM_LICENSE_FILE 7594@elliot

See Appendix A, Flexible License Manager (FLEXlm), for detailed
information.

1.4.7 HOW TO DETERMINE THE HOSTID

The hostid depends on the platform of the machine. Please use one of the
methods listed below to determine the hostid.

Platform Tool to retrieve hostid Example hostid

SunOS/Solaris hostid 170a3472

Windows licadmin (License Administrator,

or use lmhostid)

0800200055327

Table 1-2: Determine the hostid
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The License Administrator (licadmin) helps you in the process of
obtaining your license key.

If you do not have the program licadmin you can download it from our
Web site at: http://www.tasking.com/support/flexlm/licadmin.zip . It is
also on every product CD that includes FLEXlm.

1.4.8 HOW TO DETERMINE THE HOSTNAME

To retrieve the hostname of a machine, use one of the following methods.

Platform Method

SunOS/Solaris hostname

Windows 95/98 licadmin  or:

Go to the Control Panel, open "Network", click on

"Identification". Look for "Computer name".

Windows NT licadmin  or:

Go to the Control Panel, open "Network". In the

"Identification" tab look for "Computer Name".

Windows XP/2000 licadmin  or:

Go to the Control Panel, open "System". In the "Computer

Name" tab look for "Full computer name".

Table 1-3: Determine the hostname
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2.1 INTRODUCTION

With the TASKING M16C suite you can write, compile, assemble, link and
locate applications for the several M16C cores.

Embedded Development Environment

The TASKING Embedded Development Environment (EDE) is a Windows
application that facilitates working with the tools in the toolchain and also
offers project management and an integrated editor.

EDE has three main functions: Edit / Project management, Build and
Debug. The figure below shows how these main functionalities relate to
each other.

makefile

make

compiler

absolute file

debugger

assembler

linker

EDE

project management

editor

tool options

toolchain selection

EDIT

BUILD

DEBUG

Figure 2-1: EDE development flow
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In the Edit part you make all your changes:

- create a project space

- create and maintain one or more projects in a project space

- add, create and edit source files in a project

- set the options for each tool in the toolchain

- select another toolchain if you want to create an application for
another target than the M16C.

In the Build part you build your files:

- a makefile (created by the Edit part) is used to invoke the needed
toolchain components, resulting in an absolute object file.

In the Debug part you can debug your project:

- call the TASKING debugger �CrossView Pro" with the generated
absolute object file.

This Getting Started Chapter guides you step-by-step through the most
important features of EDE

The TASKING EDE is an embedded environment and differs from a native
program development.

A native program development environment is often used to develop
applications for systems where the host system and the target are the
same. Therefore, it is possible to run a compiled application directly from
the development environment.

In an embedded environment, however, a simulator or target hardware is
required to run an application. TASKING offers a number of simulators
and target hardware debuggers.

Toolchain overview

You can use all tools in the toolchain from the embedded development
environment (EDE) and from the command line in a Command Prompt
window or a UNIX shell.

The next illustration shows all components of the M16C toolchain with
their input and output files.
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assembly file

assembler

relocatable object file

CrossView Pro

C++ compiler

C++ source file

.cc

debugger

C source file

C compiler

execution

environment

.ic

cpm16c

cm16c

asm16c

relocatable object library.a

archiver

arm16c

xfwm16c

list file .lst

.src

.obj

C source file

assembly file

(hand coded)

.c

.asm

(hand coded)

error messages .ers

linker

relocatable linker object file

lkm16c

.eln

linker map file .map

error messages .elk

linker script file

.lsl

relocatable linker object file .eln

error messages .err

Motorola S-record

absolute object file

.s

Intel Hex

absolute object file

.hex

ELF/DWARF 2

absolute object file

.elf

IEEE-695

absolute object file

.abs

memory definition

.mdffile
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The following table lists the file types used by the M16C toolchain.

Extension Description

Source files

.cc C++ source file, input for the C++ compiler

.c C source file, input for the C compiler

.asm Assembler source file, hand coded

.lsl Linker script file using the Linker Script Language

Generated source files

.ic C source file, generated by the C++ compiler, input for the C

compiler

.src Assembler source file, generated by the C compiler, does not

contain macros

Object files

.obj ELF/DWARF relocatable object file, generated by the assembler

.a Archive with ELF/DWARF object files

.abs IEEE-695 absolute object file, generated by the locating part of

the linker

.eln Relocatable linker output file

.elf ELF/DWARF absolute object file, generated by the locating part

of the linker

.hex Absolute Intel Hex object file

.s Absolute Motorola S-record object file

List files

.lst Assembler list file

.map Linker map file

.mdf Memory definition file

.mcr MISRA C report file

Error list files

.err Compiler error messages file

.ers Assembler error messages file

.elk Linker error messages file

Table 2-1: File extensions
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2.2 WORKING WITH PROJECTS IN EDE

EDE is a complete project environment in which you can create and
maintain project spaces and projects. EDE gives you direct access to the
tools and features you need to create an application from your project.

A project space holds a set of projects and must always contain at least one
project. Before you can create a project you have to setup a project space.
All information of a project space is saved in a project space file (.psp):

• a list of projects in the project space

• history information

Within a project space you can create projects. Projects are bound to a
target! You can create, add or edit files in the project which together form
your application. All information of a project is saved in a project file
(.pjt):

• the target for which the project is created

• a list of the source files in the project

• the options for the compiler, assembler, linker and debugger

• the default directories for the include files, libraries and executables

• the build options

• history information

When you build your project, EDE handles file dependencies and the
exact sequence of operations required to build your application. When
you push the Build button, EDE generates a makefile, including all
dependencies, and builds your application.

Overview of steps to create and build an application

1. Create a project space

2. Add one or more projects to the project space

3. Add files to the project

4. Edit the files

5. Set development tool options

6. Build the application
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2.3 START EDE

Start EDE

• Double-click on the EDE shortcut on your desktop.

- or -

Launch EDE via the program folder created by the installation program.
Select Start -> Programs -> TASKING toolchain -> EDE.

Figure 2-2: EDE icon

The EDE screen contains a menu bar, a toolbar with command buttons,
one or more windows (default, a window to edit source files, a project
window and an output window) and a status bar.

Output Window
Contains several tabs to display

and manipulate results of EDE

operations. For example, to view

the results of builds or compiles.

Document Windows
Used to view and edit files.

Project Window
Contains several

tabs for viewing

information about

projects and other

files.

Compile Build Rebuild Debug On-line ManualsProject Options

Figure 2-3: EDE desktop
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2.4 USING THE SAMPLE PROJECTS

When you start EDE for the first time (see section 2.3, Start EDE), EDE
opens with a ready defined project space that contains several sample
projects. Each project has its own subdirectory in the examples directory.
Each directory contains a file readme.txt with information about the
example. The default project is called demo.pjt and contains a CrossView
Pro debugger example.

Select a sample project

To select a project from the list of projects in a project space:

1. In the Project Window, right-click on the project you want to open.

A menu appears.

2. Select Set as Current Project.

The selected project opens.

3. Read the file readme.txt for more information about the selected sample
project.

Building a sample project

To build the currently active sample project:

• Click on the Execute 'Make' command button.

Once the files have been processed you can inspect the generated messages
in the Build tab of the Output window.
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2.5 CREATE A NEW PROJECT SPACE WITH A PROJECT

Creating a project space is in fact nothing more than creating a project
space file (.psp) in an existing or new directory.

Create a new project space

1. From the File menu, select New Project Space...

The Create a New Project Space dialog appears.

2. In the the Filename field, enter a name for your project space (for
example MyProjects). Click the Browse button to select a directory first
and enter a filename.

3. Check the directory and filename and click OK to create the .psp file in
the directory shown in the dialog.

A project space information file with the name MyProjects.psp is
created and the Project Properties dialog box appears with the project space
selected.
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Add a new project to the project space

4. In the Project Properties dialog, click on the Add new project to project

space button (see previous figure).

The Add New Project to Project Space dialog appears.
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5. Give your project a name, for example getstart\getstart.pjt (a
directory name to hold your project files is optional) and click OK.

A project file with the name getstart.pjt is created in the directory
getstart, which is also created. The Project Properties dialog box appears
with the project selected.

Add new files to the project

Now you can add all the files you want to be part of your project.

6. Click on the Add new file to project button.

The Add New File to Project dialog appears.
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7. Enter a new filename (for example hello.c) and click OK.

A new empty file is created and added to the project. Repeat steps 6 and 7 if
you want to add more files.

8. Click OK.

The new project is now open. EDE loads the new file(s) in the editor in
separate document windows.

EDE automatically creates a makefile for the project (in this case
getstart.mak). This file contains the rules to build your application.
EDE updates the makefile every time you modify your project.

Edit your files

9. As an example, type the following C source in the hello.c document
window:

#include <stdio.h>

void main(void)

{

    printf("Hello World!\n");

}

10. Click on the Save the changed file <Ctrl-S> button.

EDE saves the file.
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2.6 SET OPTIONS FOR THE TOOLS IN THE TOOLCHAIN

The next step in the process of building your application is to select a
target processor and specify the options for the different parts of the
toolchain, such as the C compiler, assembler, linker and debugger.

Select a target processor

1. From the Project menu, select Project Options...

The Project Options dialog appears.

2. Expand the Processor entry and select Processor Definition.

3. In the Select core list select (for example) M16C.

4. In the Select group list select (for example) M16C62A.

5. In the Select processor list select (for example) M30624FGAFP/GP.

6. Optional for some processors, select a Processor mode.

7. Click OK to accept the new project settings.
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Set tool options

1. From the Project menu, select Project Options...

The Project Options dialog appears. Here you can specify options that are
valid for the entire project. To overrule the project options for the currently
active file instead, from the Project menu select Current File Options...

2. Expand the C Compiler entry.

The C Compiler entry contains several pages where you can specify C
compiler settings.

3. For each page make your changes. If you have made all changes click OK.

The Cancel button closes the dialog without saving your changes. With
the Default... button you can restore the default project options (for the
current page, or all pages in the dialog).

4. Make your changes for all other entries (Assembler, Linker, CrossView Pro,
Flasher) of the Project Options dialog in a similar way as described above
for the C compiler.

If available, the Options string field shows the command line options
that correspond to your graphical selections.
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Synchronize options with the ROM monitor

If you use a ROM monitor for debugging, you must be sure that all EDE
settings are correct for communicating with the ROM monitor. If the ROM
monitor target board is connected to your PC, EDE can automatically set
the correct options based on the ROM monitor. To do this:

1. Click on the Synchronize options with the ROM monitor button.

The Synchronize Options dialog appears.

2. Specify the Serial port and Baud rate at which the ROM monitor is
connected and click Scan. If you do not know the port or baud rate, you
can click Scan All to scan all COM ports for the ROM monitor.

3. Click Sync to synchronize the shown options with the current project.

A message appears that the current project has been synchronized with the
ROM monitor.

4. Click OK to close the message box.

5. Click Close to close the dialog.
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2.7 BUILD YOUR APPLICATION

If you have set all options, you can actually compile the file(s). This results
in an absolute ELF/DWARF object file which is ready to be debugged.

Build your Application

To build the currently active project:

• Click on the Execute 'Make' command button.

The file is compiled, assembled, linked and located. The resulting file is
getstart.elf.

The build process only builds files that are out-of-date. So, if you click
Make again in this example nothing is done, because all files are
up-to-date.

Viewing the Results of a Build

Once the files have been processed, you can see which commands have
been executed (and inspect generated messages) by the build process in
the Build tab of the Output window.

This window is normally open, but if it is closed you can open it by
selecting the Output menu item in the Window menu.

Compiling a Single File

1. Select the window (document) containing the file you want to compile or
assemble.

2. Click on the Execute 'Compile' command button. The following button
is the execute Compile button which is located in the toolbar.

If you selected the file hello.c, this results in the compiled and assembled
file hello.obj.
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Rebuild your Entire Application

If you want to compile, assemble and link/locate all files of your project
from scratch (regardless of their date/time stamp), you can perform a
rebuild.

• Click on the Execute 'Rebuild' command button. The following
button is the execute Rebuild button which is located in the toolbar.

2.8 HOW TO BUILD YOUR APPLICATION ON THE

COMMAND LINE

If you are not using EDE, you can build your entire application on the
command line. The easiest way is to use the control program ccm16c

1. In a text editor, write the file hello.c with the following contents:

#include <stdio.h>

void main(void)

{

    printf("Hello World!\n");

}

2. Build the file getstart.elf:

ccm16c -ogetstart.elf hello.c -v

The control program calls all tools in the toolchain. The -v option shows all
the individual steps. The resulting file is getstart.elf.
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2.9 DEBUG GETSTART.ELF

The application getstart.elf is the final result, ready for execution
and/or debugging. The debugger uses getstart.elf for debugging but
needs symbolic debug information for the debugging process. This
information must be included in getstart.elf and therefore you need
to compile and assemble hello.c once again.

ccm16c -g -ogetstart.elf hello.c

Now you can start the debugger with getstart.elf and see how it
executes.

Start CrossView Pro

• Click on the Debug application button.

CrossView Pro is launched. CrossView Pro will automatically download the
file getstart.elf for debugging.

See the CrossView Pro Debugger User's Guide for more information.
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3.1 INTRODUCTION

The TASKING C cross-compiler (cm16c) fully supports the ISO C99
standard. In addition, it adds extra possibilities to write fast and compact
code for the M16C and to use the special functions of the M16C.

In addition to the standard C language, the compiler supports the
following:

• extra data type __bit

• intrinsic (built-in) functions that result in M16C specific assembly
instructions

• pragmas to control the compiler from within the C source

• predefined macros

• the possibility to use assembly instructions in the C source

• keywords to specify memory types for data and functions

• attributes to specify alignment and absolute addresses

• keywords for  programming interrupt routines

• libraries

All non-standard keywords have two leading underscores (__).

This chapter first describes programming strategies and tips for writing
optimal code for the M16C. Next, the M16C specific characteristics of the C
language are described into more detail.
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3.2 PROGRAMMING STRATEGIES

3.2.1 MEMORY SPACES

Choosing Memory Spaces

The TASKING M16C toolchain introduces several qualifiers to control how
and where you want to allocate C objects in memory. Among others, the
following memory qualifiers exist:

• __far anywhere in the 20 bit space, objects can be of any size.

• __paged anywhere in the 20 bit space, objects must be smaller
than 64 kB and will never cross 64k boundaries

• __near first 64k

• __bita first 8k (the bitaddressable space)

Most M16C instructions can address operands in memory only if they lie in
the first 64k. For far addresses, expensive load/store instructions are
needed. For this reason, using __near qualified variables generates much
faster code than using __far or __paged variables.

A pointer to a __near qualified object fits in one 16 bit address register,
for a pointer to a __far or __paged object the double register A1A0 is
needed. Also, pointer arithmetic for __near pointers is much faster.

__paged qualified objects are guaranteed not to be allocated accross 64k
boundaries. Therefor, pointer arithmetic on pointers to paged memory
only requires updates of the A0 register. For pointers to far memory both
A1 and A0 need to be altered. So, pointer arithmetic is often twice as fast
for pointers to paged memory.

The stack lies always in the first 64k bytes, so a variable on the stack is
implicitly __near qualified. This means that automatic variables are
always fastest (regardless of the chosen memory model).

Objects qualified with __bita are bit-addressable. This means that setting
and getting individual bits can be done with the fast bit instructions of the
M16C.
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String and Constant Allocation

Strings and constants can be allocated in both ROM and RAM memory. If
allocated in RAM, they have to be initialized from a copy in ROM during
program startup. So allocating in ROM saves both memory and time. You
can achieve this by enabling the options Keep strings in ROM and Keep

constants in ROM on the Code Generation page of the C Compiler
options. Note that strings in ROM cannot be modified at run-time.

Usual M16C hardware configurations have no ROM in the near space (first
64k of memory). So by default, even with Keep strings in ROM and
Keep constants in ROM enabled, __near qualified objects in those cases
are allocated in RAM.

In case your hardware does have ROM in the near space, you should
enable the option ROM is available in first 64k of memory on the Code
Generation page of the C Compiler options.

Choosing a Memory Model

The memory model determines the default memory space qualifier for
objects. It also determines which library must be linked (library functions
have no memory qualifiers in their prototypes).

In the small memory model, all objects get the __near qualifier implicitly.
In the large memory model, all objects get the __far qualifier implicitly.
In the medium memory model, all constants, string literals and pointers
get the __paged qualifier implicitly, while variables get the __near
qualifier.

Note that the medium memory model is specifically tailored to allocate
constants and strings in ROM. Constants get the __paged qualifier
implicitly, so they can be put in ROM. Other variables get the __near
qualifier for optimal performance. By default, pointers are implicitly
__paged qualified, so they can point to both constants and variables.
Variables that do not fit in near memory can easily be qualified as
__paged, as this leads to no problems with default pointers and library
calls. For before mentioned reasons, the medium memory model is the
default.
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Strategies

As explained above, allocating everything in the near memory space by
using the small memory model yields the fastest and most compact code.

However, for larger projects this obviously is not an option. To reap some
of the benefits though, you can use memory qualifiers to force frequently
used and/or small variables in near memory and rarely used and/or large
variables in far memory.

One strategy is to use the small memory model, but qualify large objects
as __paged or __far when absolutely necessary. 'Far' pointers cannot be
cast to 'near' pointers. The compiler will check this, but it can be
inconvenient, especially for library calls.

Another strategy is the other way around: use the large memory model
and qualify, where possible, variables as __near. Be careful with pointers
though, default pointers are __far qualified and will produce inefficient
code if used with __near objects.

3.2.2 BIT PROGRAMMING

The M16C has efficicient instructions to manipulate individual bits.
However, these instructions are usually only available for variables in the
first 8kB of memory (the bita space).

To generate these fast bit instructions, the compiler cm16c supports the
__bit basic type. This type is implicitly allocated in the bit space.

Pointers to __bit variables are special, since they use bit addresses
instead of bytes. Therefore, __bit variables do have some restrictions (see
subsection Bit Data Type in section 3.3, Data Types).

By using the __bit type, the compiler cm16c can also generate fast bit
instructions for bitfield operations. To make this possible, you have to
allocate the structure in the bita space using the __bita memory qualifier:

__bita struct

{

     int bit0 : 1;

     int bit1 : 1;

     int bit2 : 1;

} threebits;

is equivalent to:



C Language 3-7

• • • • • • • •

struct

     __bit bit0;

     __bit bit1;

     __bit bit2;

} threebits;

Note however that the upper example places bitfields in the bita space,
making each bit within a byte addressable (mau 8), whereas the lower
example places bits in the bit space making each bit directly addressable
(mau 1).

Former TASKING M16C toolchains supported __atbit() for an
equivalent construction. While this is still supported, its use is deprecated.

3.2.3 FLOATING-POINT

Floating-point operations are not supported by M16C hardware. Instead
run-time functions are used to handle floating-points. Try to avoid using
floating-point and use integers instead.

If you still need floating-point arithmetric, try to use single precision
floating-point. Arithmetic with floats is much faster than with doubles.

To illustrate this using the whetstone example:

Whetstone Float Double Achievement

whet.c 1869 bytes 2335 bytes
Size of module whet_CO is 20%

smaller for float than for double.

whet.elf 9618 bytes 15079 bytes
Size of application is 36% smaller

for float than for double.

time 36 sec 220 sec
Execution time is 84% faster for

float than for double.

Floating-point constants like 1.0 are double precision according to the C
standard. If you only need single precision, make sure to use the float
postfix notation for constants, for example 1.0f.
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In ISO C99 all library function like double cos(double) have a single
precision parallel function like float cosf(float). Use these single
precision functions whenever possible. The tgmath.h header file even
contains type generic functions which automatically call the best variant
(see section 2.2.13, Math.h and Tgmath.h in Chapter Libraries of the
Reference Guide).

Variable argument lists can never be float, only double. But there is one
exception: with the option Use single precision float point only on the
floating-point page of the Compiler options, floats are used everywhere
instead of doubles, also in varargs! This is the only way to have single
precision floats in vararg functions like printf.

3.2.4 GENERAL OPTIMIZATION TIPS

Try to use local variables instead of global variables because:

• Locals can often be allocated in registers.

• Memory on the stack can be reused by sibling functions

• The compiler must assume external function calls read and write all
global variables, which might make some optimizations impossible.

Avoid taking the address of variables (using the & operator) because:

• Variables whose address is taken cannot be allocated in a register

• The compiler must assume every external function can call the variable
by reference, precluding some optimizations.

Optimization settings

Inline function calls

• Enable Function inlining (or choose the Agressive (all) optimization
level) on the Optimization page of the Compiler options (command
line option -Oi or -O3)

• Use function qualifiers inline and __noinline to give extra hints to
the compiler.

• Inlining results in faster, but often in larger code if Optimize for size is
not set.

• Debugging inlined code can be harder
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Reverse inlining

• The compiler has an option to 'reverse inline' functions: by making a
compiler-generated function for repeated code sequences. This always
results in smaller, but slower code. To get the smallest code size
possible, this optimization can really help.

• You can enable both Function inlining and Reverse inlining at the
same time. Inlining may increase the possibilities for reverse inlining
which leads to faster and smaller code.

MIL linking

• The cm16c compiler offers the option to compile several C-modules in
one single pass, this is called MIL linking. This makes several compiler
optimizations much more effective, notably inlining and reverse
inlining.

• To enable MIL linking, enable the option MIL linking (compile

multiple C files simultaneously) on the Optimization page of the
C Compiler options, or choose Agressive (all) optimization).

Be cautious with inline assembly (__asm)

• __asm() statements are not analyzed by the compiler, they are copied
verbatim to the output assembly. Because of this, the compiler cannot
optimize the surrounding code. It is recommended to use plain C and
intrinsic functions whenever possible.
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3.3 DATA TYPES

The TASKING C compiler for the M16C architecture supports the following
data types:

Type Keyword
Size
(bit)

Align
(bit)

Ranges

Bit __bit 1 1 0 or 1

Boolean _Bool 1 8 0 or 1

Character char

signed char
8 8 -27 .. 27-1

unsigned char 8 8 0 .. 28-1

Integral short

signed short

int

signed int

16 8 / 16* -215 .. 215-1

unsigned short

unsigned int
16 8 / 16* 0 .. 216-1

enum 1

8

16

8

8 / 16*

8 / 16*

0 or 1

-27 .. 27-1

-215 .. 215-1

long

signed long
32 8 / 16* -231 .. 231-1

long long

signed 

 long long

64 8 / 16* -263 .. -263-1

unsigned long 32 8 / 16* 0 .. 232-1

unsigned 

 long long
64 8 / 16* 0 .. 264-1

Pointer pointer to

__sfr, __bita
16 8 / 16* 0 .. 213-1

pointer to

__near
16 8 / 16* 0 .. 216-1

pointer to

__far, __paged
32 8 / 16* 0 .. 220-1
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Ranges
Align
(bit)

Size
(bit)

KeywordType

Floating

Point
float 32 8 / 16*

-3.402e38 .. -1.175e-38

1.175e-38 .. 3.402e38

double

long double
64 8 / 16*

-1.797e308 .. -2.225e-308

2.225e-308 .. 1.797e308

float

 _Imaginary
32 8 / 16*

-3.402e38i .. -1.175e-38i

1.175e-38i .. 3.402e38i

float _Complex 32+32 8 / 16* real part + imaginary part

double/

long double

 _Imaginary
64 8 / 16*

-1.797e308i .. -2.225e-308i

2.225e-308i .. 1.797e308i

double/

long double

 _Complex
64+64 8 / 16* real part + imaginary part

Table 3-1: Data Types

*  For the marked data types, the alignment is 16 if you specify compiler
option --align, otherwise the alignment is 8.

When you use the enum type, the compiler will use the smallest sufficient
integer type (_Bool, char, int), unless you use compiler option
--integer-enumeration (always use 16-bit integers for enumeration).

float is implemented in little endian IEEE 32-bit single precision format.
double is implemented in little endian IEEE 64-bit double precision
format.

When you compile for the R8C/tiny (compiler option --r8c) __far and
__paged are the same as __near.

See also the Applications Binary Interface (ABI).



User's Guide3-12
C

 L
A

N
G

U
A

G
E

Bit Data Type

You can use the __bit type to define scalars in the bit-addressable area
and for the return type of functions. A struct containing bit fields cannot
be used for this purpose, for example because the struct is aligned at a
byte boundary. Unlike the _Bool type the __bit type is aligned on a bit
boundary.

The following rules apply to __bit type variables:

• A __bit type variable is always unsigned.

• A __bit type variable can be exchanged with all other type-variables.
The compiler generates the correct conversion.

A __bit type variable is like a boolean. Therefore, if you convert an
int type variable to a __bit type variable, it becomes 1 (true) if the
integer is not equal to 0, and 0 (false) if the integer is 0. The next two
C source lines have the same effect:

   bit_variable = int_variable;

   bit_variable = int_variable ? 1 : 0;

• Pointer to __bit is allowed, but you cannot take the address of a bit
on the stack.

• The __bit type is allowed as a structure member. However, a bit
structure can only contain members of type __bit, and you cannot
push a bit structure on the stack or return a bit structure via a function.

• A union of a __bit structure and another type is not allowed.

• A __bit type variable is allowed as a parameter of a function.

• A __bit type variable is allowed as a return type of a function.

• A __bit typed expression is allowed as switch expression.

• The sizeof of a __bit type is 1.

• Global or static __bit type variable can be initialized.

• A __bit type variable can be declared volatile.

3.4 MEMORY QUALIFIERS

You can use memory qualifiers to allocate static objects in a particular part
of the addressing space of the processor.

In addition, you can place variables at absolute addresses with the
keyword __at().
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3.4.1 MEMORY TYPE QUALIFIERS

In the TASKING C language you can specify that a variable must lie in a
specific part of memory. You can do this with a memory type qualifier.

You can use the following memory type qualifiers:

Qualifier Description

__bita Bit-addressable RAM (first 8 kB of memory)

__sfr Defines a special function register. Special optimizations are

performed on this type of variables. Data is located in the

SFR space.

__near Data is located in the first 64 kB of memory

__far Data is located anywhere in memory

__paged Data is located in a 64 kB page, anywhere in memory

__rom Data defined with this qualifier is placed in ROM. This

section is excluded from automatic initialization by the

startup code. __rom is not the same as const.

Table 3-2: Memory type qualifiers

If you do not specify a memory type qualifier for the M16C, the variable
implicitly gets the default memory type of the selected memory model (see
section 3.5, Memory Models).

Functions are by default allocated in ROM. In this case you can omit the
memory qualifier __rom. You cannot use memory qualifiers for function
return values.

See also the assembler directive DEFSECT (Declare section), in section
3.3, Assembler Directives, in Chapter Assembly Language of the Reference
Guide.

Examples using explicit memory types

__rom   char  text[] = "No smoking";

__bita  int   array[10][4];

The memory type qualifiers are treated like any other data type specifier
(such as unsigned). This means the examples above can also be declared
as:
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char __rom   text[] = "No smoking";

int  __bita  array[10][4];

Pointers

Pointers declarations can have two memory type qualifiers. For example,
the pointer itself can reside in the bita space, while pointing to a function
that resides in the rom space: For example:

__rom char *__bita p;  /* pointer residing in BITA,

                          pointing to ROM */

In this declaration pointer p is qualified with __bita (allocated in
bit-addressable RAM), but points to a char which is qualified with __rom
(allocated in ROM). The memory type qualifier used to the left of the '*',
specifies the target memory of the pointer, the memory type qualifier used
to the right of the '*', specifies the storage memory of the pointer.

The TASKING M16C C compiler recognizes two types of pointers: pointers
with a size of 2 bytes or 4 bytes in memory. Pointers to __sfr, __bita
are 13-bit pointers (2 bytes in memory) and pointers to __near are 16-bit
pointers and can point only to locations in the lowest 64K bytes of
memory. Pointers to __far  and __paged are 20-bit pointers (4 bytes in
memory) and can point anywhere in memory. Pointer arithmetic with
__far is 32 bits, whereas with __paged 16-bit pointer arithmetic is used,
because an __paged object is always located in a 64 kB page.

Function pointers for the M16C core are always __far  pointers and
function pointers for the R8C core are always __near pointers.

Structures

A structure declaration is intended to specify the layout of a structure or
union. A structure declaration itself, nor its members can be bound to any
storage area. (Members of type pointer of course can point to variables in
a particular memory space).

A tag then is used to define objects of the declared structure type. You can
qualify this object with a memory type qualifier to allocate it in a particular
memory space. The whole object, including its members is allocated in the
specified memory.

struct S {

    __near int i;  /* referring to storage: not correct */

    __far char *p; /* used to specify target memory: correct */

    };
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In the declaration above the compiler ignores the erroneous __near
memory type qualifier.

__near struct S my_struct;

The compiler now reserves 6 bytes for the object my_struct: 2 bytes for
int i and 4 bytes for pointer p which points to a variable in far memory.
The following example is also correct:

__near struct S {

    int i;

    __near char *p;

    } my_struct

The example above combines the structure declaration S and the structure
definition of my_struct. In this case the object my_struct is located in
near memory where 4 bytes are reserved: 2 bytes for int i and 2 bytes
for pointer p which points to a variable in near memory.

Typedef

Typedef declarations follow the same scope rules as any declared object.
Typedef names may be (re-)declared in inner blocks but not at the
parameter level. However, in typedef declarations, memory type
qualifiers are allowed. A typedef declaration should at least contain one
type qualifier.

typedef __near int NEARINT;   /* storage type __near: OK */

typedef int __near *PTR;      /* PTR points to an int in __near

                                 PTR resides in default memory */

3.4.2 ACCESSING PERIPHERALS FROM C: __SFR

It is easy to access Special Function Registers (SFRs) that relate to
peripherals from C. The SFRs are defined in a special function register file
(*.sfr) as symbol names for use with the compiler. An SFR file contains
the names of the SFRs and the bits in the SFRs.

Based on the target processor, the compiler includes the correct SFR file.
(See compiler option -C in chapter Tool Options of the Reference Guide).
Using the correct SFR file, you can access the special function registers and
its individual bits using the symbols defined in the SFR file.
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Example use in C for the M30100 target with SFR file regm30100.sfr

P0 = 0x88;  // fill port register p0

P1_3 = 1;   // set bit 3 of port register P1

if (P1_4 == 1)

{

     P1_3 = 0;

}

INT0EN = 1; // use of bit name: set the int0 interrupt

            // enable bit in the external interrupt

            // enable register.

The compiler generates:

_main:  type    func

        mov.b   #136, 224

        bset    3,225

        btst    4,225

        jltu    _2

        bclr    3,225

_2:

        bset    0,150

You can easily find a list of defined SFRs and defined bits by inspecting
the SFR file for a specific core. The files are named regcore.sfr, for
example regm30100.sfr.

Define Special Function Registers: __sfr

With the __sfr memory type qualifier you can define a symbol as a
Special Function Register (SFR). The compiler may assume that special SFR
operations can be performed on such symbols. The compiler can decide
to use bit instructions for those special function registers that are bit
accessible. For example, if bits are defined in the SFR definition, these bits
can be accessed using bit instructions.
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A typical definition of a special function register looks as follows:

typedef struct

     _Bool __b0:1;

     _Bool __b1:1;

     _Bool __b2:1;

     _Bool __b3:1;

     _Bool __b4:1;

     _Bool __b5:1;

     _Bool __b6:1;

     _Bool __b7:1;

   ...

     _Bool __b31:1;

} __bitstruct_t;

#define P0      (*(__sfr unsigned char *)0x00E0)

#define P0_0    ((__sfr __bitstruct_t *)&P0)->__b0

#define INTEN   (*(__sfr unsigned char *)0x0096)

#define INT0EN  ((__sfr __bitstruct_t *)&INTEN)->__b0

Example of access to the SFR:

P0 = 0x56;

P0_0 = INT0EN;

It is incorrect to optimize away access to registers. Therefore, the compiler
deals with the special function registers as if they were declared with the
volatile qualifier. In fact __sfr is treated as volatile __bita.

Non-initialized global SFR variables are not cleared at program startup. For
example:

__sfr int i; // global SFR not cleared

It is not allowed to initialize global SFR variables. SFR variables are not
initialized at startup. For example:

__sfr int j=10; // not allowed to initialize global SFR

See also compiler option -C (Use SFR definitions for CPU) in section
Compiler Options in Chapter Tool Options of the Reference Guide.
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3.4.3 DECLARE A DATA OBJECT AT AN ABSOLUTE

ADDRESS: __at()

Just like you can declare a variable in a specific part of memory, you can
also place an object at an absolute address in memory. This may be useful
to interface with other programs using fixed memory schemes, or to access
special function registers.

With the attribute __at() you can specify an absolute address.

Examples

unsigned char Display[80*24] __at( 0x2000 )

The array Display is placed at address 0x2000. In the generated
assembly, an absolute section is created. On this position space is reserved
for the variable Display.

int myvar __at(0x100)=1;

The variable myvar is placed at address 0x100 and is initialized at 1.

void f(void) __at( 0xf0ff + 1 ) { }

The function f is placed at address 0xf100.

Restrictions

Take note of the following restrictions if you place a variable at an
absolute address:

• The argument of the __at() attribute must be a constant address
expression.

• You can place only variables with static storage at absolute addresses.
Parameters of functions, or automatic variables within functions cannot
be placed at absolute addresses.

• When declared extern, the variable is not allocated by the compiler.
When the same variable is defined within another module but on a
different address, the compiler, assembler or linker will not notice.

• When the variable is declared static, no public symbol will be
generated (normal C behavior).

• You cannot place structure members at absolute addresses.

• Absolute variables cannot overlap each other. If you define two
absolute variables at the same address, the assembler and / or linker
issues an error. The compiler does not check this.
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• When you define the same absolute variable within two modules, this
produces conflicts during link time. (An extern declaration in one
module and a definition of the same variable in another module is of
course possible.)

3.5 MEMORY MODELS

The M16C C compiler (cm16c) supports three reentrant memory models:
small, medium and large. You can select one of these models with the
compiler option -M.

If no memory model is specified on the command line, cm16c uses the
small model because this model generates the most efficient code. The
following table illustrates the meaning of each data model.

Model Data Constants Pointers

Small __near: in first 64 kB __near __near

Medium __near: in first 64 kB __paged __paged

Large __far: anywhere in 1 MB __far __far

Table 3-3: cm16c memory models

When you compile for the R8C/tiny (compiler option --r8c) only the
small model is allowed.

Using predefined macro __MODEL__ to write conditional code

With the predefined macro __MODEL__ you can write conditional C code
in one source for different memory models. Depending on the memory
model for which you compile, the macro __MODEL__ expands to:

's' (small memory model)
'm' (medium memory model)
'l' (large memory model)

Example

#if __MODEL__ == 'l'

/* this part is only for the large memory model */

...

#endif
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3.6 USING ASSEMBLY IN THE C SOURCE: __asm()

With the __asm() keyword you can use assembly instructions in the C
source and pass C variables as operands to the assembly code. Be aware
that C modules that contain assembly are not portable and harder to
compile in other environments.

Furthermore, assembly blocks are not interpreted by the compiler: they are
regarded as a black box. So, it is your responsibility to make sure that the
assembly block is syntactically correct.

General syntax of the __asm keyword

__asm( "instruction_template"

       [ : output_param_list 

       [ : input_param_list 

       [ : register_save_list]]] );

instruction_template   Assembly instructions that may contain
parameters from the input list or output list in
the form: %parm_nr [.regnum]

      %parm_nr[.regnum] Parameter number in the range 0 .. 31. With the
optional .regnum you can access an individual
register from a register pair. For example, with
the word register R2R0, .0 selects register R0.

output_param_list [[ "=[&]constraint_char"(C_expression)],...]

input_param_list [[ "constraint_char"(C_expression)],...]

      & Says that an output operand is written to before
the inputs are read, so this output must not be
the same register as any input.

      constraint _char Constraint character: the type of register to be
used for the C_expression.
(see table 3-4)

      C_expression Any C expression. For output parameters it must
be an lvalue, that is, something that is legal to
have on the left side of an assignment.

register_save_list [["register_name"],...]

      register_name Name of the register you want to reserve.
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Typical example: adding two C variables using assembly

int a, b, result;

void main( void )

{

    __asm("add.w %1, %2\n\t"

          "mov.w %2, %0" : "=m"(result) : "r"(a), "r"(b) );

}

generated code:

mov.w   _b, R0

mov.w   _a, R1

add.w R1, R0

mov.w R0, _result

%0 corresponds to the first C variable, %1 corresponds to the second and
so on. The escape sequence \t generates a tab, \n generates a newline.

Specifying registers for C variables

With a constraint character you specify the register type for a parameter.
In the example above, the r is used to force the use of registers (Rn) for
the parameters a and b.

You can reserve the registers that are already used in the assembly
instructions, either in the parameter lists or in the reserved register list
(register_save_list, also called "clobber list"). The compiler takes account of
these lists, so no unnecessary register saves and restores are placed around
the inline assembly instructions.

Constraint
character

Type Operand Remark

a address register A0, A1 word register

A address register A1A0 double-word register

b bit R[0..3]H.[0..7]

R[0..3]L.[0..7]

A[0..1].[0..7]

C

_bitvar

bit registers/variables

h data register R[0..3]H

R[0..3]L

byte registers

i immediate value #value

m memory address, label,
_variable

memory variable or

function address
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RemarkOperandTypeConstraint
character

r data register R[0..3] word registers

R registers R2R0, R3R1 double-word registers

number other operand same as

%number
used when input and

output operands must be

the same

Table 3-4: Available input/output operand constraints

Loops and conditional jumps

The compiler does not detect loops with multiple __asm statements or
(conditional) jumps across __asm statements and will generate incorrect
code for the registers involved.

If you want to create a loop with __asm, the whole loop must be
contained in a single __asm statement. The same counts for (conditional)
jumps. As a rule of thumb, all references to a label in an __asm statement
must be in that same statement.

Example 1: no input or output

A simple example without input or output parameters. You can just output
any assembly instruction:

__asm( "nop" );

Generated code:

nop

Example 2: using output parameters

Assign the result of inline assembly to a variable. With the constraint h a
byte data register is chosen for the parameter; the compiler decides which
data register it uses. The %0 in the instruction template is replaced with the
name of this data register. Finally, the compiler generates code to assign
the result to the output variable.

char result;

void main( void )

{

    __asm( "mov.b #0xFF,%0" : "=h"(result));

}
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Generated assembly code:

mov.b   #0xFF,R0H

mov.b   R0H,_result

Example 3: using input and output parameters

Add two C variables and assign the result to a third C variable. Data
registers are used for the input and output parameters (constraint r, %1 for
a and %2 for b in the instruction template) and memory is used for the
output parameter (constraint m, %0 for result in the instruction template).
The compiler generates code to move the input expressions into the input
registers and to assign the result to the output variable.

int a, b, result;

void add2( void )

{

    __asm("add.w %1, %2\n\t"

          "mov.w %2, %0" : "=m"(result) : "r"(a), "r"(b) );

}

void main(void)

{

    a = 3;

    b = 4;

    add2();

}

Generated assembly code:

_add2:

    mov.w   _b, R0

    mov.w   _a, R1

    add.w R1, R0

    mov.w R0, _result

_main:

    mov.w   #3, _a

    mov.w   #4, _b

    jsr     _add2
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Example 4: reserve registers

Sometimes an instruction knocks out certain specific registers. The most
common example of this is a function call, where the called function is
allowed to do whatever it likes with some registers. If this is the case, you
can list specific registers that get clobbered by an operation after the
inputs.

Same as Example 3, but now register R0 is a reserved register. You can do
this by adding a reserved register list (: "R0"). As you can see in the
generated assembly code, register R0 is not used (the first register used is
R1).

int a, b, result;

void add2( void )

{

   __asm("add.w %1, %2\n\t"

         "mov.w %2, %0" : "=m"(result) : "r"(a), "r"(b) : "R0");

}

Generated assembly code:

mov.w   _b, R2

mov.w   _a, R1

add.w R1, R2

mov.w R2, _result

Example 5: input and output are the same

If the input and output must be the same you must use a number
constraint. The following example inverts the value of the input variable
ivar and returns this value to ovar. Since the assembly instruction not.w
uses only one register, the return value has to go in the same place as the
input value. To indicate that ivar uses the same register as ovar, the
constraint '0' is used which indicates that ivar also corresponds with %0.

int ovar;

void invert(int ivar)

{

    __asm ("not.w %0": "=r"(ovar): "0"(ivar) );

}

void main(void)

{

    invert(255);

}
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Generated assembly code:

_invert:

    not.w   R0

    mov.w   R0,_ovar

_main:

    mov.w   #255,R0

    jsr    _invert

Example 6: inlining assembly functions

Because you can use any assembly instruction with the __asm keyword,
you can use the __asm keyword to perform tasks that have no
equivalence in C. By inlining such a function, rather than calling it, you
can create fast 'functions' to perform tasks that have no equivalent in C.
In fact, this way you create your own intrinsic functions.

First write a function with assembly in the body using the keyword __asm.
We use the add routine from Example 3.

Next make sure that the function is inlined rather than being called. You
can do this with the function qualifier inline. This qualifier is discussed
in more detail in section 3.12.3, Inlining Functions.

int a, b, result;

inline void my_add( void )

{

    __asm("add.w %1, %2\n\t"

          "mov.w %2, %0" : "=m"(result) : "r"(a), "r"(b) );

}

void main(void)

{

    // call to function my_add

    my_add();

}

When you call this function from within your C source, the next assembly
code will be inlined (not called!):

_main:

    ; __my_add code is inlined here

    mov.w   _b, R0

    mov.w   _a, R1

    add.w R1, R0

    mov.w R0, _result
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Example 7: accessing individual registers in a register pair

You can access the individual registers in a register pair by adding a '.'
after the operand specifier in the assembly part, followed by the index in
the register pair.

int f1, f2;

void foo(long l)

{

    __asm ("mov.w %2.0, %0\n\t"

           "mov.w %2.1, %1"

           : "=m"(f1), "=m"(f2): "R"(l) );

}

The first mov.w instruction uses index #0 of argument 2 (which is a long
placed in a RnRn register) and the second mov.w instruction uses index
#1. The input operand is located in register pair R2R0. The assembly
output becomes:

    mov.w R0, _f1

    mov.w R2, _f2

    rts

If the index is not a valid index (for example, the register is not a register
pair, or the argument has not a register constraint), the '.' is passed into the
assembly output. This way you can still use the '.' in assembly instructions.
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3.7 CONTROLLING THE COMPILER: PRAGMAS

Pragmas are keywords in the C source that control the behavior of the
compiler. Pragmas overrule compiler options.

The syntax is:

#pragma pragma-spec   [ON | OFF | DEFAULT]

or:

_Pragma( "pragma-spec   [ON | OFF | DEFAULT]" )

For example, you can set a compiler option to specify which optimizations
the compiler should perform. With the #pragma optimize flags you
can set an optimization level for a specific part of the C source. This
overrules the general optimization level that is set in the C compiler
Optimization page in the Project Options dialog of EDE (command line
option -O).

The compiler recognizes the following pragmas, other pragmas are
ignored.

Pragma name Description

alias symbol=defined-symbol Defines an alias for a symbol

align

align-data

align-func

Specifies object alignment.

See compiler option --align in section

4.1, Compiler Options in Chapter Tool
Options of the Reference Guide.

auto_switch
jump_switch
linear_switch
lookup_switch

Specifies switch statement.

See section 3.11, Switch Statement

clear

noclear
Specifies 'clearing' of non-initialized

static/public variables

extension isuffix Enables the language extension to

specify imaginary floating-point

constants by adding an 'i' to the

constant

extern symbol Forces an external reference

inline

noinline

smartinline

Specifies function inlining.

See section 3.12.3, Inlining Functions.
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DescriptionPragma name

macro

nomacro
Specifies macro expansion

message "string" ... Emits a message to standard output

optimize flags
endoptimize

Controls compiler optimizations.

See section 5.3, Compiler
Optimizations in Chapter Using the
Compiler

renamesect spec
endrenamesect

Changes section names

See section 3.13, Section Naming and

compiler option -R in section 4.1,

Compiler Options in Chapter Tool
Options of the Reference Guide

source
nosource

Specifies which C source lines must

be shown in assembly output.

See compiler option -s in section 4.1,

Compiler Options in Chapter Tool
Options of the Reference Guide.

tradeoff level Controls the speed/size tradeoff for

optimizations.

See compiler option -t in section 4.1,

Compiler Options in Chapter Tool
Options of the Reference Guide.

warning [number,...] Disables warning messages.

See compiler option -w in section 4.1,

Compiler Options in Chapter Tool
Options of the Reference Guide.

weak symbol Marks a symbol as 'weak'

Table 3-5: Overview of pragmas

For a detailed description of each pragma, see section 1.6, Pragmas, in
Chapter C Language of the Reference Guide.

3.8 PREDEFINED MACROS

In addition to the predefined macros required by the ISO C standard, the
TASKING C compiler supports the predefined macros as defined in Table
3-6. The macros are useful to create conditional C code.
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Macro Description

__SINGLE_FP__ Defined when you use compiler option -F (Treat

double as float)

__CM16C__ Identifies the compiler. You can use this symbol to flag

parts of the source which must be recognized by the

cm16c compiler only. It expands to the version

number of the compiler.

__CPU__ Expands to the CPU type specified to the compiler

option -C, or 0 otherwise.

__LITTLE_ENDIAN__ Expands to 1, indicating the processor accesses data

in little-endian.

__MODEL__ Identifies the memory model for which the current

module is compiled. For example, if you compile for

the small memory model, the macro expands to s.

__M16C__ Defined when you select a M16C core.

__R8C__ Defined when you select a R8C core (--r8c).

__TASKING__ Identifies the compiler as a TASKING compiler. It

expands to 1.

__DSPC__ Indicates conformation to the DSP-C standard.

Expands to 0, DSP-C extensions are not supported.

__VERSION__ Identifies the version number of the compiler. For

example, if you use version 3.0r1 of the compiler,

__VERSION__ expands to 3000 (dot and revision

number are omitted, minor version number in 3 digits).

__REVISION__ Identifies the revision number of the compiler. For

example, if you use version 3.0r1 of the compiler,

__REVISION__ expands to 1.

__BUILD__ Identifies the build number of the compiler, composed

of decimal digits for the build number, three digits for

the major branch number and three digits for the

minor branch number. For example, if you use build

1.22.1 of the compiler, __BUILD__ expands to

1022001. If there is no branch number, the branch

digits expand to zero. For example, build 127 results

in 127000000.

Table 3-6: Predefined macros

Example

#ifdef __CM16C__

    /* this part is for the M16C compiler */

#endif
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3.9 INITIALIZED VARIABLES

Non-static initialized variables use the same amount of space in both ROM
and RAM (for all possible RAM memory spaces). This is because the
initializers are stored in ROM and copied to RAM at start-up.

An exception is when an initialized variable resides in ROM by means of
the __rom memory type qualifier or when you specify the option
--romconstants to force constants in rom:

Examples

       int  i = 100;       /* 2 bytes in far rom and

                              2 bytes in ram         */

__rom  int  j = 3;         /* 2 bytes in rom, no ram */

__rom  char a[] = "HELP";  /* 5 bytes in rom, no ram */

Option --romconstants enabled:

const __far int i = 100;   /* 2 bytes in far rom only */

See also the next section 3.10, Strings.

3.10 STRINGS

A string is defined as a separate occurrence of a string in a C program.
Array variables initialized with strings can have storage qualifiers, and are
not the same as strings. See also section 3.9 Initialized Variables.

By default, strings are copied from ROM to RAM at start-up. However,
string literals in a C source program, which are not used to initialize an
array, have static storage duration and the ISO C standard does not require
these strings to be modifiable. Therefor, allocating strings in ROM only is
allowed.

With compiler option --romstrings the compiler will place strings in the
ROM area.

Examples

char *world = "hello"; /* 5 bytes in far rom

                          5 bytes in ram     */

Option --romstrings enabled (in large memory model):

char *world = "hello"; /* 5 bytes in far rom only */
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3.11 SWITCH STATEMENT

The TASKING C compiler supports three ways of code generation for a
switch statement: a jump chain (linear switch), a jump table or a lookup
table.

A jump chain is comparable with an if/else-if/else-if/else construction. A
jump table is a table filled with target addresses for each possible switch
value. The switch argument is used as an index within this table. A lookup
table is a table filled with a value to compare the switch argument with
and a target address to jump to. A binary search lookup is performed to
select the correct target address.

By default, the compiler will automatically choose the most efficient switch
implementation based on code and data size and execution speed. You
can influence the selection of the switch method with compiler option -t

(--tradeoff), which determines the speed/size tradeoff.

It is obvious that, especially for large switch statements, the jump table
approach executes faster than the lookup table approach. Also the jump
table has a predictable behavior in execution speed. No matter the switch
argument, every case is reached in the same execution time. However,
when the case labels are distributed far apart, the jump table becomes
sparse, wasting code memory. The compiler will not use the jump table
method when the waste becomes excessive.

With a small number of cases, the jump chain method can be faster in
execution and shorter in size.

How to overrule the default switch method

You can overrule the compiler chosen switch method with a pragma:

#pragma linear switch    /* force jump chain code */

#pragma jump_switch      /* force jump table code */

#pragma lookup_switch    /* force lookup table code */

#pragma auto_switch      /* let the compiler decide

                            the switch method used */

Pragma auto_switch is also the default of the compiler.
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3.12 FUNCTIONS

3.12.1 PARAMETER PASSING

A lot of execution time of an application is spent transferring parameters
between functions. The fastest parameter transport is via registers.
Therefore, function parameters are first passed via registers. If no more
registers are available for a parameter, the parameter is passed via the
stack. The table below shows the register usage when parameters of
several types are passed.

Parameter Type Parameter Number

1 2 3 4 5 .. 16

__bit / _Bool 0,R0 1,R0 2,R0 3,R0 4,R0 .. 15,R0

char R0L R0H

8-bit struct R0L R0H

short / int R0 R2 R1 R3

16-bit struct R0 R2 R1 R3

16-bit pointer A0 A1

32-bit pointer A1A0

long R2R0 R3R1

long long R3R1R2R0

float / 

float _Imaginary

R2R0 R3R1

float _Complex R3R1R2R0

double / 

double _Imaginary

R3R1R2R0

Table 3-7: Register usage for parameter passing

All '...' parameters of a variable argument list function are always passed
over the stack. Parameters are pushed in reverse order, so all ISO C
macros defined in stdarg.h can be applied.
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Example with five arguments

func1( char a, long b, long c, int d, char e )

- a (first parameter) is passed in register R0L

- b (second parameter) is passed in registers R3R1

- c (third parameter) is passed via the stack

- d (fourth parameter) is passed in register R2

- e (fifth parameter) is passed in register R0H

Example with variable argument function

printf( char *format, ... )

- format (first parameter) is passed in register A0

- all other parameters are passed via the stack

3.12.2 FUNCTION RETURN TYPES

The C compiler uses registers to store C function return values, depending
on the function return types.

Return type Register

__bit / _Bool C

char R0L

8-bit struct R0L

short / int R0

16-bit struct R0

16-bit pointer A0

32-bit pointer A1A0

long R2R0

long long R3R1R2R0

float / 

float _Imaginary

R2R0

float _Complex R3R1R2R0

double / 

double _Imaginary

R3R1R2R0

double _Complex on the stack

Table 3-8: Register usage for function return types
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3.12.3 INLINING FUNCTIONS: INLINE

You can use the inline keyword to tell the compiler to inline the
function body instead of calling the function. Use the __noinline
keyword to tell the compiler not to inline the function body.

Normally, you must define inline functions in the same source module as
in which you call the function, because the compiler only inlines a
function in the module that contains the function definition. When you
need to call the inline function from several source modules, you must:

• include the definition of the inline function in each module (for
example using an include file containing the definition).

• enable MIL linking on the Optimizations page of the C compiler
options and compile the involved files in the same run.

The compiler inserts the function body at the place the function is called.
If the function is not called at all, the compiler does not generate code for
it.

Example: inline

int  w,x,y,z;

inline int add( int a, int b )

{

     return( a + b );

}

void main( void )

{

     w = add( 1, 2 );

     z = add( x, y );

}

The function add() is defined before it is called. The compiler inserts
(optimized) code for both calls to the add() function. The generated
assembly is:
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_main:

    mov.w   #3, _w

    mov.w   _y, A0

    add.w   _x, A0

    mov.w   A0, _z

Example: #pragma inline / #pragma noinline

Instead of the inline qualifier, you can also use #pragma inline and
#pragma noinline to inline a function body:

int  w,x,y,z;

#pragma inline

int add( int a, int b )

{

     return( a + b );

}

#pragma noinline

void main( void )

{

     w = add( 1, 2 );

     z = add( x, y );

}

If a function has an inline/__noinline function qualifier, then this
qualifier will overrule the current pragma setting.

#pragma smartinline

By default, small fuctions that are not too often called, are inlined. This
reduces execution time at the cost of code size (compiler option -Oi).

With the #pragma noinline / #pragma smartinline you can
temporarily disable this optimization.

With the compiler options --inline-max-incr and --inline-max-size

you have more control over the function inlining process of the compiler.

See for more information of these options, section Compiler Options in
Chapter Tool Options of the Reference Guide.
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Combining inline with __asm to create intrinsic functions

With the keyword __asm it is possible to use assembly instructions in the
body of an inline function. Because the compiler inserts the (assembly)
body at the place the function is called, you can create your own intrinsic
function.

See section 3.6, Using Assembly in the C Source, for more information
about the __asm keyword.
Example 6 in that section shows how to inline assembly functions with the
inline keyword.

3.12.4 INTRINSIC FUNCTIONS

Some specific M16C assembly instructions have no equivalence in C.
Intrinsic functions give the possibility to use these instructions. Intrinsic
functions are predefined functions that are recognized by the compiler.
The compiler then generates the most efficient assembly code for these
functions.

The compiler always inlines the corresponding assembly instructions in the
assembly source rather than calling the function. This avoids unnecessary
parameter passing and register saving instructions which are normally
necessary when a function is called.

Intrinsic functions produce very efficient assembly code. Though it is
possible to inline assembly code by hand, registers are used even more
efficient by intrinsic functions. At the same time your C source remains
very readable. Intrinsic functions do not limit the optimization possibilities
of the compiler opposed to assembly that is hand coded with __asm.

You can use intrinsic functions in C as if they were ordinary C (library)
functions. All intrinsics begin with a double underscore character. The
following example illustrates the use of an intrinsic function and its
resulting assembly code.

char q;

q = __divb_q( 10,3 );  // return quotient of divide

The resulting assembly code is inlined rather than being called:

mov.w   #10, R0

div.b   #3

mov.b   R0L, _q
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For extended information about all available intrinsic functions, refer to
section 1.5, Intrinsic Functions, in Chapter C Language of the Reference
Guide.

3.12.5 CALLING ASSEMBLY FUNCTIONS: __asmfunc

For a fixed register-based interface between C and assembly functions the
function qualifier __asmfunc is available. You can use this function
qualifier for a prototype of an assembly function to be called from C or for
a function definition of a C function to be called from assembly. Normally,
the C compiler adds a leading underscore when it generates an assembly
function, with __asmfunc the C compiler does not add the extra
underscore.

Example:

           /* prototype of assembly function */

extern __asmfunc int

special_out( int port, long config, int value );

void main( void )

{

     long cfg;

     int y;

     ...

     if( special_out( 1, cfg, y ) ) /* call assembly

                                       function */

     {

          ...

     }

     ...

}

The number of arguments that can be passed is limited by the number of
available registers. (See section 3.12.1, Paramater Passing). If too many
arguments are used, the compiler will issue an error.
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3.12.6 INTERRUPT FUNCTIONS

The TASKING M16C C compiler supports a number of function qualifiers
and keywords to program interrupt service routines (ISR).

An interrupt service routine (or: interrupt function, or: interrupt handler) is
called when an interrupt event (or: service request) occurs. This can be a
software interrupt or a hardware interrupt.

A software interrupt occurs when certain instructions are executed.
Software interrupt are non-maskable, which means that the interrupt
cannot be enable or disabled by the interrupt enable flag (I flag) or that its
interrupt priority cannot be changed by priority level.

A hardware interrupt can be a special (non-maskable) interrupt, for
example an interrupt triggered by a watchdog timer, or a peripheral
function interrupt generated by a microcomputer's internal function.
Peripheral function interrupts are maskable, which means that the interrupt
can be enable or disabled by the interrupt enable flag (I flag) or that its
interrupt priority can be changed by priority level.

Each maskable interrupt has an interrupt priority level. This number (0 to
7) is set in the interrupt control register (xxxIC) by the interrupt control
unit. If multiple interrupts occur at the same time, the interrupt request that
has the highest priority is accepted. A request is handled if the priority
number is higher than the processor interrupt priority level (IPL). An
interrupt service routine can be interrupted again by another interrupt
request with a higher priority. Interrupts with priority number 0 are never
handled.

The M16C uses two interrupt vector tables for the hardware and software
interrupts: a relocatable vector table and a fixed vector table. The interrupt
vector contains the start address of the interrupt service routine.

With the following function qualifiers you can declare an interrupt handler
using the relocatable or fixed vector table respectively:

__interrupt()

__interrupt_fixed()

For an extensive description of the M16C interrupt system, see chapter
Overview of Interrupt in the M16C Group Specification [Renesas]
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3.12.6.1 DEFINING AN INTERRUPT SERVICE ROUTINE:

__interrupt()

A function can be declared as an interrupt service routine with one of the
following function qualifiers:

__interrupt(vector,...)

__interrupt_fixed(vector,...)

Both function qualifiers takes vector as an argument which identifies the
interrupt number entry in the interrupt vector table. This number must be
in the range 0 to 63 for __interrupt() or 0 to 8 for
__interrupt_fixed(). Interrupt functions cannot accept arguments and
do not return anything.

For the relocatable vector table use:

__interrupt( vector,... ) 

void isr( void )

{ ... }

For the fixed vector table use:

__interrupt_fixed( vector,... ) 

void isr( void )

{ ... }

When you define an interupt service routine, the compiler generates the
appropriate interrupt vector, consisting of an instruction jumping to the
interrupt function. You can suppress this with the compiler option
--novector or the #pragma novector. The difference between a normal
function and an interrupt function is that an interrupt function ends with a
RETI instruction instead of a RET instruction, and that all registers that
might possibly be corrupted during the execution of the interrupt function
are saved on function entry (this is called the interrupt frame) and restored
on function exit.
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Example

The next example illustrates the function definition for a function for a
software interrupt with vector number 0x30 in the relocatable vector table:

int c;

void __interrupt( 0x30 ) transmit( void )

{

     c = 1;

}

Compiler option --novector (Do not generate interrupt vectors)

3.12.6.2 REGISTER BANK SWITCHING: __bankswitch

Normally when an interrupt function is called, all registers that might
possibly be corrupted during the execution of the interrupt function are
saved on the stack so the registers are available for the interrupt function.
After return from thrrupt function the original values are restored from the
stack.

With the function qualifier __bankswitch you can specify to use register
bank 1 for the interrupt function. This minimizes the interrupt latency
because registers do not need to be pushed on the stack. You can use this
to reduce time for high-speed interrupt handling.

__interrupt( vector,... ) __bankswitch

void isr( void )

{

...

}

__interrupt_fixed( vector,... ) __bankswitch

void isr( void )

{

...

}
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3.12.6.3 INTERRUPT FRAME: __frame()

With the function qualifier __frame() you can specify which registers
must be saved for a particular interrupt function. Only the specified
registers will be pushed and popped from the stack. The syntax is:

__interrupt( vector,... ) __frame( reg,... )

void isr( void )

{

...

}

__interrupt_fixed( vector,... ) __frame( reg,... )

void isr( void )

{

...

}

where, reg can be one of the following registers: R0..R3, A0, A1, FB or SB.

If you do not specify the function qualifier __frame(), the C compiler
determines which registers must be pushed and popped.

Example

__interrupt(1) __frame(R0,R1) 

void alarm( void )

{

     /* an interrupt function */

}

When you do not want the interrupt frame (saving/restoring registers) to
be generated you can use the compiler option --noframe. In that case
you will have to specify your own interrupt frame. For this you can use
the inline capabilities of the compiler.

Compiler option --noframe (Do not generate frame for interrupt handler)
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3.13 SECTION NAMING

The compiler generates code and data in several types of sections. The
compiler uses the following section naming convention:

module-name[_attr]_mem[_address]

The mem suffix depends on the type of the section and the optional attr
suffix depends on the section attributes and determines if the section is
initialized, constant or uninitialized. The compiler adds the optional
_address when you use the __at() keyword to specify an absolute
address.

Type
mem
suffix

Description Qualifier

code CO program code

data DA __near data (first 64 kB of memory) __near

fdata FD __far data __far

bit BI __bit type section

bita BA __bita type section (bit-addressable data) __bita

Table 3-9: Section types and mem section name suffixes

Attribute
attr 
suffix

Description Qualifier

init INI defines that the section contains

initialization data, which is copied from ROM

to RAM at program startup

clear CLR section is cleared (zeroed) at startup

noclear NCL section is not cleared at startup

romdata RO section contains data to be placed in ROM __rom

fit 65536 PG section fits in a 64 kB page __paged

Table 3-10: Section attributes and attr section name suffixes

Rename sections

You can change the default section names with the following pragma:

#pragma renamesect mem=name [ attribute ] [__at( address )]
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The new name replaces the module-name part of the section names that
have type mem. With the optional attribute you can overrule the section
attribute. With the optional __at() keyword you can place a section at an
absolute address.

For example,

#pragma renamesect DA=flash clear __at(0x20)

All sections of type 'data' have the name "flash_attr_DA" and have
attribute 'clear' and 'at 0x20'.

The following pragma restores the default section naming for type mem.

#pragma endrenamesect mem

See also compiler option -R in section Compiler Options in Chapter Tool
Options of the Reference Guide.
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3.14 LIBRARIES

The TASKING C compiler comes with standard C libraries (ISO/IEC
9899:1999) and header files with the appropriate prototypes for the library
functions. The standard C libraries are available in object format and in C
or assembly source code.

A number of standard operations within C are too complex to generate
inline code for. These operations are implemented as run-time library
functions.

The lib directory of the toolchain contains subdirectories with separate
libraries for the M16C and the R8C.

3.14.1 OVERVIEW OF LIBRARIES

The following tables lists the libraries included in the M16C toolchain, for
the M16C and R8C processors.

Library to link Description

libcs.a

libcm.a

libcl.a

C library for small, medium or large memory model

(Some functions require the floating-point library. Also

includes the startup code.)

libcss.a

libcms.a

libcls.a

Single precision C library for small, medium or large memory

model (compiler option -F)

(Some functions require the floating-point library. Also

includes the startup code.)

libfps.a

libfpm.a

libfpl.a

Floating-point library (non-trapping) for each model

libfpst.a

libfpmt.a

libfplt.a

Floating-point library (trapping) for each model

(Control program option --fp-trap)

librts.a

librtm.a

librtl.a

Run-time library for each model

Table 3-11: Overview of M16C libraries
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Library to link Description

libc.a C library

(Some functions require the floating-point library. Also

includes the startup code.)

libcs.a Single precision C library (compiler option -F)

(Some functions require the floating-point library. Also

includes the startup code.)

libfp.a Floating-point library (non-trapping)

libfpt.a Floating-point library (trapping)

(Control program option --fp-trap)

librt.a Run-time library

Table 3-12: Overview of R8C libraries

See section 2.2, Library Functions, in Chapter Libraries of the Reference
Guide for an extensive description of all standard C library functions.

3.14.2 PRINTF AND SCANF FORMATTING ROUTINES

The C library functions printf(), fprintf(), vfprintf(),
vsprintf(), ... call one single function, _doprint(), that deals with the
format string and arguments. The same applies to all scanf type functions,
which call the function _doscan(), and also for the wprintf and
wscanf type functions which call _dowprint() and _dowscan()
respectively. The C library contains three versions of these routines: int,
long and long long versions. If you use floating-point, the formatter
function for floating-point _doflt() or _dowflt() is called. Depending
on the formatting arguments you use, the correct routine is used from the
library. Of course the larger the version of the routine the larger your
produced code will be.

Note that when you call any of the printf/scanf routines indirect, the
arguments are not known and always the long long version with
floating-point support is used from the library.



User's Guide3-46
C

 L
A

N
G

U
A

G
E

Example:

#include <stdio.h>

long L;

void main(void)

{

    printf( "This is a long: %ld\n", L );

}

The linker extracts the long version without floating-point support from
the library.

3.14.3 REBUILDING LIBRARIES

If you have manually changed one of the standard C library functions, you
need to recompile the standard C libraries.

'Weak' symbols are used to extract the most optimal implementation of a
function from the library. For example if your application does not use
floating-point variables the prinf alike functions do not support
floating-point types either. The compiler emits strong symbols to guide
this process. Do not change the order in which modules are placed in the
library since this may break this process.

The sources of the libraries are present in the lib\src directory. This
directory also contains subdirectories with a makefile for each type of
library:

lib\src\

        m16c\

             libcl\makefile

             libcm\makefile

             libcs\makefile

             librtl\makefile

             librtm\makefile

             librts\makefile

        r8c\

             libc\makefile

             librt\makefile

To rebuild the libraries, follow the next steps.
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First make sure that the bin directory for the toolchain is included in your
PATH environment variable. (See section 1.3.2, Configuring the Command
Line Environment.

1. Make the directory lib\src\m16c\libcl the current working
directory.

This directory contains a makefile which also uses the default make
rules from mkm16c.mk from the cm16c\etc directory.

2. Edit the makefile.

See section 8.3, Make Utility, in Chapter Utilities for an extensive
description of the make utility and makefiles.

3. Assuming the lib\src\m16c\libcl directory is still the current
working directory, type:

mkm16c

to build the library.

The new library is created in the lib\src\m16c\libcl directory.

4. Make a backup copy of the original library and copy the new library to
the lib\m16c directory of the product.

3.15 CONVERTING C MODULES TO ISO C99

The TASKING M16C C compiler fully supports the ISO/IEC 9899:1999(E)
standard. V2.3 and older C source files may not meet the requirements of
the ISO C99 standard. However, EDE provides an option to convert these
files automatically.

To convert one or more C source files:

1. Click on the Convert C modules to the new ISO C style button.

The Conversion dialog box appears.
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2. Select whether you want to convert All C files in project or the Current

selected file.

3. Enable or disable the options Prompt before replace and Insert

comment with each replacement.

If you select comments, you can format the comments to be inserted.

4. Type a format string in the comment field.

For example, to insert C++ style comments with a date, type:
// 2004 1 (where 1 is replaced with the standard replacement message).

5. Click OK to start the conversion.

During conversion the following will be changed:

• M16C keywords with a single underscore are replaced with keywords
with double underscore. For example, replace _bit with __bit.

• Old predefined macro names are replaced with new macro names. For
example, replace _MODEL with __MODEL__.

• Pragmas are replaced, removed or commented because their meaning
has changed. For example, replace #pragma asm/endasm part with
__asm keyword.

• M16C intrinsic functions with a single underscore are replaced with
intrinsic functions with double underscore. For example, replace
_absb with __absb.
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4.1 INTRODUCTION

This chapter describes the most important aspects of the M16C assembly
language. For a complete overview of the M16C assembly language, refer
to the M16C Series Software Manual [Renesas].

4.2 ASSEMBLY SYNTAX

An assembly program consists of zero or more statements. A statement
may optionally be followed by a comment. Any source statement can be
extended to more lines by including the line continuation character (\) as
the last character on the line. The length of a source statement (first line
and continuation lines) is only limited by the amount of available memory.

Mnemonics and directives are case insensitive. Labels, symbols, directive
arguments, and literal strings are case sensitive.

The syntax of an assembly statement is:

[label[:]] [instruction | directive | macro_call] [;comment]

label A label is a special symbol which is assigned the value and
type of the current program location counter. A label can
consist of letters, digits and underscore characters (_). The
first character cannot be a digit. A label which is prefixed by
whitespace (spaces or tabs) has to be followed by a colon (:).
The size of an identifier is only limited by the amount of
available memory.

Examples:

   LAB1:  ; This label is followed by a colon and

            can be prefixed by whitespace

LAB1      ; This label has to start at the beginning

            of a line
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instruction An instruction consists of a mnemonic and zero, one or more
operands. It must not start in the first column. Operands are
described in section 4.4, Operands of an Assembly
Instruction. The instructions are described in the M16C Series
Software Manual [Renesas].

Examples:

REIT                 ; No operand

PUSH.W R0            ; One operand

ADD.W R0,R1          ; Two operands

STZX #12,#22,15[FB]  ; Three operands

directive With directives you can control the assembler from within the
assembly source. These must not start in the first column.
Directives are described in section 4.8, Assembler Directives
and Controls.

macro_call A call to a previously defined macro. It must not start in the
first column. Macros are described in section 4.10 Macro
Operations.

You can use empty lines or lines with only comments.

Apart from the assembly statements as described above, you can put a
so-called 'control line' in your assembly source file. These lines start with
a $ in the first column and alter the default behavior of the assembler.

$control

For more information on controls see section 4.8, Assembler Directives and
Controls.

4.3 ASSEMBLER SIGNIFICANT CHARACTERS

You can use all ASCII characters in the assembly source both in strings and
in comments. Also the extended characters from the ISO 8859-1 (Latin-1)
set are allowed.

Some characters have a special meaning to the assembler. Special
characters associated with expression evaluation are described in section
4.6.3, Expression Operators. Other special assembler characters are:
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Character Description

; Start of a comment

\ Line continuation character or

Macro operator: argument concatenation

? Macro operator: return decimal value of a symbol

% Macro operator: return hex value of a symbol

^ Macro operator: override local label

" Macro string delimiter or

Quoted string DEFINE expansion character

' String constants delimiter

@ Start of a built-in assembly function

$ Location counter substitution

# Constant number (immediate addressing mode)

++ String concatenation operator

[ ] Substring delimiter or

Indirect addressing mode operator

Note that macro operators have a higher precedence than expression
operators.

4.4 OPERANDS OF AN ASSEMBLY INSTRUCTION

In an instruction, the mnemonic is followed by zero, one or more
operands. An operand has one of the following types:

Operand Description

symbol A symbolic name as described in section 4.5, Symbol
Names. Symbols can also occur in expressions.

register Any valid data register (R0, R0H, R0L, R1, R1H, R1L, R2,

R3), address register (A0, A1), frame base register (FB),

static base register (SB), control register (PC, INTB, USP,

ISP, FLG) or special function register. For some instruction

you can use a register pair (R2R0, R3R1, A1A0).

expression Any valid expression as described in the section 4.6,

Assembly Expressions.

address A combination of expression, register and symbol.
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The M16C assembly language has several addressing modes. These
described in detail in the M16C Series Software Manual [Renesas].

4.5 SYMBOL NAMES

User-defined symbols

A user-defined symbol can consist of letters, digits and underscore
characters (_). The first character cannot be a digit. The size of an
identifier is only limited by the amount of available memory. The case of
these characters is significant. You can define a symbol by means of a
label declaration or an equate or set directive.

Labels

Symbols used for memory locations are referred to as labels.

Reserved symbols

Register names and names of assembler directives and controls are
reserved for the system, so you cannot use these for user-defined symbols.
The case of these built-in symbols is insignificant.

Examples

 CON1 EQU 3H    ; The symbol CON1 represents

                ; the value of 3 hex

 MOV.W CON1 + 020H, R1    ; Move contents of address

                          ; 023H to register R1

Valid symbol names Invalid symbol names

loop_1

ENTRY

a_B_c

_aBC

1_loop   (starts with a number)
R0       (reserved register name)
DEFINE   (reserved directive name)
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4.6 ASSEMBLY EXPRESSIONS

An expression is a combination of symbols, constants, operators, and
parentheses which represent a value that is used as an operand of an
assembler instruction (or directive).

Expressions can contain user-defined labels (and their associated integer
or floating-point values), and any combination of integers, floating-point
numbers, or ASCII literal strings.

Expressions follow the conventional rules of algebra and boolean
arithmetic.

Expressions that can be evaluated at assembly time are called absolute
expressions. Expressions where the result is unknown until all sections
have been combined and located, are called relocatable or relative
expressions.

When any operand of an expression is relocatable, the entire expression is
relocatable. Relocatable expressions are emitted in the object file and are
evaluated by the linker. Relocatable expressions can only contain integral
functions; floating-point functions and numbers are not supported by the
ELF/DWARF object format.

The assembler evaluates expressions with 64-bit precision in two's
complement.

An expression can be any of the following:

- numeric contant

- string

- symbol

- expression binary_operator expression

- unary_operator expression

- ( expression )

- function call

All types of expressions are explained in separate sections.
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4.6.1 NUMERIC CONSTANTS

Numeric constants can be used in expressions. If there is no prefix, the
assembler assumes the number is a decimal number.

Base Description Example

Binary '0B' or '0b' followed by binary digits (0,1).
0B1101

0b11001010

Hexadecimal
'0X' or '0x' followed by a hexadecimal

digits (0-9, A-F, a-f).

0X12FF

0x45

0x9abc

Decimal,

integer
Decimal digits (0-9).

12

1245

Decimal,

floating point

Includes a decimal point, or an 'E' or 'e'

followed by the exponent.

6E10

.6

3.14

2.7e10

4.6.2 STRINGS

ASCII characters, enclosed in single (') or double (″) quotes constitue an
ASCII string. Strings between double quotes allow symbol substitution by a
DEFINE directive, whereas strings between single quotes are always literal
strings. Both types of strings can contain escape characters.

Strings constants in expressions are evaluated to a number (each character
is replaced by its ASCII value). Strings in expressions can have a size of up
to a long word (first 4 characters) or less depending on the operand of an
instruction or directive; any subsequent characters in the string are
ignored. In this case the assembler issues a warning. An exception to this
rule is when a string longer than 4 characters is used in a DB assembler
directive; in that case all characters result in a constant byte. Null strings
have a value of 0.

Square brackets ([ ]) delimit a substring operation in the form:

[string,offset,length]

offset is the start position within string. length is the length of the desired
substring. Both values may not exceed the size of string.
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Examples

'ABCD'            ; (0x41424344)

'''79'            ; to enclose a quote double it

"A\"BC"           ; or to enclose a quote escape it

'AB'+1            ; (0x4143) string used in expression

''                ; null string

dl 'abcdef'       ; (0x61626364) 'ef' are ignored

                  ; warning: string value truncated

'ab'++'cd'        ; you can concatenate two strings

                  ; with the '++' operator.

                  ; This results in 'abcd'

['TASKING',0,4]   ; results in the substring 'TASK'

4.6.3 EXPRESSION OPERATORS

The next table shows the assembler operators. They are ordered according
to their precedence. Operators of the same precedence are evaluated left
to right. Expressions between parentheses have the highest priority
(innermost first).

Valid operands include numeric constants, literal ASCII strings and
symbols.

Most assembler operators can be used with both integer and floating-point
values. If one operand has an integer value and the other operand has a
floating-point value, the integer is converted to a floating-point value
before the operator is applied. The result is a floating-point value.
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Type Oper
ator

Name Description

( ) parentheses Expressions enclosed by

parenthesis are evaluated first.

Unary + plus Returns the value of its operand.

- minus Returns the negative of its operand.

~ complement Returns complement, integer only

! logical negate Returns 1 if the operands' value is

1; otherwise 0. For example, if buf

is 0 then !buf is 1.

Arithmetic * multiplication Yields the product of two operands.

/ division Yields the quotient of the division of

the first operand by the second.

With integers, the divide operation

produces a truncated integer.

% modulo Integer only: yields the remainder

from a division of the first operand

by the second.

+ addition Yields the sum of its operands.

- subtraction Yields the difference of its

operands.

Shift << shift left Integer only: shifts the left operand

to the left (zero-filled) by the

number of bits specified by the right

operand.

>> shift right Integer only: shifts the left operand

to the right (sign bit extended) by

the number of bits specified by the

right operand.

Relational <

<=

>

>=

==

!=

less than

less or equal

greater than

greater or equal

equal

not equal

If the indicated condition is:

- True: result is an integer 1

- False: result is an integer 0

Be cautious when you use floating

point values in an equality test;

rounding errors can cause

unexpected results.
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DescriptionNameOper
ator

Type

Bitwise & AND Integer only: yields bitwise AND

| OR Integer only: yields bitwise OR

^ exclusive OR Integer only: yields bitwise exlusive

OR

Logical && logical AND Returns an integer 1 if both

operands are nonzero; otherwise, it

returns an integer 0.

|| logical OR Returns an integer 1 if either of the

operands is nonzero; otherwise, it

returns an integer 1

Table 4-1: Assembly expression operators

4.7 BUILT-IN ASSEMBLY FUNCTIONS

The assembler has several built-in functions to support data conversion,
string comparison, and math computations. You can use functions as terms
in any expression. Functions have the following syntax:

Syntax of an assembly function

@function_name([argument[,argument]...])

Functions start with the '@' character and have zero or more arguments,
and are always followed by opening and closing parentheses. White space
(a blank or tab) is not allowed between the function name and the
opening parenthesis and between the (comma-separated) arguments.

The built-in assembler functions are grouped into the following types:

• Mathematical functions comprise, among others, transcendental,
random value, and min/max functions.

• String functions compare strings, return the length of a string, and
return the position of a substring within a string.

• Macro functions return information about macros.

• Address calculation functions return the high or low part of an
address.

• Assembler mode functions relating assembler operation.
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The following tables provide an overview of all built-in assembler
functions. For a detailed description of these functions, see section 3.2,
Built-in Assembly Function, in Chapter Assembly Language of the
Reference Guide.

Overview of mathematical functions

Function Description

@ABS(expr) Absolute value

@MAX(expr,[,...,exprN]) Maximum value

@MIN(expr,[,...,exprN]) Minimum value

@SGN(expr) Returns the sign of an expression as -1, 0 or 1

Overview of string functions

Function Description

@CAT(str1,str2) Concatenate strings

@LEN(string) Length of string

@POS(str1,str2[,start]) Position of substring in string

@SCP(str1,str2) Returns 1 if two strings are equal

@SUB(string,expr,expr) Returns substring in string

Overview of macro functions

Function Description

@ARG('symbol'|expr) Test if macro argument is present

@CNT() Return number of macro arguments

@MAC(symbol) Test if symbol is defined as a macro

@MXP() Test if macro expansion is active

Overview of address calculation functions

Function Description

@LSW(expr) Returns lower 16 bits of expression value

@MSW(expr) Returns bits 16..31 of expression value
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Overview of assembler mode functions

Function Description

@DEF('symbol'|symbol) Returns 1 if symbol has been defined

@LST() LIST control flag value

4.8 ASSEMBLER DIRECTIVES AND CONTROLS

An assembler directive is simply a message to the assembler. Assembler
directives are not translated into machine instructions. There are three
main groups of assembler directives.

• Assembler directives that tell the assembler how to go about translating
instructions into machine code. This is the most typical form of
assembly directives. Typically they tell the assembler where to put a
program in memory, what space to allocate for variables, and allow
you to initialize memory with data. When the assembly source is
assembled, a location counter in the assembler keeps track of where
the code and data is to go in memory.

The following directives fall under this group:

- Assembly control directives

- Symbol definition directives

- Data definition / Storage allocation directives

- Debug directives

• Directives that are interpreted by the macro preprocessor. These
directives tell the macro preprocessor how to manipulate your
assembly code before it is actually being assembled. You can use these
directives to write macros and to write conditional source code. Parts of
the code that do not match the condition, will not be assembled at all.

• Some directives act as assembler options and most of them indeed do
have an equivalent assembler (command line) option. The advantage
of using a directive is that with such a directive you can overrule the
assembler option for a particular part of the code. Directives of this
kind are called controls. A typical example is to tell the assembler with
an option to generate a list file while with the controls $LIST ON and
$LIST OFF you overrule this option for a part of the code that you do
not want to appear in the list file. Controls always appear on a separate
line and start with a '$' sign in the first column.
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The following controls are available:

- Assembly listing controls

- Miscellaneous controls

Each assembler directive or control has its own syntax. You can use
assembler directives and controls in the assembly code as pseudo
instructions.

4.8.1 OVERVIEW OF ASSEMBLER DIRECTIVES

The following tables provide an overview of all assembler directives. For a
detailed description, see section 3.3.2, Detailed Description of Assembler
Directives, in Chapter Assembly Language of the Reference Guide.

Overview of assembly control directives

Directive Description

COMMENT Start comment lines. You cannot use this directive in

IF/ELSE/ENDIF constructs and MACRO/DUP

definitions.

DEFINE Define substitution string

DEFSECT Define section name, type and attributes

END End of source program

FAIL Programmer generated error message

INCLUDE Include file

MSG Programmer generated message

RADIX Change input radix for constants

SECT Activate a declared section

UNDEF Undefine DEFINE symbol

WARN Programmer generated warning
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Overview of symbol definition directives

Directive Description

BTEQU Bit equate

EQU Assigns permanent value to a symbol

EXTERN External symbol declaration

GLOBAL Global symbol declaration

LOCAL Local symbol declaration

SET Set temporary value to a symbol

SIZE Set size of symbol in the ELF symbol table

TYPE Set symbol type in the ELF symbol table

WEAK Mark symbol as 'weak'

Overview of data definition / storage allocation directives

Directive Description

ALIGN Define alignment

ASCII / ASCIZ Define ASCII string without / with ending NULL byte

BS Define block storage (initialized)

BSB Define byte block storage (initialized)

BSBIT Define bit block storage in bit-addressable data

BSW / BSL Define word / long block storage (initialized)

DB Define constant byte

DBIT Define constant bit

DS Define storage

DW / DL Define a word / long constant

FLOAT / DOUBLE Define a float / double constant
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Overview of macro and conditional assembly directives

Directive Description

DUP Duplicate sequence of source lines

DUPA Duplicate sequence with arguments

DUPC Duplicate sequence with characters

DUPF Duplicate sequence in loop

ENDM End of macro or duplicate sequence

EXITM Exit macro

IF/ELIF/ELSE/ENDIF Conditional assembly

MACRO Define macro

PMACRO Undefine (purge) macro

Overview of debug directives

Directive Description

CALLS Passes call information to object file. Used by the

linker to build a call graph and calculate stack size

4.8.2 OVERVIEW OF ASSEMBLER CONTROLS

The following tables provide an overview of all assembler controls. For a
detailed description, see section 3.3.4, Detailed Description of Assembler
Controls, in Chapter Assembly Language of the Reference Guide.

Overview of assembly listing controls

Control Description

$LIST ON/OFF Generation of assembly list file temporary ON/OFF

$LIST "flags" Exclude / include lines in assembly list file

$PAGE Generate formfeed in assembly list file

$PAGE settings Define page layout for assemly list file

$PRCTL Send control string to printer

$STITLE string Set program subtitle in header of assembly list file

$TITLE string Set program title in headerof assembly list file
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Overview of miscellaneous assembler controls

Control Description

$CASE ON/OFF Case sensitive user names ON/OFF

$DEBUG ON/OFF Generation of symbolic debug ON/OFF

$DEBUG "flags" Generation of symbolic debug ON/OFF

$IDENT

    LOCAL/GLOBAL

Assembler treats labels by default as local or global

$OBJECT Alternative name for the generated object file

$OPTJ ON/OFF Turn on/off conditional optimization

$WARNING OFF [num] Suppress one or all warnings

4.9 WORKING WITH SECTIONS

Sections are absolute or relocatable blocks of contiguous memory that can
contain code or data. Some sections contain code or data that your
program declared and uses directly, while other sections are created by
the compiler or linker and contain debug information or code or data to
initialize your application. These sections can be named in such a way that
different modules can implement different parts of these sections. These
sections are located in memory by the linker (using the linker script
language, LSL) so that concerns about memory placement are postponed
until after the assembly process.

All instructions and directives which generate data or code must be within
an active section. The assembler emits a warning if code or data starts
without a section definition and activation. The compiler automatically
generates sections. If you program in assembly you have to define sections
yourself.

For more information about locating sections see section 7.6.7 The Section
Layout Definition: Locating Sections in chapter Using the Linker.

Section definition

Sections are defined with the DEFSECT directive and have a name. A
section may have attributes to instruct the linker to place it on a
predefined starting address, or that it may be overlaid with another
section.

DEFSECT "name",  type  [, attribute ]...  [AT address]
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See the DEFSECT directive in section 3.3.2, Detailed Description of
Assembler Directives, in chapter Assembly Language of the Reference
Guide, for a complete description of all possible attributes.

Section activation

Sections are defined once and are activated with the SECT directive.

SECT "name"

The linker will check between different modules and emits an error
message if the section attributes do not match. The linker will also
concatenate all matching section definitions into one section. So, all "code"
sections generated by the compiler will be linked into one big "code"
chunk which will be located in one piece. By using this naming scheme it
is possible to collect all pieces of code or data belonging together into one
bigger section during the linking phase. A SECT directive referring to an
earlier defined section is called a continuation. Only the name can be
specified.

Example 1

DEFSECT   "test_CO", CODE

SECT      "test_CO"

Defines and activates a relocatable section in CODE memory. Other parts
of this section, with the same name, may be defined in the same module
or any other module. Other modules should use the same DEFSECT
statement. When necessary, it is possible to give the section an absolute
starting address with the locator description file.

Example 2

DEFSECT   "test_ABS_CO", CODE AT 0x1000

SECT      "test_ABS_CO"

Defines and activates an absolute section named test_ABS_CO starting on
address 0x1000.
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Example 3

DEFSECT   "test_CLR_DA", DATA, CLEAR

SECT      "test_CLR_DA"

Defines a relocatable named section in DATA memory. The CLEAR
attribute instructs the linker to clear the memory located to this section.
When this section is used in another module it must be defined identically.
Continuations of this section in the same module are as follows:

SECT "test_CLR_DA"

4.10 MACRO OPERATIONS

Macros provide a shorthand method for inserting a repeated pattern of
code or group of instructions. Yuo can define the pattern as a macro, and
then call the macro at the points in the program where the pattern would
repeat.

Some patterns contain variable entries which change for each repetition of
the pattern. Others are subject to conditional assembly.

When a macro is called, the assembler executes the macro and replaces
the call by the resulting in-line source statements. 'In-line' means that all
replacements act as if they are one the same line as the macro call. The
generated statements may contain substitutable arguments. The statements
produced by a macro can be any processor instruction, almost any
assembler directive, or any previously-defined macro. Source statements
resulting from a macro call are subject to the same conditions and
restrictions as any other statements.

Macros can be nested. The assembler processes nested macros when the
outer macro is expanded.

4.10.1 DEFINING A MACRO

The first step in using a macro is to define it in the source file. The
definition of a macro consists of three parts:

• Header, which assigns a name to the macro and defines the arguments.

• Body, which contains the code or instructions to be inserted when te
macro is called.
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• Terminator, which indicates the end of the macro definition (ENDM
directive).

A macro definition takes the following form:

Header: macro_name MACRO [arg[,arg]...] [; comment]

                   .

Body:              source statements

                   .

Terminator:            ENDM

If the macro name is the same as an existing assembler directive or
mnemonic opcode, the assembler replaces the directive or mnemonic
opcode with the macro and issues a warning.

The arguments are symbolic names that the macro preprocessor replaces
with the literal arguments when the macro is expanded (called). Each
argument must follow the same rules as global symbol names. Argument
names cannot start with a percent sign (%).

Example

The macro definition:

CONSTD  MACRO  reg,value                    ;header

    mov.w   #value,reg                      ;body

    ENDM                                    ;terminator

The macro call:

    DEFSECT  "data",DATA

    SECT    "data"

    CONSTD  R0,0x1234

    END

The macro expands as follows:

    mov.w   #0x1234,R0
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4.10.2 CALLING A MACRO

To invoke a macro, construct a source statement with the following format:

[label] macro_name [arg[,arg]...]          [; comment]

where:

label An optional label that corresponds to the value of the
location counter at the start of the macro expansion.

macro_name The name of the macro. This may not start in the first
column.

arg One or more optional, substitutable arguments. Multiple
arguments must be separated by commas.

comment An optional comment.

The following applies to macro arguments:

• Each argument must correspond one-to-one with the formal arguments
of the macro definition. If the macro call does not contain the same
number of arguments as the macro definition, the assembler issues a
warning.

• If an argument has an embedded comma or space, you must surround
the argument by single quotes (').

• You can declare a macro call argument as NULL in three ways:

- enter delimiting commas in succession with no intervening spaces

macroname ARG1,,ARG3 ; the second argument

                       is a NULL argument

- terminate the argument list with a comma, the arguments that
normally would follow, are now considered NULL

macroname ARG1,      ; the second and all following

                       arguments are NULL

- declare the argument as a NULL string

• No character is substituted in the generated statements that reference a
NULL argument.
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4.10.3 USING OPERATORS FOR MACRO ARGUMENTS

The assembler recognizes certain text operators within macro definitions
which allow text substitution of arguments during macro expansion. You
can use these operators for text concatenation, numeric conversion, and
string handling.

Operator Name Description

\ Macro argument

concatenation

Concatenates a macro argument with

adjacent alphanumeric characters.

? Return decimal

value of symbol

Substitutes the ?symbol sequence with a

character string that represents the decimal

value of the symbol.

% Return hex

value of symbol

Substitutes the %symbol sequence with a

character string that represents the

hexadecimal value of the symbol.

" Macro string

delimiter

Allows the use of macro arguments as literal

strings.

^ Macro local label

override

Causes local labels in its term to be evaluated

at normal scope rather than at macro scope.

Argument Concatenation Operator - \

Consider the following macro definition:

SWAP_REG MACRO REG1,REG2         ;swap register contents

     XCHG.B    R\REG1\H, R\REG2\H

     ENDM

The macro is called as follows:

     SWAP_REG  0,1

The macro expands as follows:

     XCHG.B    R0H, R1H

The macro preprocessor substitutes the character '0' for the argument
REG1, and the character '1' for the argument REG2. The concatenation
operator (\) indicates to the macro preprocessor that the substitution
characters for the arguments are to be concatenated with the character 'R'.

Without the '\' operator the macro would expand as:

     XCHG.B    RREG1H, RREG2H
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which results in an assembler error (invalid operand).

Decimal value Operator - ?

Instead of substituting the formal arguments with the actual macro call
arguments, you can also use the value of the macro call arguments.

Consider the following source code that calls the macro SWAP_SYM after
the argument AREG has been set to 0 and BREG has been set to 1.

AREG SET      0

BREG SET      1

     SWAP_SYM  AREG,BREG

If you want to replace the arguments with the value of AREG and BREG
rather than with the literal strings 'AREG' and 'BREG', you can use the ?
operator and modify the macro as follows:

SWAP_SYM   MACRO  REG1,REG2       ;swap memory contents

     XCHG.W    R\?REG1, R\?REG2

     ENDM

The macro first expands as follows:

     XCHG.W    R\?AREG, R\?BREG

Then ?AREG is replaced by '0' and ?BREG is replaced by '1':

     XCHG.W    R\0, R\1

Because of the concatenation operator '\' the strings are concatenated:

     XCHG.W    R0, R1

Hex Value Operator - %

The percent sign (%) is similar to the standard decimal value operator (?)
except that it returns the hexadecimal value of a symbol.

Consider the following macro definition:

GEN_LAB   MACRO  LAB,VAL,STMT

LAB\%VAL  STMT

     ENDM
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A symbol with the name NUM is set to 10 and the macro is called with
NUM as argument:

NUM SET       10

    GEN_LAB    HEX,NUM,NOP

The macro expands as follows:

HEXA NOP

The %VAL argument is replaced by the character 'A' which represents the
hexadecimal value 10 of the argument VAL.

Argument String Operator - "

To generate a literal string, enclosed by single quotes ('), you must use the
argument string operator (") in the macro definition.

Consider the following macro definition:

STR_MAC    MACRO  STRING

    DB  "STRING"

    ENDM

The macro is called as follows:

STR_MAC  ABCD

The macro expands as follows:

 DB  'ABCD'

Within double quotes DEFINE directive definitions can be expanded. Take
care when using constructions with quotes and double quotes to avoid
inappropriate expansions. Since a DEFINE expansion occurs before a
macro substitution, all DEFINE symbols are replaced first within a macro
argument string:

    DEFINE LONG  'short'

STR_MAC    MACRO  STRING

    MSG 'This is a LONG STRING'

    MSG "This is a LONG STRING"

    ENDM

If the macro is called as follows:

 STR_MAC  sentence
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The macro expands as:

MSG 'This is a LONG STRING'

MSG 'This is a short sentence'

Single quotes prevent expansion.

Macro Local Label Override Operator - ^

If you use labels in macros, the assembler normally generates another
unique name for the labels (such as LAB__M_L0000001).

The macro ^-operator prevents name mangling on macro local labels.

Consider the following macro definition:

INIT   MACRO ARG, CNT

       MOV.W #CNT,A0

^LAB:

       DB ARG

       DEC.W A0

       JNZ ^LAB

       ENDM

The macro is called as follows:

      INIT 2,4

The macro expands as:

       MOV.W #4,A0

LAB:

       DB 2

       DEC.W A0

       JNZ LAB

Without the ^ operator, the macro preprocessor would choose another
name for LAB because the label already exists. The macro then would
expand like:

       MOV.W #4,A0

LAB__M_L000001:

       DB 2

       DEC.W A0

       JNZ LAB__M_L000001
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4.10.4 USING THE DUP, DUPA, DUPC, DUPF

DIRECTIVES AS MACROS

The DUP, DUPA, DUPC, and DUPF directives are specialized macro forms
to repeat a block of source statements. You can think of them as a
simultaneous definition and call of an unnamed macro. The source
statements between the DUP, DUPA, DUPC, and DUPF directives and the
ENDM directive follow the same rules as macro definitions.

For a detailed description of these directives, see section 3.3, Assembler
Directives, in Chapter Assembly Language of the Reference Guide.

4.10.5 CONDITIONAL ASSEMBLY: IF, ELIF AND ELSE

DIRECTIVES

With the conditional assembly directives you can instruct the macro
preprocessor to use a part of the code that matches a certain condition.

You can specify assembly conditions with arguments in the case of
macros, or through definition of symbols via the DEFINE, SET, and EQU
directives.

The built-in functions of the assembler provide a versatile means of testing
many conditions of the assembly environment.

You can use conditional directives also within a macro definition to check
at expansion time if arguments fall within a certain range of values. In this
way macros become self-checking and can generate error messages to any
desired level of detail.

The conditional assembly directive IF has the following form:

IF  expression

 .

 .

[ELIF  expression] ;(the ELIF directive is optional)

 .

 .

[ELSE]             ;(the ELSE directive is optional)

 .

 .

ENDIF
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The expression must evaluate to an absolute integer and cannot contain
forward references. If expression evaluates to zero, the IF-condition is
considered FALSE. Any non-zero result of expression is considered as
TRUE.

For a detailed description of these directives, see section 3.3, Assembler
Directives, in Chapter Assembly Language of the Reference Guide.
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5.1 INTRODUCTION

EDE uses a makefile to build your entire project, from C source till the
final ELF/DWARF object file which serves as input for the debugger.

Although in EDE you cannot run the compiler separately from the other
tools, this chapter discusses the options that you can specify for the
compiler.

On the command line it is possible to call the compiler separately from the
other tools. However, it is recommended to use the control program
ccm16c for command line invocations of the toolchain (see section 8.2,
Control Program, in Chapter Using the Utilities). With the control program
it is possible to call the entire toolchain with only one command line.

The compiler takes the following files for input and output:

assembly file

C source file

C compiler

.ic

cm16c
.err

.src

C source file

(hand coded)

.c

error messages

Figure 5-1: C compiler

This chapter first describes the compilation process which consists of a
frontend and a backend part. During compilation the code is optimized in
several ways. The various optimizations are described in the second
section. Third it is described how to call the compiler and how to use its
options. An extensive list of all options and their descriptions is included
in the section 4.1, Compiler Options, in Chapter 4, Tool Options, of the
Reference Guide. Finally, a few important basic tasks are described.
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5.2 COMPILATION PROCESS

During the compilation of a C program, the compiler cm16c runs through
a number of phases that are divided into two groups: frontend and
backend.

The backend part is not called for each C statement, but starts after a
complete C module or set of modules has been processed by the frontend
(in memory). This allows better optimization.

Frontend phases

1. The preprocessor phase:

The preprocessor includes files and substitutes macros by C source. It uses
only string manipulations on the C source. The syntax for the preprocessor
is independent of the C syntax but is also described in the ISO/IEC
9899:1999(E) standard.

2. The scanner phase:

The scanner converts the preprocessor output to a stream of tokens.

3. The parser phase:

The tokens are fed to a parser for the C grammar. The parser performs a
syntactic and semantic analysis of the program, and generates an
intermediate representation of the program. This code is called MIL
(Medium level Intermediate Language).

4. The frontend optimization phase:

Target processor independent optimizations are performed by transforming
the intermediate code.
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Backend phases

1. Instruction selector phase:

This phase reads the MIL input and translates it into Low level
Intermediate Language (LIL). The LIL objects correspond to an M16C
processor instruction, with an opcode, operands and information used
within the compiler.

2. Peephole optimizer phase:

This phase replaces instruction sequences by equivalent but faster and/or
shorter sequences, rearranges instructions and deletes unnecessary
instructions.

3. Register allocator phase:

This phase chooses a physical register to use for each virtual register.

4. The backend optimization phase:

Performs target processor independent and dependent optimizations which
operate on the Low level Intermediate Language.

5. The code generation/formatter phase:

This phase reads through the LIL operations to generate assembly
language output.

5.3 COMPILER OPTIMIZATIONS

The compiler has a number of optimizations which you can enable or
disable. To enable or disable optimizations:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Optimization.

3. Select an optimization level in the Optimization level box.

or:

In the Optimization level box, select Custom optimization and
enable the optimizations you want in the Custom optimization box.



User's Guide5-6
C
O
M
P
IL
E
R

Optimization levels

The TASKING C compilers offer four optimization levels and a custom
level, at each level a specific set of optimizations is enabled.

• Level 0: No optimizations are performed. The compiler tries to achieve
a 1-to-1 resemblance between source code and produced code.
Expressions are evaluated in the order written in the source code,
associative and commutative properties are not used.

• Level 1: Enables optimizations that do not affect the debug-ability of
the source code. Use this level when you are developing/debugging
new source code.

• Level 2: Enables more aggressive optimizations to reduce the memory
footprint and/or execution time. The debugger can handle this code
but the relation between source code and generated instructions may
be hard to understand. Use this level for those modules that are already
debugged. This is the default optimization level.

• Level 3: Enables aggressive global optimization techniques. The
relation between source code and generated instructions can be very
hard to understand. The debugger does not crash, will not provide
misleading information, but does not fully understand what is going
on. Use this level when your program does not fit in the memory
provided by your system anymore, or when your program/hardware
has become too slow to meet your real-time requirements.

• Custom level: you can enable/disable specific optimizations.

Optimization pragmas

If you specify a certain optimization, all code in the module is subject to
that optimization. Within the C source file you can overrule the compiler
options for optimizations with #pragma optimize flag and #pragma
endoptimize. Nesting is allowed:

#pragma optimize e    /* Enable expression

...                      simplification               */

... C source ...

...

#pragma optimize c    /* Enable common expression

...                      elimination. Expression

... C source ...         simplification still enabled */

...

#pragma endoptimize   /* Disable common expression

...                      elimination                  */

#pragma endoptimize   /* Disable expression

...                      simplification               */

The compiler optimizes the code between the pragma pair as specified.
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You can enable or disable the optimizations described below. The
command line option for each optimization is given in brackets.

See also option -O (--optimize) in section 4.1, Compiler Options, of
Chapter Tool Options of the Reference Guide.

Generic optimizations (frontend)

Common subexpression elimination (CSE)  (option -Oc/-OC)

The compiler detects repeated use of the same (sub-)expression. Such a
"common" expression is replaced by a variable that is initialized with the
value of the expression to avoid recomputation. This method is called
common subexpression elimination (CSE).

Expression simplification  (option -Oe/-OE)

Multiplication by 0 or 1 and additions or subtractions of 0 are removed.
Such useless expressions may be introduced by macros or by the compiler
itself (for example, array subscription).

Constant propagation  (option -Op/-OP)

A variable with a known constant value is replaced by that value.

Function Inlining  (option -Oi/-OI)

Small functions that are not too often called, are inlined. This reduces
execution time at the cost of code size.

Compaction (reverse inlining)  (option -Or/-OR)

Compaction is the opposite of inlining functions: large chunks of code
that occur more than once, are transformed into a function. This reduces
code size at the cost of execution speed.

Control flow simplification  (option -Of/-OF)

A number of techniques to simplify the flow of the program by removing
unnecessary code and reducing the number of jumps. For example:

Switch optimization:
A number of optimizations of a switch statement are performed, such
as removing redundant case labels or even removing an entire switch.
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Jump chaining:
A (conditional) jump to a label which is immediately followed by an
unconditional jump may be replaced by a jump to the destination label
of the second jump. This optimization speeds up execution.

Conditional jump reversal:
A conditional jump over an unconditional jump is transformed into one
conditional jump with the jump condition reversed. This reduces both
the code size and the execution time.

Dead code elimination:
Code that is never reached, is removed. The compiler generates a
warning messages because this may indicate a coding error.

Subscript strength reduction  (option -Os/-OS)

An array of pointer subscripted with a loop iterator variable (or a simple
linear function of the iterator variable), is replaced by the dereference of a
pointer that is updated whenever the iterator is updated.

Loop transformations  (option -Ol/-OL)

Temporarily transform a loop with the entry point at the bottom, to a loop
with the entry point at the top. This enables constant propagation in the
initial loop test and code motion of loop invariant code by the CSE
optimization.

Forward store  (option -Oo/-OO)

A temporary variable is used to cache multiple assignments (stores) to the
same non-automatic variable.

Core specific optimizations (backend)

Coalescer  (option -Oa/-OA)

The coalescer seeks for possibilities to reduce the number of moves (MOV
instruction) by smart use of registers. This optimizes both speed as code
size.

Interprocedural register optimization (option -Ob/-OB)

Register allocation is improved by taking note of register usage in
functions called by a given function.
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Peephole optimizations  (option -Oy/-OY)

The generated assembly code is improved by replacing instruction
sequences by equivalent but faster and/or shorter sequences, or by
deleting unnecessary instructions.

Generic assembly optimizations  (option -Og/-OG)

A set of target independent optimizations that increase speed and decrease
code size.

Optimize 'call+return' to jump (option -Oz/-OZ)

A function call which is immediately followed by a function return is
replaced by a jump. With this optimization a call trace is no longer
possible.

5.3.1 OPTIMIZE FOR SIZE OR SPEED

You can tell the compiler to focus on execution speed or code size during
optimizations. You can do this by specifying a size/speed trade-off level
from 0 (speed) to 4 (size). This trade-off does not turn optimization
phases on or off. Instead, its level is a weight factor that is used in the
different optimization phases to influence the heuristics. The higher the
level, the more the compiler focuses on code size optimization.

To specify the size/speed trade-off optimization level:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Optimization.

3. Select one of the options Optimize for size or Optimize for speed.

See also option -t (--tradeoff) in section 4.1, Compiler Options, in
Chapter Tool Options of the Reference Guide.
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5.4 CALLING THE COMPILER

EDE uses a makefile to build your entire project. This means that you
cannot run the compiler only. If you compile a single C source file from
within EDE, the file is also automatically assembled. However, you can set
options specific for the compiler. After you have build your project, the
output files of the compilation step are available in your project directory.

To compile your program, click either one of the following buttons:

Compiles and assembles the currently selected file. This
results in a relocatable object file (.obj).

Builds your entire project but looks whether there are already
files available that are needed in the building process. If so,
these files will not be generated again, which saves time.

Builds your entire project unconditionally. All steps necessary
to obtain the final .elf file are performed.

To only check for syntax errors, click the following button:

Checks the currently selected file for syntax errors, but does
not generate code.

Select a target processor (core)

Because the toolchain supports several processor cores, you need to
choose a processor type first.

To access the M16C processor options:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Processor entry and select Processor Definition.

3. In the Select processor list select the target processor.

4. (Optional) Fill in the Startup Code page.

5. Click OK to accept the processor options.

Processor options affect the invocation of all tools in the toolchain. In
EDE you only need to set them once. The corresponding options for the
compiler are listed in table 5-1.
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Based on the target processor, the compiler includes a special function
register file regcpu.sfr. This is an include file written in C syntax which
is shared by the compiler, assembler and debugger. Once the compiler
reads an SFR file you can reference the special function registers (SFR) and
bits within an SFR using symbols defined in the SFR file.

To specify the search path and include directories

1. From the Project menu, select Directories...

The Directories dialog box appears.

2. Fill in the directory path settings and click OK.

To access the compiler options

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry, fill in the various pages and click OK to
accept the compiler options.

The compiler command line equivalences of your EDE selections are
shown simultaneously in the Options string box.

The following processor options are available:

EDE options Command line

Processor Definition

Select processor -Ccpu

Compile for R8C/tiny instead of M16C/60 --r8c

Memory

Internal memory EDE only

Startup Code

Add <project>_cstart.src to your project EDE only

Table 5-1: Processor options
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The following project directories are available:

EDE options Command line

Directories

Executable files path

Include files path

Library files path

$PATH environment

-Idir

linker option -Ldir

Table 5-2: Project directories

The following compiler options are available:

EDE options Command line

Memory Models

Compile using small/medium/large memory model -M{s|m|l}

Code Generation

Keep strings in ROM --romstrings

Keep constants in ROM --romconstants

ROM is available in first 64k of memory --near-rom

Generate code for fixed interrupt vector --novector

Generate frame for interrupt routines --noframe

Preprocessing

Define user macro -Dmacro[=def]

Include an extra file at the beginning of the C source -Hfile

Store the C compiler preprocess output (file.pre) -Eflag

Alignment

Align functions to an even address --align-func

Align data to an even address --align-data

Optimization

Optimization level

Custom optimization

-O{0|1|2|3}

-Oflag

Optimize for size/speed -t{0|4}

Language

ISO C standard 90 or 99 (default: 99) -c{90|99}

Treat 'char' variables as unsigned instead of signed -u
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Command lineEDE options

Treat 'int' bitfield as signed --signed-bitfields

Treat enumerated types always as integer --integer-
   enumeration

Language extensions

Allow C++ style comments in C source

Check assignment constant string to 

non constant string pointer

-Aflag
-Ap
-Ax

Debug

Generate debug information -g

Floating Point

Use single precision floating point only -F

Floating point trap/exception handling control program option
--fp-trap

Diagnostics

Report all warnings

Suppress all warnings

Suppress specific warnings

Treat warnings as errors

no option -w
-w
-wnum[,num]...

--warnings-as-
errors

MISRA C

MISRA C rules --misrac={all|nr[-nr]
,...}

Produce MISRA C report file linker option
--misra-c-report

Miscellaneous

Merge C source code with assembly in output file

(.src)

-s

Additional C Compiler options options

Table 5-3: Compiler options

The following options are available on the command line, and you can set
them in EDE through the Additional C Compiler options field in the
Miscellaneous page:

Description Command line

Display invocation syntax -?

Align all objects on an even address --align
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Command lineDescription

Maximum size of a match with code compaction

(default: 200)

--compact-max-size
= value

Redirect diagnostic messages to a file --error-file[=file]

Read options from file -f file

Always inline function calls --inline

Maximum size increment inlining (in %) (default: 25) --inline-max-incr=
value

Maximum size for function to always inline 

(default: 10)

--inline-max-size=
value

Keep output file after errors -k

Maximum call depth, default infinite

(default: -1)

--max-call-depth=
value

Send output to standard output -n

Do not clear non-initialized global variables --noclear

Do not generate frame for interrupt handler --noframe

Specify name of output file -o file

Rename sections -Rmem=name

Treat external definitions as "static" --static

Display version header only -V

Table 5-4: Compiler options only available on the command line

The invocation syntax on the command line is:

cm16c [option]... [file]

The input file must be a C source file (.c or .ic).

cm16c test.c

This compiles the file test.c and generates the file test.src which
serves as input for the assembler.

For a complete overview of all options with extensive description, see
section 4.1, Compiler Options, of Chapter Tool Options of the Reference
Guide.
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5.5 HOW THE COMPILER SEARCHES INCLUDE FILES

When you use include files, you can specify their location in several ways.
The compiler searches the specified locations in the following order:

1. The absolute pathname, if specified in the #include statement. Or, if no
path or a relative path is specified, the same directory as the source file.
This is only possible for include files that are enclosed in "".

This first step is not done for include files enclosed in <>.

2. The directories that are specified in the Project | Directories dialog (-I

option).

3. The paths which were set during installation. You can still change these
paths.

See section 1.3.1, Configuring the Embedded Development Environment
and environment variable CM16CINC in section 1.3.2, Configuring the
Command Line Environment, in Chapter Software Installation.

4. The default include directory relative to the installation directory.

5.6 COMPILING FOR DEBUGGING

Compiling your files is the first step to get your application ready to run
on a target. However, during development of your application you first
may want to debug your application.

To create an object file that can be used for debugging, you must instruct
the compiler to include symbolic debug information in the source file.

To include symbolic debug information

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Debug Information.

3. Enable the option Generate debug information.
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4. Click OK to accept the new project settings.

cm16c -g

Debug and optimizations

Due to different compiler optimizations, it might be possible that certain
debug information is optimized away. Therefore, it is best to specify
Debug purpose (-O1) when you want to debug your application. This is
a special optimization level where the source code is still suitable for
debugging.

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select Optimization.

3. In the Optimization level box, select Debug purpose.

5.7 C CODE CHECKING: MISRA C

The C programming language is a standard for high level language
programming in embedded systems, yet it is considered somewhat
unsuitable for programming safety-related applications. Through enhanced
code checking and strict enforcement of best practice programming rules,
TASKING MISRA C code checking helps you to produce more robust code.

MISRA C specifies a subset of the C programming language which is
intended to be suitable for embedded automotive systems. It consists of a
set of 127 rules, defined in the document "Guidelines for the Use of the C
Language in Vehicle Based Software" published by "Motor Industry
Research Association" (MISRA).

For a complete overview of all MISRA C rules, see Chapter 8, MISRA C
Rules, in the Reference Guide.
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Implementation issues

The MISRA C implementation in the compiler supports 117 of the 127
rules. Some MISRA C rules address documentation, run-time behavior, or
other issues that cannot be checked by static source code inspection.
Therefore, the following rules are not implemented: 2, 4, 6, 15, 41, 116,
117.  In addition, the rules 23, 25 and 27 are not implemented in the
compiler, because they cannot be checked without an application-wide
overview.

During compilation of the code, violations of the enabled MISRA C rules
are indicated with error messages and the build process is halted.

Note that not all MISRA C violations will be reported when other errors are
detected in the input source. For instance, when there is a syntax error, all
semantic checks will be skipped, including some of the MISRA C checks.
Also note that some checks cannot be performed when the optimizations
are switched off.

Quality Assurance report

To ensure compliance to the MISRA C rules throughout the entire project,
the TASKING M16C linker can generate a MISRA C Quality Assurance
report. This report lists the various modules in the project with the
respective MISRA C settings at the time of compilation. You can use this in
your company's quality assurance system to provide proof that company
rules for best practice programming have been applied in the particular
project.

Apply MISRA C code checking to your application

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the C Compiler entry and select MISRA C.

3. Select a MISRA C configuration. Select a predefined configuration for
conformance with the required rules in the MISRA C guidelines.

4. (Optional) In the MISRA C Rules entry, specify the individual rules.

cm16c --misrac={all | number [-number],...}
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See compiler option --misrac in section 4.1, Compiler Options in Chapter
Tool Options of the Reference Guide.

See linker option --misra-c-report in section 4.3, Linker Options in
Chapter Tool Options of the Reference Guide.

5.8 C COMPILER ERROR MESSAGES

The cm16c compiler reports the following types of error messages:

F Fatal errors

After a fatal error the compiler immediately aborts compilation.

E Errors

Errors are reported, but the compiler continues compilation. No output
files are produced unless you have set the compiler option
--keep-output-files (the resulting output file may be incomplete).

W Warnings

Warning messages do not result into an erroneous assembly output file.
They are meant to draw your attention to assumptions of the compiler for
a situation which may not be correct. You can control warnings in the C
Compiler | Diagnostics page of the Project | Project Options... menu
(compiler option -w).

I Information

Information messages are always preceded by an error message.
Information messages give extra information about the error.

S System errors

System errors occur when internal consistency checks fail and should
never occur. When you still receive the system error message

S9##: internal consistency check failed - please report

please report the error number and as many details as possible about the
context in which the error occurred. The following helps you to prepare
an e-mail using EDE:
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1. From the Help menu, select Technical Support -> Prepare Email...

The Prepare Email form appears.

2. Fill out the the form. State the error number and attach relevant files.

3. Click the Copy to Email client button to open your email application.

A prepared e-mail opens in your e-mail application.

4. Finish the e-mail and send it.

Display detailed information on diagnostics

1. In the Help menu, enable the option Show Help on Tool Errors.

2. In the Build tab of the Output window, double-click on an error or
warning message.

A description of the selected message appears.

cm16c --diag=[format:]{all | number,...}

See compiler option --diag in section 4.1, Compiler Options in Chapter
Tool Options of the Reference Guide.
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6.1 INTRODUCTION

The assembler converts hand-written or compiler-generated assembly
language programs into machine language, resulting in object files in the
Executable and Linking Format (ELF).

The assembler takes the following files for input and output:

assembly file

assembler

asm16c

.src
assembly file .asm

(hand coded)

relocatable object file

.obj

list file .lst

error messages .ers

(compiler generated)

Figure 6-1: Assembler

This chapter first describes the assembly process. The various assembler
optimizations are described in the second section. Third it is described
how to call the assembler and how to use its options. An extensive list of
all options and their descriptions is included in the Reference Guide.
Finally, a few important basic tasks are described.

6.2 ASSEMBLY PROCESS

The assembler generates relocatable output files with the extension .obj.
These files serve as input for the linker.

Phases of the assembly process

1. Parsing of the source file: preprocessing of assembler directives and
checking of the syntax of instructions

2. Optimization (instruction alignment, size and generic instructions)

3. Generation of the relocatable object file and optionally a list file

The assembler integrates file inclusion and macro facilities. See section
4.10,  Macro Operations, in Chapter Assembly Language for more
information.
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6.3 ASSEMBLER OPTIMIZATIONS

The asm16c assembler performs various optimizations to reduce the size
of the assembled applications. To enable or disable optimizations:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry and select Optimization.

You can enable or disable the optimizations described below. The
command line option for each optimization is given in brackets.

See also option -O (--optimize) in section 4.2, Assembler Options, in
Chapter Tool Options of the Reference Guide.

Instruction alignment  (option -Oa/-OA)

When this option is enabled, the assembler aligns instructions with an
even size on even addresses. Odd sized instructions are not aligned.

Allow generic instructions  (option -Og/-OG)

When this option is enabled, you can use generic instructions in your
assembly source. The assembler tries to replace the generic instructions by
faster or smaller instructions. For example, the generic instruction 
jeq _label1 is replaced by jne __T1; jz _label1; __T1:. 
By default this option is enabled. Because shorter instructions may
influence the number of cycles, you may want to disable this option when
you have written timed code. In that case the assembler encodes all
instructions as they are.

Optimize instruction size  (option -Os/-OS)

When this option is enabled, the assembler tries to find the shortest
possible operand encoding for instructions. By default this option is
enabled.
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6.4 CALLING THE ASSEMBLER

EDE uses a makefile to build your entire project. You can set options
specific for the assembler. After you have built your project, the output
files of the assembling step are available in your project directory.

To assemble your program, click either one of the following buttons:

Assembles the currently selected assembly file (.asm or
.src). This results in a relocatable object file (.obj).

Builds your entire project but looks whether there are already
files available that are needed in the building process. If so,
these files will not be generated again, which saves time.

Builds your entire project unconditionally. All steps necessary
to obtain the final .elf file are performed.

To only check for syntax errors, click the following button:

Checks the currently selected assembly file for syntax errors,
but does not generate code.

Select a target processor (core)

Because the toolchain supports several processor cores, you need to
choose a processor type first.

To access the M16C processor options:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Processor entry, fill in the Processor Definition page
and optionally the Startup Code page and click OK to accept the
processor options.

Processor options affect the invocation of all tools in the toolchain. In
EDE you only need to set them once. The corresponding options for the
assembler are listed in table 6-1.

Based on the target processor, the assembler includes a special function
register file regcpu.sfr. This is an include file written in C syntax which
is shared by the compiler, assembler and debugger. Once the assembler
reads an SFR file you can reference the special function registers (SFR) and
bits within an SFR using symbols defined in the SFR file.
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To access the assembler options

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Assembler entry, fill in the various pages and click OK to
accept the project options.

The assembler command line equivalences of your EDE selections are
shown simultaneously in the Options string box.

The following processor options are available:

EDE options Command line

Processor Definition

Select processor -Ccpu

Target R8C/tiny instead of M16C/60 --r8c

Memory

Internal memory EDE only

Startup Code

Add <project>_cstart.src to your project EDE only

Table 6-1: Processor options

The following assembler options are available:

EDE options Command line

Preprocessing

Define user macro -Dmacro[=def]

Include this file before source -Hfile

Optimization

Optimize speed by means of instruction alignment

Allow generic instructions

Optimize instruction size

-Oa/-OA      (= on/off)

-Og/-OG
-Os/-OS

Debug

No debug information

Automatic HLL or assembly level debug information

Custom debug information

-gAHLS
-gs
-gflag
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Command lineEDE options

List File

Generate list file -l

Custom list file generation options -Lflags

Generate section summary in list file -tl

Diagnostics

Report all warnings

Suppress all warnings

Suppress specific warnings

no option -w
-w
-wnum[,num]...

Treat warnings as errors --warnings-as-errors

Miscellaneous

Generate section summary -tc

Case sensitive identifiers no option -c

Additional assembler options options

Table 6-2: Assembler options

The following options are available on the command line, and you can set
them in EDE through the Additional assembler options field in the
Miscellaneous page:

Description Command line

Display invocation syntax -?

Emit local symbols --emit-locals

Redirect diagnostic messages to a file --error-file[=file]

Read options from file -f file

Labels are by default:

local (default)

global

-il
-ig

Keep output file after errors -k

Select TASKING preprocessor or no preprocessor -m{t|n}

Specify name of output file -o file

Verbose information -v

Display version header only -V

Table 6-3: Assembler command line options
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The invocation syntax on the command line is:

asm16c [option]... [file]

The input file must be an assembly source file (.asm or .src).

asm16c test.asm

This assembles the file test.asm for and generates the file test.o
which serves as input for the linker.

For a complete overview of all options with extensive description, see
section 4.2, Assembler Options, of Chapter Tool Options of the Reference
Guide.

6.5 HOW THE ASSEMBLER SEARCHES INCLUDE FILES

When you use include files, you can specify their location in several ways.
The assembler searches the specified locations in the following order:

1. The absolute pathname, if specified in the INCLUDE directive. Or, if no
path or a relative path is specified, the same directory as the source file.

2. The directories that are specified in the Project | Directories dialog (-I

option).

3. The paths which were set during installation. You can still change these
paths.

See section 1.3.1, Configuring the Embedded Development Environment
and environment variable ASM16CINC in section 1.3.2, Configuring the
Command Line Environment, in Chapter Software Installation.

4. The default include directory relative to the installation directory.

6.6 GENERATING A LIST FILE

The list file is an additional output file that contains information about the
generated code. You can also customize the amount and form of
information.

If the assembler generates errors or warnings, these are reported in the list
file just below the source line that caused the error or warning.
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To generate a list file

1. From the Project menu, select Project Options...

The Project Options dialog appears.

2. Expand the Assembler entry and select List File.

3. In the List file generation box, select Enable default list file

generation or Custom list file generation options.

4. If you selected Custom, enable the options you want to include in the
list file.

EDE generates a list file for each source file in your project. A list file gets
the same basename as the source file but with extension .lst.

Example on the command line

The following command generates the list file test.lst.

asm16c -l test.src

See section 5.1, Assembler List File Format, in Chapter List File Formats of
the Reference Guide for an explanation of the format of the list file.

6.7 ASSEMBLER ERROR MESSAGES

The assembler produces error messages of the following types:

F Fatal errors

After a fatal error the assembler immediately aborts the assembling
process.

E Errors

Errors are reported, but the assembler continues assembling. No output
files are produced unless you have set the assembler option
--keep-output-files (the resulting output file may be incomplete).
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W Warnings

Warning messages do not result into an erroneous assembly output file.
They are meant to draw your attention to assumptions of the assembler for
a situation which may not be correct. You can control warnings in the
Assembler | Diagnostics page of the Project | Project Options...

menu (assembler option -w).

Display detailed information on diagnostics

1. In the Help menu, enable the option Show Help on Tool Errors.

2. In the Build tab of the Output window, double-click on an error or
warning message.

A description of the selected message appears.

asm16c --diag=[format:]{all | number,...}

See assembler option --diag in section 4.2, Assembler Options in Chapter
Tool Options of the Reference Guide.
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7.1 INTRODUCTION

The linker lkm16c is a combined linker/locator. The linker phase
combines relocatable object files (.obj files, generated by the assembler),
and libraries into a single relocatable linker object file (.eln). The locator
phase assigns absolute addresses to the linker object file and creates an
absolute object file which you can load into a target processor. From this
point the term linker is used for the combined linker/locator.

The linker takes the following files for input and output:

relocatable object files

linker

relocatable linker object file

lkm16c

.obj

.eln

linker map file .map

error messages .elk

relocatable object library.a

Motorola S-record

absolute object file

.s

Intel Hex

absolute object file

.hex

ELF/DWARF 2

absolute object file

.elf

linker script file .lsl

relocatable linker object file .eln

IEEE-695

absolute object file

.abs

memory definition

.mdffile

Figure 7-1: Linker

This chapter first describes the linking process. Then it describes how to
call the linker and how to use its options. An extensive list of all options
and their descriptions is included in section 4.3, Linker Options, of the
Reference Guide.

To gain even more control over the link process, you can write a script for
the linker. This chapter shortly describes the purpose and basic principles
of the Linker Script Language (LSL) on the basis of an example. A
complete description of the LSL is included in Chapter 7, Linker Script
Language, of the Reference Guide.

The end of the chapter describes how to generate a map file and contains
an overview of the different types of messages of the linker.
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7.2 LINKING PROCESS

The linker combines and transforms relocatable object files (.obj) into a
single absolute object file. This process consists of two phases: the linking
phase and the locating phase.

In the first phase the linker combines the supplied relocatable object files
and libraries into a single relocatable object file. In the second phase, the
linker assigns absolute addresses to the object file so it can actually be
loaded into a target.

Glossary of terms

Term Definition

Absolute object file Object code in which addresses have fixed absolute

values, ready to load into a target.

Address A specification of a location in an address space.

Address space The set of possible addresses. A core can support

multiple spaces, for example in a Harvard architecture

the addresses that identify the location of an instruction

refer to code space, whereas addresses that identify the

location of a data object refer to a data space.

Architecture A description of the characteristics of a core that are of

interest for the linker. This encompasses the logical

address space(s) and the internal bus structure. Given

this information the linker can convert logical addresses

into physical addresses.

Copy table A section created by the linker. This section contains

data that specifies how the startup code initializes the

data sections. For each section the copy table contains

the following fields:

- action: defines whether a section is copied or zeroed

- destination: defines the section's address in RAM

- source: defines the sections address in ROM

- length: defines the size of the section in MAUs

   of the destination space

Core An instance of a core architecture.

Derivative The design of a processor. A description of one or more

cores including internal memory and any number of

buses.

Library Collection of relocatable object files. Usually each

object file in a library contains one symbol definition

(for example, a function).
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DefinitionTerm

Logical address An address as encoded in an instruction word, an

address generated by a core (CPU).

LSL file The set of linker script files that are passed to the linker.

MAU Minimum Addressable Unit. For a given processor the

number of bits loaded between an address and the next

address. This is not necessarily a byte or a word.

Object code The binary machine language representation of the

C source.

Physical address An address generated by the memory system.

Processor An instance of a derivative. Usually implemented as a

(custom) chip, but can also be implemented in an

FPGA, in which case the derivative can be designed by

the developer.

Relocatable object

file

Object code in which addresses are represented by

symbols and thus relocatable.

Relocation The process of assigning absolute addresses.

Relocation

information

Information about how the linker must modify the

machine code instructions when it relocates addresses.

Section A group of instructions and/or data objects that occupy

a contiguous range of addresses.

Section attributes Attributes that define how the section should be linked

or located.

Target The hardware board on which an application is

executing. A board contains at least one processor.

However, a complex target may contain multiple

processors and external memory that may be shared

between processors.

Unresolved

reference

A reference to a symbol for which the linker did not find

a definition yet.

Table 7-1: Glossary of terms
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7.2.1 PHASE 1: LINKING

The linker takes one or more relocatable object files and/or libraries as
input. A relocatable object file, as generated by the assembler, contains the
following information:

• Header information: Overall information about the file, such as the
code size, name of the source file it was assembled from, and creation
date.

• Object code: Binary code and data, divided into various named
sections. Sections are contiguous chunks of code or data that have to
be placed in specific parts of the memory. The program addresses start
at zero for each section in the object file.

• Symbols: Some symbols are exported - defined within the file for use
in other files. Other symbols are imported - used in the file but not
defined (external symbols). Generally these symbols are names of
routines or names of data objects.

• Relocation information: A list of places with symbolic references that
the linker has to replace with actual addresses. When in the code an
external symbol (a symbol defined in another file or in a library) is
referenced, the assembler does not know the symbol's size and
address. Instead, the assembler generates a call to a preliminary
relocatable address (usually 0000), while stating the symbol name.

• Debug information: Other information about the object code that is
used by a debugger. The assembler optionally generates this
information and can consist of line numbers, C source code, local
symbols and descriptions of data structures.

The linker resolves the external references between the supplied
relocatable object files and/or libraries and combines the supplied
relocatable object files into a single relocatable linker object file.

The linker starts its task by scanning all specified relocatable object files
and libraries. If the linker encounters an unresolved symbol, it remembers
its name and continues scanning. The symbol may be defined elsewhere
in the same file, or in one of the other files or libraries that you specified
to the linker. If the symbol is defined in a library, the linker extracts the
object file with the symbol definition from the library. This way the linker
collects all definitions and references of all of the symbols.
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With this information, the linker combines the object code of all
relocatable object files. The linker combines sections with the same section
name and attributes into single sections, starting each section at address
zero. The linker also substitutes (external) symbol references by
(relocatable) numerical addresses where possible. At the end of the linking
phase, the linker either writes the results to a file (a single relocatable
object file) or keeps the results in memory for further processing during
the locating phase.

The resulting file of the linking phase is a single relocatable object file
(.eln). If this file contains unresolved references, you can link this file
with other relocatable object files (.obj) or libraries (.a) to resolve the
remaining unresolved references.

With the linker command line option --link-only, you can tell the linker
to only perform this linking phase and skip the locating phase. The linker
complains if any unresolved references are left.

7.2.2 PHASE 2: LOCATING

In the locating phase, the linker assigns absolute addresses to the object
code, placing each section in a specific part of the target memory. The
linker also replaces references to symbols by the actual address of those
symbols. The resulting file is an absolute object file which you can actually
load into a target memory. Optionally, when the resulting file should be
loaded into a ROM device the linker creates a so-called copy table section
which is used by the startup code to initialize the data sections.

Code modification

When the linker assigns absolute addresses to the object code, it needs to
modify this code according to certain rules or relocation expressions to
reflect the new addresses. These relocation expressions are stored in the
relocatable object file. Consider the following snippet of x86 code that
moves the contents of variable a to variable b via the eax register:

A1 3412 0000 mov a,%eax  (a defined at 0x1234, byte reversed)
A3 0000 0000 mov %eax,b  (b is imported so the instruction refers to
                          0x0000 since its location is unknown)

Now assume that the linker links this code so that the section in which a
is located is relocated by 0x10000 bytes, and b turns out to be at 0x9A12.
The linker modifies the code to be:
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A1 3412 0100 mov a,%eax  (0x10000 added to the address)
A3 129A 0000 mov %eax,b  (0x9A12 patched in for b)

These adjustments affect instructions, but keep in mind that any pointers
in the data part of a relocatable object file have to be modified as well.

Output formats

The linker can produce its output in different file formats. The default
ELF/DWARF2 format (.elf) contains an image of the executable code and
data, and can contain additional debug information. The Intel-Hex format
(.hex) and Motorola S-record format (.s) only contain an image of the
executable code and data. You can specify a format with the options -o

(--output) and -c (--chip-output).

Controlling the linker

Via a so-called linker script file you can gain complete control over the
linker. The script language used to describe these features is called the
Linker Script Language (LSL). You can define:

• The types of memory that are installed in the embedded target system:

To assign locations to code and data sections, the linker must know
what memory devices are actually installed in the embedded target
system. For each physical memory device the linker must know its
start-address, its size, and whether the memory is read-write accessible
(RAM) or read-only accessible (ROM).

• How and where code and data should be placed in the physical
memory:

Embedded systems can have complex memory systems. If for example
on-chip and off-chip memory devices are available, the code and data
located in internal memory is typically accessed faster and with
dissipating less power. To improve the performance of an application,
specific code and data sections should be located in on-chip memory.
By writing your own LSL file, you gain full control over the locating
process.

• The underlying hardware architecture of the target processor.
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To perform its task the linker must have a model of the underlying
hardware architecture of the processor you are using. For example the
linker must know how to translate an address used within the object
file (a logical address) into an offset in a particular memory device
(a physical address). In most linkers this model is hard coded in the
executable and can not be modified. For the lkm16c linker this
hardware model is described in the linker script file. This solution is
chosen to support  configurable cores that are used in system-on-chip
designs.

When you want to write your own linker script file, you can use the
standard linker script files with architecture descriptions delivered with the
product.

See also section 7.6, Controlling the Linker with a Script.

7.2.3 LINKER OPTIMIZATIONS

During the linking and locating phase, the linker looks for opportunities to
optimize the object code. Both code size and execution speed can be
optimized. To enable or disable optimizations:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Optimization.

You can enable or disable the optimizations described below. The
command line option for each optimization is given in brackets.

See also option -O (--optimize) in section 4.3, Linker Options, in Chapter
Tool Options of the Reference Guide.

First fit decreasing  (option -Ol/-OL)

When the physical memory is fragmented or when address spaces are
nested it may be possible that a given application cannot be located
although the size of the available physical memory is larger than the sum
of the section sizes. Enable the first-fit-decreasing optimization when this
occurs and re-link your application.
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The linker's default behavior is to place sections in the order that is
specified in the LSL file. This also applies to sections within an unrestricted
group. If a memory range is partially filled and a section must be located
that is larger than the remainder of this range, then the section and all
subsequent sections are placed in a next memory range. As a result of this
gaps occur at the end of a memory range.

When the first-fit-decreasing optimization is enabled the linker will first
place the largest sections in the smallest memory ranges that can contain
the section. Small sections are located last and can likely fit in the
remaining gaps.

Copy table compression  (option -Ot/-OT)

The startup code initializes the application's data areas. The information
about which memory addresses should be zeroed and which memory
ranges should be copied from ROM to RAM is stored in the copy table.

When this optimization is enabled the linker will try to locate sections in
such a way that the copy table is as small as possible thereby reducing the
application's ROM image.

This optimization reduces both memory and startup speed.

Compress ROM image  (option -Oz/-OZ)

Reduce the size of the application's ROM image by compressing the ROM
image of initialized data sections. At application startup time the ROM
image is decompressed and copied to RAM.

Delete unreferenced sections  (option -Oc/-OC)

This optimization removes unused sections from the resulting object file.
Because debug information normally refers to all sections, this
optimization has no effect until you compile your project without debug
information or use linker option --strip-debug to remove the debug
information.

Delete duplicate code sections  (option -Ox/-OX)

Delete duplicate data sections  (option -Oy/-OY)

These two optimizations remove code and constant data that is defined
more than once, from the resulting object file.
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7.3 CALLING THE LINKER

EDE uses a makefile to build your entire project. This means that you
cannot run only the linker. However, you can set options specific for the
linker. After you have build your project, the output files of the linking
step are available in your project directory, unless you specified an
alternative output directory in the Build Options dialog.

To link your program, click either one of the following buttons:

Builds your entire project but only updates files that are
out-of-date or have been changed since the previous build,
which saves time.

Builds your entire project unconditionally. All steps necessary
to obtain the final .elf file are performed.

To get access to the linker options:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry. Select the subentries and set the options in
the various pages.

The command line variant is shown simultaneously.
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The following linker options are available:

EDE options Command line

Output Format

Output formats -o[filename][:format
[:addr_size][,space]]

-c[basename]:format
[:addr_size]

Libraries

Link default C libraries -lx

Rescan libraries to solve unresolved exernals --no-rescan

Link case sensitive (required for C language) no option
--case-insensitive

Optimization

Use a 'first fit decreasing' algorithm

Use copy table compression

Compress ROM image

Delete unreferenced sections

Delete duplicate code

Delete duplicate constant data

-Ol/-OL      (= on/off)

-Ot/-OT
-Oz/-OZ
-Oc/-OC
-Ox/-OX
-Oy/-OY

Map File

Generate a map file (.map) -M

Suboptions for the Generate a map file option -mflags

Warnings

Report all warnings

Suppress all warnings

Suppress specific warnings

no option -w
-w
-wnum[,num]...

Treat warnings as errors --warnings-as-errors

Miscellaneous

Use standard copy-table for initialization no option -i

Strip symbolic debug information -S

Dump processor and memory info from LSL file --lsl-dump[=file]

Select linker script file -dfile,...

Additional linker options options

Table 7-2: Linker options
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The following options are only available on the command line:

Description Command line

Display invocation syntax -?

Define preprocessor macro -Dmacro[=def]

Show description of diagnostic(s) --diag=[fmt:]{all|nr,...}

Specify a symbol as unresolved external -esymbol

Redirect errors to a file with extension .elk --error-file[=file]

Read options from file -f file

Scan libraries in given order --first-library-first

Search only in -L directories, not in default path --ignore-default-
library-path

Keep output files after errors -k

Link only, do not locate --link-only

Check LSL file(s) and exit --lsl-check

Do not generate ROM copy -N

Locate all ROM sections in RAM --non-romable

Link incrementally -r

Display version header only -V

Print the name of each file as it is processed -v

Table 7-3: Linker command line options

The invocation syntax on the command line is:

lkm16c [option]... [file]... ]...

When you are linking multiple files (either relocatable object files (.obj)
or libraries (.a), it is important to specify the files in the right order. This
is explained in Section 7.4.1, Specifying Libraries to the Linker

Example:

lkm16c -otest.elf -dm16c.lsl test.obj

This links and locates the file test.obj and generates the file test.elf.

For a complete overview of all options with extensive description, see
section 4.3, Linker Options, of the Reference Guide.
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7.4 LINKING WITH LIBRARIES

There are two kinds of libraries: system libraries and user libraries.

System library

The lib directory of the toolchain contains subdirectories with separate
system libraries for the M16C and the R8C. An overview of the system
libraries is given in the following tables.

Library to link Description

libcs.a

libcm.a

libcl.a

C library for small, medium or large memory model

(Some functions require the floating-point library. Also

includes the startup code.)

libcss.a

libcms.a

libcls.a

Single precision C library for small, medium or large memory

model (compiler option -F)

(Some functions require the floating-point library. Also

includes the startup code.)

libfps.a

libfpm.a

libfpl.a

Floating-point library (non-trapping) for each model

libfpst.a

libfpmt.a

libfplt.a

Floating-point library (trapping) for each model

(Control program option --fp-trap)

librts.a

librtm.a

librtl.a

Run-time library for each model

Table 7-4: Overview of M16C libraries

Library to link Description

libc.a C library

(Some functions require the floating-point library. Also

includes the startup code.)

libcs.a Single precision C library (compiler option -F)

(Some functions require the floating-point library. Also

includes the startup code.)

libfp.a Floating-point library (non-trapping)

libfpt.a Floating-point library (trapping)

(Control program option --fp-trap)

librt.a Run-time library

Table 7-5: Overview of R8C libraries
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For more information on these libraries see section 3.14, Libraries, in
Chapter C Language.

User library

You can also create your own libraries. Section 8.4, Archiver, in Chapter
Using the Utilities, describes how you can use the archiver to create your
own library with object modules. To link user libraries, specify their
filenames on the command line.

7.4.1 SPECIFYING LIBRARIES TO THE LINKER

In EDE you can specify both system and user libraries.

Link a system library with EDE

To specify to link the default C libraries:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Libraries.

3. Select Link default C libraries.

4. Click OK to accept the linker options.

When you want to link system libraries from the command line, you must
specify this with the linker option -l. With the option -lcl you specify the
system library libcl.a. For example:

lkm16c -lcl start.obj

Link a user library in EDE

To specify your own libraries, you have to add the library files to your
project:

1. From the Project menu, select Properties...

The Project Properties dialog box appears.

2. In the Members tab, click on the Add existing files to project

button.
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3. Select the libraries you want to add and click Open.

4. Click OK to accept the new project settings.

The invocation syntax on the command line is for example:

lkm16c start.obj mylib.a

If the library resides in a subdirectory, specify that directory with the
library name:

lkm16c start.obj mylibs\mylib.a

Library order

The order in which libraries appear on the command line is important. By
default the linker processes object files and libraries in the order in which
they appear on the command line. Therefore, when you use a weak
symbol construction, like printf, in an object file or your own library,
you must position this object/library before the C library.

With the option --first-library-first you can tell the linker to scan the
libraries from left to right, and extract symbols from the first library where
the linker finds it. This can be useful when you want to use newer
versions of a library routine.

Example:

lkm16c --first-library-first a.a test.obj b.a

If the file test.obj calls a function which is both present in a.a and
b.a, normally the function in b.a would be extracted. With this option
the linker first tries to extract the symbol from the first library a.a.

7.4.2 HOW THE LINKER SEARCHES LIBRARIES

System libraries

You can specify the location of system libraries (specified with option -l)
in several ways. The linker searches the specified locations in the
following order:

1. The linker first looks in the directories that are specified in the
Directories dialog (-L option). If you specify the -L option without a
pathname, the linker stops searching after this step.
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2. When the linker did not find the library (because it is not in the specified
library directory or because no directory is specified), it looks which paths
were set during installation. You can still change these paths if you like.

See environment variables LIBM16C in section 1.3.2, Configuring the
Command Line Environment, in Chapter Software Installation.

3. When the linker did not find the library, it tries the default lib directory
relative to the installation directory.

User library

If you use your own library, the linker searches the library in the current
directory only.

7.4.3 HOW THE LINKER EXTRACTS OBJECTS FROM

LIBRARIES

A library built with arm16c always contains an index part at the beginning
of the library. The linker scans this index while searching for unresolved
externals. However, to keep the index as small as possible, only the
defined symbols of the library members are recorded in this area.

When the linker finds a symbol that matches an unresolved external, the
corresponding object file is extracted from the library and is processed.
After processing the object file, the remaining library index is searched. If
after a complete search of the library unresolved externals are introduced,
the library index will be scanned again. After all files and libraries are
processed, and there are still unresolved externals and you did not specify
the linker option --no-rescan, all libraries are rescanned again. This way
you do not have to worry about the library order. However, this
rescanning does not work for 'weak symbols'. If you use a weak symbol
construction, like printf, in an object file or your own library, you must
position this object/library before the C library

The -v option shows how libraries have been searched and which objects
have been extracted.
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Resolving symbols

If you are linking from libraries, only the objects that contain symbol
definition(s) to which you refer, are extracted from the library. This implies
that if you invoke the linker like:

lkm16c mylib.a

nothing is linked and no output file will be produced, because there are
no unresolved symbols when the linker searches through mylib.a.

It is possible to force a symbol as external (unresolved symbol) with the
option -e:

lkm16c -e main mylib.a

In this case the linker searches for the symbol main in the library and (if
found) extracts the object that contains main. If this module contains new
unresolved symbols, the linker looks again in mylib.a. This process
repeats until no new unresolved symbols are found.

7.5 INCREMENTAL LINKING

With the M16C linker lkm16c it is possible to link incrementally.
Incremental linking means that you link some, but not all .obj modules
to a relocatable object file .eln. In this case the linker does not perform
the locating phase. With the second invocation, you specify both new
.obj files and the .eln file you had created with the first invocation.

Incremental linking is only possible on the command line.

lkm16c -r test1.obj -otest.eln

lkm16c test2.obj test.eln

This links the file test1.obj and generates the file test.eln. This file is
used again and linked together with test2.obj to create the file
task1.elf (the default name if no output filename is given in the default
ELF/DWARF 2 format).

With incremental linking it is normal to have unresolved references in the
output file until all .obj files are linked and the final .eln or .elf file
has been reached. The option -r for incremental linking also suppresses
warnings and errors because of unresolved symbols.
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7.6 CONTROLLING THE LINKER WITH A SCRIPT

With the options on the command line you can control the linker's
behavior to a certain degree. From EDE it is also possible to determine
where your sections will be located, how much memory is available,
which sorts of memory are available, and so on. EDE passes these locating
directions to the linker via a script file. If you want even more control over
the locating process you can supply your own script.

The language for the script is called the Linker Script Language, or shortly
LSL. You can specify the script file to the linker, which reads it and locates
your application exactly as defined in the script. If you do not specify your
own script file, the linker always reads a standard script file which is
supplied with the toolchain.

7.6.1 PURPOSE OF THE LINKER SCRIPT LANGUAGE

The Linker Script Language (LSL) serves three purposes:

1. It provides the linker with a definition of the target's core architecture.
This definition is supplied with the toolchain.

2. It provides the linker with a specification of the memory attached to
the target processor.

3. It provides the linker with information on how your application should
be located in memory. This gives you, for example, the possibility to
create overlaying sections.

The linker accepts multiple LSL files. You can use the specifications of the
M16C and R8C architectures that Altium has supplied in the include.lsl
directory. Do not change these files.

If you use a different memory layout than described in the LSL file
supplied for the target core, you must specify this in a separate LSL file
and pass both the LSL file that describes the core architecture and your LSL
file that contains the memory specification to the linker. Next you may
want to specify how sections should be located and overlaid. You can do
this in the same file or in another LSL file.

LSL has its own syntax. In addition, you can use the standard ANSI C
preprocessor keywords because the linker sends the script file first to the
C preprocessor before it starts interpreting the script.
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The complete syntax is described in Chapter 7, Linker Script Language, in
the Reference Guide.

7.6.2 EDE AND LSL

In EDE you can specify the size of the stack and heap; the physical
memory attached to the processor; identify that particular address ranges
are reserved; and specify which sections are located where in memory.
EDE translates your input into an LSL file that is stored in the project
directory under the name project.lsl and passes this file to the linker.

If you want to learn more about LSL you can inspect the generated file
project.lsl.

To change the LSL settings

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Processor entry and select Memory.

3. Make your changes.

4. Also make your changes, if necessary, in the pages Sections,
Reserved Areas and/or Stack/Heap in the Linker entry.

Each time you close the Project Options dialog the file project.lsl is
updated and you can immediately see how your settings are encoded in
LSL.

Note that EDE supports ChromaCoding (applying color coding to text) and
template expansion when you edit LSL files.

Specify your own LSL file

If you want to write your own linker script file, you can use the EDE
generated file project.lsl as an example. Specify this file to EDE as
follows:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Miscellaneous.
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3. Select Use project specific linker script file and add your own file in
the edit field.

7.6.3 STRUCTURE OF A LINKER SCRIPT FILE

A script file consists of several definitions. The definitions can appear in
any order.

The architecture definition (required)

In essence an architecture definition describes how the linker should
convert logical addresses into physical addresses for a given type of core.
If the core supports multiple address spaces, then for each space the linker
must know how to perform this conversion. In this context a physical
address is an offset on a given internal or external bus. Additionally the
architecture definition contains information about items such as the
(hardware) stack and the interrupt vector table.

This specification is normally written by Altium. For the M16C core
architecture, a separate LSL file is provided m16c.lsl. For the R8C core
architecture, a separate LSL file is provided r8c.lsl.

The architecture definition of the LSL file should not be changed by you
unless you also modify the core's hardware architecture. If the LSL file
describes a multi-core system an architecture definition must be available
for each different type of core.

The derivative definition (required)

The derivative definition describes the configuration of the internal
(on-chip) bus and memory system. Basically it tells the linker how to
convert offsets on the buses specified in the architecture definition into
offsets in internal memory. A derivative definition must be present in an
LSL file. Microcontrollers and DSPs often have internal memory and I/O
sub-systems apart from one or more cores. The design of such a chip is
called a derivative.

When you design an FPGA together with a PCB, the components on the
FPGA become part of the board design and there is no need to distinguish
between internal and external memory. For this reason you probably do
not need to work with derivative definitions at all. There are, however,
two situations where derivative definitions are useful:
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1. When you re-use an FPGA design for several board designs it may be
practical to write a derivative definition for the FPGA design and
include it in the project LSL file.

2. When you want to use multiple cores of the same type, you must
instantiate the cores in a derivative definition, since the linker
automatically instantiates only a single core for an unused architecture.

The processor definition

The processor definition describes an instance of a derivative. A processor
definition is only needed in a multi-processor embedded system. It allows
you to define multiple processors of the same type.

If for a derivative 'A' no processor is defined in the LSL file, the linker
automatically creates a processor named 'A' of derivative 'A'. This is why
for single-processor applications it is enough to specify the derivative in
the LSL file, for example with -dm16c.lsl.

The memory and bus definitions (optional)

Memory and bus definitions are used within the context of a derivative
definition to specify internal memory and on-chip buses. In the context of
a board specification the memory and bus definitions are used to define
external (off-chip) memory and buses. Given the above definitions the
linker can convert a logical address into an offset into an on-chip or
off-chip memory device.

The board specification

The processor definition and memory and bus definitions together form a
board specification. LSL provides language constructs to easily describe
single-core and heterogeneous or homogeneous multi-core systems. The
board specification describes all characteristics of your target board's
system buses, memory devices, I/O sub-systems, and cores that are of
interest to the linker. Based on the information provided in the board
specification the linker can for each core:

• convert a logical address to an offset within a memory device

• locate sections in physical memory

• maintain an overall view of the used and free physical memory within
the whole system while locating
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The section layout definition (optional)

The optional section layout definition enables you to exactly control
where input sections are located. Features are provided such as: the ability
to place sections at a given address, to place sections in a given order, and
to overlay code and/or data sections.

Example: Skeleton of a Linker Script File

A linker script file that defines a derivative "X'" based on the M16C
architecture, its external memory and how sections are located in memory,
may have the following skeleton:

architecture M16C

{

    // Specification of the M16C core architecture.

    // Written by Altium.

}

derivative X           // derivative name is arbitrary

{

    // Specification of the derivative.

    // Written by Altium.

    core M16C            // always specify the core

    {

       architecture = M16C;

    }

    bus data_bus       // internal bus

    {

       // maps to data_bus in "M16C" core

    }

    // internal memory

}

processor proc1        // processor name is arbitrary

{

    derivative = X;

    // You can omit this part, except if you use a

    // multi-core system.

}
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memory ext_name

{

    // external memory definition

}

section_layout proc1:M16C:near    // section layout

{

    // section placement statements

    // sections are located in address space 'near'

    // of core 'M16C' of processor 'proc1'

}

7.6.4 THE ARCHITECTURE DEFINITION

Although you will probably not need to program the architecture
definition (unless you are building your own processor core) it helps to
understand the Linker Script Language and how the definitions are
interrelated.

Within an architecture definition the characteristics of a target processor
core that are important for the linking process are defined. These include:

• space definitions: the logical address spaces and their properties

• bus definitions: the I/O buses of the core architecture

• mappings: the address translations between logical address spaces, the
connections between logical address spaces and buses and the address
translations between buses

Address spaces

A logical address space is a memory range for which the core has a
separate way to encode an address into instructions. Most microcontrollers
and DSPs support multiple address spaces. For example, the M16C has
separate spaces for byte-addressable data and bit-addressable data.
Normally, the size of an address space is to 2N, with N the number of bits
used to encode the addresses.

The relation of an address space with another address space can be one of
the following:

• one space is a subset of the other. These are often used for "small"
absolute, and relative addressing.
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• the addresses in the two address spaces represent different locations so
they do not overlap. This means the core must have separate sets of
address lines for the address spaces. For example, in Harvard
architectures we can identify at least a code and a data memory space.

Address spaces (even nested) can have different minimal addressable units
(MAU), alignment restrictions, and page sizes.

The M16C architecture in LSL notation

The best way to program the architecture definition, is to start with a
drawing. The following figure shows a part of the M16C architecture:

0

1M

64k

space far

space near

bus data_bus

id = 1

mau = 8

id = 2

mau = 8

mau = 8

width=8

Figure 7-2: Scheme of (part of) the M16C architecture

The figure shows two address spaces called near, and far. The address
space near is a subset of the address space far. All address spaces have
attributes like a number that identifies the logical space (id), a MAU size
and an alignment. In LSL notation the definition of these address spaces
looks as follows:

space near

{

     id = 1;

     mau = 8;

     map (src_offset=0x00000, dest_offset=0x00000,

          size=64k, dest=space:far);

}

space far

{

     id = 2;

     mau = 8;

     map (src_offset=0x00000, dest_offset=0x00000,

          size=1M, dest=bus:data_bus);

}
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The keyword map corresponds with the arrows in the drawing. You can
map:

• address space => address space

• address space => bus

• memory => bus (not shown in the drawing)

• bus => bus (not shown in the drawing)

Next the internal bus, named data_bus must be defined in LSL:

bus data_bus

{

     mau = 8;

     width = 8;  // there are 8 data lines on the bus

}

This completes the LSL code in the architecture definition. Note that all
code above goes into the architecture definition, thus between:

architecture M16C

{

    All code above goes here.

}

7.6.5 THE DERIVATIVE DEFINITION

Although you will probably not need to program the derivative definition
(unless you are using multiple cores) the description below helps to
understand the Linker Script Language and how the definitions are
interrelated.

A derivative is the design of a processor, as implemented on a chip (or
FPGA). It comprises one or more cores and on-chip memory. The
derivative definition includes:

• core definition: an instance of a core architecture

• bus definition: the I/O buses of the core architecture

• memory definitions: internal (or on-chip) memory
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Core

Each derivative must have at least one core and each core must have a
specification of its core architecture. This core architecture must be defined
somewhere in the LSL file(s).

core M16C

{

   architecture = M16C;

}

Bus

Each derivative can contain a bus definition for connecting external
memory. In this example, the bus data_bus maps to the bus data_bus
defined in the architecture definition of core M16C:

bus data_bus

{

   mau = 8;

   width = 8;

   map (dest=bus:M16C:data_bus, dest_offset=0, size=256);

}

Memory

Memory is usually described in a separate memory definition, but you can
specify on-chip memory for a derivative. For example:

memory internal_ram

{

     type = ram;

     size = 16k;

     mau = 8;

     map(src_offset=0x0000, dest_offset=0x0000,

         size=16k, dest=bus:M16C:data_bus);

}

This completes the LSL code in the derivative definition. Note that all code
above goes into the derivative definition, thus between:

derivative X    // name of derivative

{

    All code above goes here.

}
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If you want to create a custom derivative and you want to use EDE to
select sections, the derivative must be called "M16C", since EDE uses this
name in the generated LSL file. If you want to specify external memory in
EDE, the custom derivative must contain a bus named "data_bus" for the
same reason. In EDE you have to define a target processor in the
Processor pages of the Project | Project Options dialog.

7.6.6 THE MEMORY DEFINITION

Once the core architecture is defined in LSL, you may want to extend the
processor with memory. You need to specify the location and size of the
physical external memory devices in the target system.

The principle is the same as defining the core's architecture but now you
need to fill the memory definition:

memory name

{

    memory definitions.

}

0

1M

8k

space far

space near

bus data_bus

id = 1

mau = 8

id = 2

mau = 8

mau = 8

width=8
16k

0

memory iram

mau = 8

256k

memory irom

0

mau = 8

1k

0
mau = 8

memory my_nvram

Figure 7-3: Adding external memory to the M16C architecture

Suppose your embedded system has 16k of RAM, named iram., 1k of
non-volatile RAM called my_nvram and 256k of ROM, named irom (see
figure above). The memories are connected to the bus data_bus. In LSL
this looks like:
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memory iram

{

     type = ram;

     size = 16k;

     mau = 8;

     map(src_offset=0x0000, dest_offset=0x0400,

         size=16k, dest=bus:M16C:data_bus);

}

The memory my_nvram is connected to the bus with an offset of 0x5000:

memory my_nvram

{

     type = ram;

     size = 1k;

     mau = 8;

     map(src_offset=0x0000, dest_offset=0x5000,

         size=1k, dest=bus:M16C:data_bus);

}

The memory irom is connected to the bus with an offset of 0xC0000:

memory irom

{

     type = rom;

     size = 256k;

     mau = 8;

     map(src_offset=0x0000, dest_offset=0xc0000,

         size=256k, dest=bus:M16C:data_bus);

}

If you use a different memory layout than described in the LSL file
supplied for the target core, you can specify this in EDE or you can specify
this in a separate LSL file and pass both the LSL file that describes the core
architecture and your LSL file that contains the memory specification to the
linker.

In order to bypass the default memory setup, your memory LSL file must
contain a #define __NODEFAULTMEM, and you must specify this file
before the core architecture LSL file.

Adding memory using EDE

In EDE you can only specify external memory if the processor does not
run in single chip mode.

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Processor entry and select Processor Definition.
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3. Select Memory Expansion mode or Microprocessor mode or select
-- User Defined -- in the Select processor box for a user defined
processor.

4. Open the Memory page.

5. In the External Memory box add your memory (for example
my_nvram), by specifying the type, name, start address and size.

7.6.7 THE SECTION LAYOUT DEFINITION: LOCATING

SECTIONS

Once you have defined the internal core architecture and optional
memory, you can actually define where your application must be located
in the physical memory.

During compilation, the compiler divides the application into sections.
Sections have a name, an indication in which address space it should be
located and attributes like writable or read-only.

In the section layout definition you can exactly define how input sections
are placed in address spaces, relative to each other, and what their
absolute run-time and load-time addresses will be. To illustrate section
placement the following example of a C program is used:

Example: section propagation through the toolchain

To illustrate section placement, the following example of a C program
(bat.c) is used. The program saves the number of times it has been
executed in battery back-upped memory, and prints the number.

#define BATTERY_BACKUP_TAG  0xa5f0

#include <stdio.h>

int  uninitialized_data;

int  initialized_data = 1;

#pragma renamesect DA "non_volatile" noclear

int  battery_backup_tag;

int  battery_backup_invok;

#pragma endrenamesect DA
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void main (void)

{

     if (battery_backup_tag != BATTERY_BACKUP_TAG )

     {

         // battery back-upped memory area contains invalid data

         // initialize the memory

         battery_backup_tag = BATTERY_BACKUP_TAG;

         battery_backup_invok = 0;

     }

     printf( "This application has been invoked %d times\n",

              battery_backup_invok++);

}

The compiler assigns names and attributes to sections. With the #pragma
renamesect DA "name" the compiler's default section naming
convention is overruled and a section with the name
non_volatile_CLR_DA is defined. In this section the battery
back-upped data is stored.

By default the compiler creates the section bat_CLR_DA, data, clear
(a section with the name bat_CLR_DA carrying section attributes "data"
and "clear") to store uninitialized data objects. The section attributes tell
the linker to locate the section in address space data and that the section
content should be filled with zeros at startup.

As a result of the #pragma renamesect DA "non_volatile"
noclear, the data objects between the pragma pair are placed in
non_volatile_CLR_DA, data, noclear. Note that because battery
back-upped sections should not be cleared we used the "noclear"
attribute.

The generated assembly may look like:

        extern  (code)_printf

        extern  (code)___printf_int

        extern  (code)__START

        defsect "bat_CO", code

        sect    "bat_CO"

        global  _main
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; Function _main

_main:  type    func

        cmp.w   #42480, _battery_backup_tag

        jeq     _2

        .

        .

        jsr     _printf

        rts

        size    _main, $-_main

        ; End of function

        ; End of section

        defsect "bat_CLR_DA", data, clear

        sect    "bat_CLR_DA"

        global  _uninitialized_data

_uninitialized_data:    type    object

        size    _uninitialized_data, 2

        ds      2

        ; End of section

        defsect "bat_INI_DA", data, init

        sect    "bat_INI_DA"

        global  _initialized_data

_initialized_data:  type    object

        size    _initialized_data, 2

        dw      1

        ; End of section

        defsect "non_volatile_CLR_DA", data, noclear

        sect    "non_volatile_CLR_DA"

        global  _battery_backup_tag

_battery_backup_tag:  type    object

        size    _battery_backup_tag, 2

        ds      2

        global  _battery_backup_invok

_battery_backup_invok:  type    object

        size    _battery_backup_invok, 2

        ds      2

        ; End of section

        sect    "bat_INI_DA"

__1_ini:        type    object

        size    __1_ini, 44

        db      84,  104, 105, 115, 32,  97,  112, 112, 108, 105

        db      99,  97,  116, 105, 111, 110, 32,  104, 97,  115

        db      32,  98,  101, 101, 110, 32,  105, 110, 118, 111

        db      107, 101, 100, 32,  37,  100, 32,  116, 105, 109

        db      101, 115, 10,  0

        ; This application has been invoked %d times\n

        ; Module end
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Section placement

The number of invocations of the example program should be saved in
non-volatile (battery back-upped) memory. This is the memory my_nvram
from the example in the previous section.

To control the locating of sections, you need to write one or more section
definitions in the LSL file. At least one for each address space where you
want to change the default behavior of the linker. In our example, we
need to locate sections in the address space near:

section_layout ::near

{

    Section placement statements

}

To locate sections, you must create a group in which you select sections
from your program. For the battery back-up example, we need to define
one group, which contains the section non_volatile_CLR_DA. All other
sections are located using the defaults specified in the architecture
definition. Section non_volatile_CLR_DA should be placed in
non-volatile ram. To achieve this, the run address refers to our
non-volatile memory called my_nvram:

group ( ordered, run_addr = mem:my_nvram )

{

     select "non_volatile_CLR_DA";

}

Section placement from EDE

To specify the above settings using EDE, follow these steps:

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Sections.

Here you can specify where sections are located in memory.

3. In the Section type field, select Near Data.

4. In the Section name field, enter non_volatile_CLR_DA.

5. In the Absolute address field, enter mem:my_nvram

6. In the Section attr field, select Code/Data part.
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7. Click OK.

This completes the LSL file for the sample architecture and sample
program. You can now call the linker with this file and the sample
program to obtain an application that works for this architecture.

For a complete description of the Linker Script Language, refer to Chapter
7, Linker Script Language, in the Reference Guide.

7.6.8 THE PROCESSOR DEFINITION: USING

MULTI-PROCESSOR SYSTEMS

The processor definition is only needed when you write an LSL file for a
multi-processor embedded system. The processor definition explicitly
instantiates a derivative, allowing multiple processors of the same type.

processor proc_name

{

   derivative = deriv_name

}

If no processor definition is available that instantiates a derivative, a
processor is created with the same name as the derivative.
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7.7 LINKER LABELS

The linker creates labels that you can use to refer to from within the
application software. Some of these labels are real labels at the beginning
or the end of a section. Other labels have a second function, these labels
are used to address generated data in the locating phase. The data is only
generated if the label is used.

Linker labels are labels starting with __lc_. The linker assigns addresses to
the following labels when they are referenced:

Label Description

__lc_cp Start of copy table. Same as __lc_ub_table. The copy

table gives the source and destination addresses of

sections to be copied. This table will be generated by the

linker only if this label is used.

__lc_bh Begin of heap. Same as __lc_ub_heap.

__lc_eh End of heap. Same as __lc_ue_heap.

__lc_bs Begin of stack. Same as __lc_ub_sp.

__lc_es End of stack. Same as __lc_ue_sp.

__lc_u_name User defined label. The label must be defined in the LSL

file. For example,

 "__lc_u_int_tab" = (INTTAB);

__lc_ub_name

__lc_b_name

Begin of section name. Also used to mark the begin of the

stack or heap or copy table.

__lc_ue_name

__lc_e_name

End of section name. Also used to mark the begin of the

stack or heap.

__lc_cb_name Start address of an overlay section in ROM.

__lc_ce_name End address of an overlay section in ROM.

__lc_gb_name Begin of group name. This label appears in the output file

even if no reference to the label exist in the input file.

__lc_ge_name End of group name. This label appears in the output file

even if no reference to the label exist in the input file.

Table 7-6: Linker labels

The linker only allocates space for the stack and/or heap when a reference
to either of the section labels exists in one of the input object files.
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At C level, all linker labels start with one leading underscore (the compiler
adds an extra underscore).

Example

Suppose in an LSL file you have defined a user stack section with the
name "ustack" (with the keyword stack). You can refer to the begin
and end of the stack from your C source as follows (labels have one
leading underscore):

#include <stdio.h>

extern char *_lc_ub_ustack;

extern char *_lc_ue_ustack;

void main()

{

  printf( "Size of user stack is %d\n", 

          _lc_ue_ustack - _lc_ub_ustack );

}

From assembly you can refer to the end of the user stack with:

extern __lc_ue_ustack   ; user stack end
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7.8 GENERATING A MAP FILE

The map file is an additional output file that contains information about
the location of sections and symbols. You can customize the type of
information that should be included in the map file.

To generate a map file

1. From the Project menu, select Project Options...

The Project Options dialog box appears.

2. Expand the Linker entry and select Map File.

3. Select Generate a linker map file (.map)

4. (Optional) Enable the options to include that information in the map
file.

Example on the command line

lkm16c -Mtest.map test.obj

With this command the list file test.map is created.

See section 5.2,  Linker Map File Format, in Chapter List File Formats of the
Reference Guide for an explanation of the format of the map file.
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7.9 LINKER ERROR MESSAGES

The linker produces error messages of the following types:

F Fatal errors

After a fatal error the linker immediately aborts the link/locate process.

E Errors

Errors are reported, but the linker continues linking and locating. No
output files are produced unless you have set the linker option
--keep-output-files.

W Warnings

Warning messages do not result into an erroneous output file. They are
meant to draw your attention to assumptions of the linker for a situation
which may not be correct. You can control warnings in the Linker |

Diagnostics page of the Project | Project Options... menu (linker
option -w).

I Information

Verbose information messages do not indicate an error but tell something
about a process or the state of the linker. To see verbose information, use
the linker option -v.

S System errors

System errors occur when internal consistency checks fail and should
never occur. When you still receive the system error message

S6##: message

please report the error number and as many details as possible about the
context in which the error occurred. The following helps you to prepare
an e-mail using EDE:

1. From the Help menu, select Technical Support -> Prepare Email...

The Prepare Email form appears.

2. Fill out the the form. State the error number and attach relevant files.

3. Click the Copy to Email client button to open your email application.

A prepared e-mail opens in your e-mail application.



Using the Linker 7-39

• • • • • • • •

4. Finish the e-mail and send it.

Display detailed information on diagnostics

1. In the Help menu, enable the option Show Help on Tool Errors.

2. In the Build tab of the Output window, double-click on an error or
warning message.

A description of the selected message appears.

lkm16c --diag=[format:]{all | number,...}

See linker option --diag in section 4.3, Linker Options in Chapter Tool
Options of the Reference Guide.
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8.1 INTRODUCTION

The TASKING toolchain for the M16C processor family comes with a
number of utilities that provide useful extra features.

ccm16c A control program for the M16C toolchain. The control
program invokes all tools in the toolchain and lets you
quickly generate an absolute object file from C source input
files.

mkm16c A utility program to maintain, update, and reconstruct groups
of programs. The make utility looks whether files are out of
date, rebuilds them and determines which other files as a
consequence also need to be rebuild.

arm16c An ELF archiver. With this utility you create and maintain
object library files.

flashm16c A utility to flash an ELF, IEEE-695, Intel Hex or Motorola
S-Records file.
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8.2 CONTROL PROGRAM

The control program ccm16c is a tool that invokes all tools in the
toolchain for you. It provides a quick and easy way to generate the final
absolute object file out of your C sources without the need to invoke the
compiler, assembler and linker manually.

8.2.1 CALLING THE CONTROL PROGRAM

You can only call the control program from the command line. The
invocation syntax is

ccm16c [ [option]... [file]... ]...

For example:

ccm16c -v test.c

The control program calls all tools in the toolchain and generates the
absolute object file test.elf. With the control program option -v you
can see how the control program calls the tools:

+ c:\cm16c\bin\cm16c -Ms -o test.src test.c

+ c:\cm16c\bin\asm16c -o test.obj test.src

+ c:\cm16c\bin\lkm16c test.obj -o test.elf --map-file

-lcs -lfps -lrts

By default, the control program removes the intermediate output files
(test.src and test.obj in the example above) afterwards, unless you
specify the command line option -t (--keep-temporary-files).

Recognized input files

The control program recognizes the following input files:

• Files with a .cc, .cxx or .cpp suffix are interpreted as C++ source
programs and are passed to the C++ compiler.

• Files with a .c suffix are interpreted as C source programs and are
passed to the compiler.

• Files with a .asm suffix are interpreted as hand-written assembly
source files which have to be passed to the assembler.

• Files with a .src suffix are interpreted as compiled assembly source
files. They are directly passed to the assembler.
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• Files with a .a suffix are interpreted as library files and are passed to
the linker.

• Files with a .obj suffix are interpreted as object files and are passed to
the linker.

• Files with a .eln suffix are interpreted as linked object files and are
passed to the locating phase of the linker. The linker accepts only one
.eln file in the invocation.

• An argument with a .lsl suffix is interpreted as a linker script file and
is passed to the linker.

Options of the control program

The following control program options are available:

Description Option

Information

Display invocation options -?

Display version header -V

Check the source but do not generate code --check

Show description of diagnostics --diag=[fmt:]{all|nr}

Verbose option: show commands invoked

Verbose option: show commands without executing

-v
-n

Suppress all warnings -w

Treat warnings as errors --warnings-as-
errors

Show C and assembly warnings for C++

compilations

--show-c++-
warnings

C Language

ISO C standard 90 or 99 (default: 99) --iso={90|99}

Language extensions

Allow C++ style comments in C source

Check assignment constant string to 

non constant string pointer

-Aflag
-Ap
-Ax

Treat external definitions as "static" --static

Single precision floating point -F

C++ Language

Treat  C++ files as C files --force-c

Force C++ compilation and linking --force-c++
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OptionDescription

Force invocation of C++ muncher --force-munch

Force invocation of C++ prelinker --force-prelink

Show the list of object files handled by the C++

prelinker

--list-object-files

Copy C++ prelink (.ii) files from outside the current

directory

--prelink-copy-
if-nonlocal

Use only C++ prelink files in the current directory --prelink-local-only

Remove C++ instantiation flags after prelinking --prelink-remove-
instantiation-flags

Enable C++ exception handling --exceptions

C++ instantiation mode --instantiate=type

C++ instantiation directory --instantiation-dir=
dir

C++ instantiation file --instantiation-file=
file

Disable automatic C++ instantiation --no-auto-
instantiation

Allow multiple instantiations in a single object file --no-one-instantiat
ion-per-object

Preprocessing

Define preprocessor macro -Dmacro[=def]

Remove preprocessor macro -Umacro

Store the C compiler preprocess output (file.pre) -Eflag

Memory models

Select memory model -M{s|m|l}

Code generation

Select CPU type -Ccpu

Generate symbolic debug information -g

Target R8C instead of M16C/60 --r8c

Libraries

Add library directory -Ldir

Add library -llib

Ignore the default search path for libraries --ignore-default-
library-path
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OptionDescription

Do not include default list of libraries --no-default-
libraries

Use trapped floating-point library --fp-trap

Input files

Specify linker script file -d file

Read options from file -f file

Add include directory -Idir

Output files

Redirect diagnostic messages to a file --error-file

Select final output file:

 relocatable output file

 object file(s)

 assembly file(s)

-cl
-co
-cs

Specify linker output format (ELF, IEEE) --format=type

Set the address size for linker IHEX/SREC files --address-size=n

Set linker output space name --space=name

Keep output file(s) after errors -k

Do not generate linker map file --no-map-file

Specify name of output file -o file

Do not delete intermediate (temporary) files -t

Table 8-1: Overview of control program options

For a complete list and description of all control program options, see
section 4.4, Control Program Options, in Chapter Tool Options of the
Reference Guide.

The options in table 8-1 are options that the control program interprets
itself. The control program however can also pass an option directly to a
tool. Such an option is not interpreted by the control program but by the
tool itself. The next example illustrates how an option is passed directly to
the linker to link a user defined library:

ccm16c -Wl-lmylib test.c

Use the following options to pass arguments to the various tools:



User's Guide8-8
U
T
IL
IT
IE
S

Description Option

Pass argument directly to the C++ compiler

Pass argument directly to the C++ pre-linker

Pass argument directly to the C compiler

Pass argument directly to the assembler

Pass argument directly to the linker

-Wcparg
-Wplarg
-Wcarg
-Waarg
-Wlarg

Table 8-2: Control program options to pass an option directly to a tool

If you specify an unknown option to the control program, the control
program looks if it is an option for a specific tool. If so, it passes the
option directly to the tool. However, it is recommended to use the control
program options for passing arguments directly to tools.

With the environment variable CCM16COPT you can define options and/or
arguments that the control programs always processes before the command
line arguments.

For example, if you use the control program always with the option
--no-map-file (do not generate a linker map file), you can specify
"--no-map-file" to the environment variable CCM16COPT.

See section 1.3.2, Configuring the Command Line Environment, in Chapter
Software Installation.
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8.3 MAKE UTILITY

If you are working with large quantities of files, or if you need to build
several targets, it is rather time-consuming to call the individual tools to
compile, assemble, link and locate all your files.

You save already a lot of typing if you use the control program ccm16c

and define an options file. You can even create a batch file or script that
invokes the control program for each target you want to create. But with
these methods all files are completely compiled, assembled, linked and
located to obtain the target file, even if you changed just one C source.
This may demand a lot of (CPU) time on your host.

The make utility mkm16c is a tool to maintain, update, and reconstruct
groups of programs. The make utility looks which files are out-of-date
and only recreates these files to obtain the updated target.

Make process

In order to build a target, the make utility needs the following input:

• the target it should build, specified as argument on the command line

• the rules to build the target, stored in a file usually called makefile

In addition, the make utility also reads the file mkm16c.mk which contains
predefined rules and macros. See section 8.3.2, Writing a Makefile.

The makefile contains the relationships among your files (called
dependencies) and the commands that are necessary to create each of the
files (called rules). Typically, the absolute object file (.elf) is updated
when one of its dependencies has changed. The absolute file depends on
.obj files and libraries that must be linked together. The .obj files on
their turn depend on .src files that must be assembled and finally, .src
files depend on the C source files (.c) that must be compiled. In the
makefile makefile this looks like:

test.src  : test.c                    # dependency

            cm16c test.c              # rule

test.obj  : test.src

            asm16c test.src

test.elf  : test.obj

            lkm16c -otest.elf test.obj -lcs -lfps -lrts

You can use any command that is valid on the command line as a rule in
the makefile. So, rules are not restricted to invocation of the toolchain.
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Example

To build the target test.elf, call mkm16c with one of the following
lines:

mkm16c test.elf

mkm16c -f mymake.mak test.elf

By default, the make utility reads makefile so you do not need to specify
it on the command line. If you want to use another name for the makefile,
use the option -f my_makefile.

If you do not specify a target, mkm16c uses the first target defined in the
makefile. In this example it would build test.src instead of test.elf.

The make utility now tries to build test.elf based on the makefile
and peforms the following steps:

1. From the makefile the make utility reads that test.elf depends on
test.obj.

2. If test.obj does not exist or is out-of-date, the make utility first tries
to build this file and reads from the makefile that test.obj depends
on test.src.

3. If test.src does exist, the make utility now creates test.obj by
executing the rule for it: asm16c test.src.

4. There are no other files necessary to create test.elf so the make
utility now can use test.obj to create test.elf by executing the
rule lkm16c -otest.elf test.obj -lcs -lfps -lrts.

The make utility has now built test.elf but it only used the assembler
to update test.obj and the linker to create test.elf.

If you compare this to the control program:

ccm16c test.c

This invocation has the same effect but now all files are recompiled
(assembled, linked and located).
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8.3.1 CALLING THE MAKE UTILITY

You can only call the make utility from the command line. The invocation
syntax is

mkm16c [ [options] [targets] [macro=def]... ]

For example:

mkm16c test.elf

target You can specify any target that is defined in the makefile.
A target can also be one of the intermediate files specified
in the makefile.

macro=def Macro definition. This definition remains fixed for the
mkm16c invocation. It overrides any regular definitions
for the specified macro within the makefiles and from the
environment. It is inherited by subordinate mkm16c's but
act as an environment variable for these. That is,
depending on the -e setting, it may be overridden by a
makefile definition.

Exit status

The make utility returns an exit status of 1 when it halts as a result of an
error. Otherwise it returns an exit status of 0.

Options of the make utility

The following make utility options are available:

Description Option

Display options

Display version header

-?
-V

Verbose

Print makefile lines while being read

Display time comparisons which indicate a target is out of date

Display current date and time

Verbose option: show commands without executing (dry run)

Do not show commands before execution

Do not build, only indicate whether target is up-to-date

-D/-DD
-d/-dd
-time
-n
-s
-q
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OptionDescription

Input files

Use makefile instead of the standard makefile makefile
Change to directory before reading the makefile

Read options from file

Do not read the mkm16c.mk file

-f makefile
-G path
-m file
-r

Process

Always rebuild target without checking whether it is out-of-date

Run as a child process

Environment variables override macro definitions

Do not remove temporary files

On error, only stop rebuilding current target

Overrule the option -k (only stop rebuilding current target)

Make all target files precious

Touch the target files instead of rebuilding them

Treat target as if it has just been reconstructed

-a
-c
-e
-K
-k
-S
-p
-t
-W target

Error messages

Redirect error messages and verbose messages to a file

Ignore error codes returned by commands

Redirect messages to standard out instead of standard error

Show extended error messages

-err file
-i
-w
-x

Table 8-3: Overview of make utility options

For a complete list and description of all make utility options, see section
4.5, Make Utility Options, in Chapter Tool Options of the Reference Guide.

8.3.2 WRITING A MAKEFILE

In addition to the standard makefile makefile, the make utility always
reads the makefile mkm16c.mk before other inputs. This system makefile
contains implicit rules and predefined macros that you can use in the
makefile makefile.

With the option -r (Do not read the mkm16c.mk file) you can prevent the
make utility from reading mkm16c.mk.

The default name of the makefile is makefile in the current directory. If
on a UNIX system this file is not found, the file Makefile is used as the
default. If you want to use other makefiles, use the option -f my_makefile.



Using the Utilities 8-13

• • • • • • • •

The makefile can contain a mixture of:

• targets and dependencies

• rules

• macro definitions or functions

• comment lines

• include lines

• export lines

To continue a line on the next line, terminate it with a backslash (\):

# this comment line is continued\

on the next line

If a line must end with a backslash, add an empty macro.

# this comment line ends with a backslash \$(EMPTY)

# this is a new line

Targets and dependencies

The basis of the makefile is a set of targets, dependencies and rules. A
target entry in the makefile has the following format:

target ... : [dependency ...] [; rule]

       [rule]

        ...

Target lines must always start at the beginning of a line, leading white
spaces (tabs or spaces) are not allowed. A target line consists of one or
more targets, a semicolon and a set of files which are required to build the
target (dependencies). The target itself can be one or more filenames or
symbolic names.:

all:                    demo.elf final.elf

demo.elf final.elf:     test.obj demo.obj final.obj

You can now can specify the target you want to build to the make utility.
The following three invocations all have the same effect:

mkm16c

mkm16c all

mkm16c demo.elf final.elf
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If you do not specify a target, the first target in the makefile (in this
example all) is build. The target all depends on demo.elf and
final.elf so the second and third invocation have also the same effect
and the files demo.elf and final.elf are built.

In MS-Windows you can normally use colons to denote drive letters. The
following works as intended: c:foo.obj : a:foo.c

If a target is defined in more than one target line, the dependencies are
added to form the target's complete dependency list:

all:  demo.elf   # These two lines are equivalent with:

all:  final.elf  # all: demo.elf final.elf

For target lines, macros and functions are expanded at the moment they
are read by the make utility. Normally macros are not expanded until the
moment they are actually used.

Special Targets

There are a number of special targets. Their names begin with a period.

.DEFAULT: If you call the make utility with a target that has no definition
in the make file, this target is build.

.DONE: When the make utility has finished building the specified
targets, it continues with the rules following this target.

.IGNORE: Non-zero error codes returned from commands are ignored.
Encountering this in a makefile is the same as specifying the
option -i on the command line.

.INIT: The rules following this target are executed before any other
targets are build.

.SILENT: Commands are not echoed before executing them.
Encountering this in a makefile is the same as specifying the
option -s on the command line.

.SUFFIXES: This target specifies a list of file extensions. Instead of
building a completely specified target, you now can build a
target that has a certain file extension. Implicit rules to build
files with a number of extensions are included in the system
makefile mkm16c.mk.
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If you specify this target with dependencies, these are added
to the existing .SUFFIXES target in mkm16c.mk. If you
specify this target without dependencies, the existing list is
cleared.

.PRECIOUS: Dependency files mentioned for this target are never
removed. Normally, if a command in a rule returns an error
or when the target construction is interrupted, the make
utility removes that target file. You can use the -p command
line option to make all target files precious.

Rules

A line with leading white space (tabs or spaces) is considered as a rule
and associated with the most recently preceding dependency line. A rule
is a line with commands that are executed to build the associated target.
A target-dependency line can be followed by one or more rules.

final.src : final.c            # target and dependency

            mv test.c final.c  # rule1

            cm16c final.c      # rule2

You can precede a rule with one or more of the following characters:

@ does not echo the command line, except if -n is used.

- the make utility ignores the exit code of the command (ERRORLEVEL
in MS-DOS). Normally the make utility stops if a non-zero exit code is
returned. This  is the same as specifying the option -i on the command
line or specifying the special .IGNORE target.

+ The make utility uses a shell or COMMAND.COM to execute the
command. If the '+' is not followed by a shell line, but the command is
a DOS command or if redirection is used (<, |, >), the shell line is
passed to COMMAND.COM anyway. For UNIX, redirection, backquote
(`) parentheses and variables force the use of a shell.

You can force mkm16c to execute multiple command lines in one
shell environment. This is accomplished with the token combination
';\'. For example:

cd c:\cm16c\bin ;\

ccm16c -V
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The ';' must always directly be followed by the '\' token. Whitespace is not
removed when it is at the end of the previous command line or when it is
in front of the next command line. The use of the ';' as an operator for a
command (like a semicolon ';' separated list with each item on one line)
and the '\' as a layout tool is not supported, unless they are separated with
whitespace.

The make utility can generate inline temporary files. If a line contains
<<LABEL (no whitespaces!) then all subsequent lines are placed in a
temporary file until the line LABEL is encountered. Next, <<LABEL is
replaced by the name of the temporary file.

Example:

lkm16c -o $@ -f <<EOF

$(separate "\n" $(match .obj $!))

$(separate "\n" $(match .a $!))

$(LKFLAGS)

EOF

The three lines between <<EOF and EOF are written to a temporary file
(for example mkce4c0a.tmp), and the rule is rewritten as lkm16c -o $@
-f mkce4c0a.tmp.

Instead of specifying a specific target, you can also define a general target.
A general target specifies the rules to generate a file with extension .ex1
to a file with extension .ex2. For example:

.SUFFIXES:  .c

.c.src   :

            lkm16c $<

Read this as: to build a file with extension .src out of a file with
extension .c, call the compiler with $<. $< is a predefined macro that is
replaced with the basename of the specified file. The special target
.SUFFIXES: is followed by a list of file extensions of the files that are
required to build the target.

Implicit Rules

Implicit rules are stored in the system makefile mkm16c.mk and are
intimately tied to the .SUFFIXES special target. Each dependency that
follows the .SUFFIXES target, defines an extension to a filename which
must be used to build another file. The implicit rules then define how to
actually build one file from another. These files share a common
basename, but have different extensions.
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If the specified target on the command line is not defined in the makefile
or has not rules in the makefile, the make utility looks if there is an
implicit rule to build the target.

Example

This makefile says that prog.elf depends on two files prog.obj and
sub.obj, and that they in turn depend on their corresponding source files
(prog.c and sub.c) along with the common file inc.h.

LIB  =     -lcs                                      # macro

prog.elf:  prog.obj sub.obj

     lkm16c prog.obj sub.obj $(LIB) -o prog.elf

prog.obj:  prog.c inc.h

     cm16c  prog.c

     asm16c prog.src

sub.obj:   sub.c inc.h

     cm16c  sub.c

     asm16c sub.src

The following makefile uses implicit rules (from mkm16c.mk) to perform
the same job.

LKFLAGS = -lcs               # macro used by implicit rules

prog.elf: prog.obj sub.obj   # implicit rule used

prog.obj: prog.c inc.h       # implicit rule used

sub.obj:  sub.c inc.h        # implicit rule used

Files

makefile Description of dependencies and rules.
Makefile Alternative to makefile, for UNIX.
mkm16c.mk Default dependencies and rules.

Diagnostics

mkm16c returns an exit status of 1 when it halts as a result of an error.
Otherwise it returns an exit status of 0.

Macro definitions

A macros is a symbol names that is replaced with it's definition before the
makefile is executed. Although the macro name can consist of lower case
or upper case characters, upper case is an accepted convention. The
general form of a macro definition is:
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MACRO = text and more text

Spaces around the equal sign are not significant. To use a macro, you must
access it's contents:

$(MACRO)       # you can read this as

${MACRO}       # the contents of macro MACRO

If the macro name is a single character, the parentheses are optional. Note
that the expansion is done recursively, so the body of a macro may
contain other macros. These macros are expanded when the macro is
actually used, not at the point of definition:

FOOD = $(EAT) and $(DRINK)

EAT = meat and/or vegetables

DRINK = water

export FOOD

The macro FOOD is expanded as meat and/or vegetables and
water at the moment it is used in the export line.

Predefined  Macros

MAKE Holds the value mkm16c. Any line which uses MAKE,
temporarily overrides the option -n (Show commands
without executing), just for the duration of the one line. This
way you can test nested calls to MAKE with the option -n.

MAKEFLAGS
Holds the set of options provided to mkm16c (except for
the options -f and -d). If this macro is exported to set the
environment variable MAKEFLAGS, the set of options is
processed before any command line options. You can pass
this macro explicitly to nested mkm16c's, but it is also
available to these invocations as an environment variable.

PRODDIR Holds the name of the directory where mkm16c is installed.
You can use this macro to refer to files belonging to the
product, for example a library source file.

DOPRINT = $(PRODDIR)/lib/src/_doprint.c

When mkm16c is installed in the directory /cm16c/bin this
line expands to:

DOPRINT = /cm16c/lib/src/_doprint.c
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SHELLCMD Holds the default list of commands which are local to the
SHELL. If a rule is an invocation of one of these commands, a
SHELL is automatically spawned to handle it.

TMP_CCPROG
Holds the name of the control program: ccm16c. If this
macro and the TMP_CCOPT macro are set and the command
line argument list for the control program exceeds 127
characters, then mkm16c creates a temporary file with the
command line arguments. mkm16c calls the control program
with the temporary file as command input file.

TMP_CCOPT
Holds -f, the control program option that tells it to read
options from a file. (This macro is only available for the
Windows command prompt version of mkm16c.)

$ This macro translates to a dollar sign. Thus you can use "$$"
in the makefile to represent a single "$".

There are several dynamically maintained macros that are useful as
abbreviations within rules. It is best not to define them explicitly.

$* The basename of the current target.

$< The name of the current dependency file.

$@ The name of the current target.

$? The names of dependents which are younger than the target.

$! The names of all dependents.

The $< and $* macros are normally used for implicit rules. They may be
unreliable when used within explicit target command lines. All macros
may be suffixed with F to specify the Filename components (e.g. ${*F},
${@F}). Likewise, the macros $*, $< and $@ may be suffixed by D to
specify the directory component.

The result of the $* macro is always without double quotes ("), regardless
of the original target having double quotes (") around it or not.
The result of using the suffix F (Filename component) or D (Directory
component) is also always without double quotes ("), regardless of the
original contents having double quotes (") around it or not.
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Functions

A function not only expands but also performs a certain operation.
Functions syntactically look like macros but have embedded spaces in the
macro name, e.g. '$(match arg1 arg2 arg3 )'. All functions are built-in and
currently there are five of them: match, separate, protect, exist and
nexist.

match The match function yields all arguments which match a
certain suffix:

$(match .obj prog.obj sub.obj mylib.a)

yields:

prog.obj sub.obj

separate The separate function concatenates its arguments using the
first argument as the separator. If the first argument is
enclosed in double quotes then '\n' is interpreted as a
newline character, '\t' is interpreted as a tab, '\ooo' is
interpreted as an octal value (where, ooo is one to three octal
digits), and spaces are taken literally. For example:

$(separate "\n" prog.obj sub.obj)

results in:

prog.obj

sub.obj

Function arguments may be macros or functions themselves.
So,

$(separate "\n" $(match .obj $!))

yields all object files the current target depends on, separated
by a newline string.

protect The protect function adds one level of quoting. This
function has one argument which can contain white space. If
the argument contains any white space, single quotes, double
quotes, or backslashes, it is enclosed in double quotes. In
addition, any double quote or backslash is escaped with a
backslash.



Using the Utilities 8-21

• • • • • • • •

Example:

echo $(protect I'll show you the "protect"

function)

yields:

echo "I'll show you the \"protect\"

function"

exist The exist function expands to its second argument if the
first argument is an existing file or directory.

Example:

$(exist test.c ccm16c test.c)

When the file test.c exists, it yields:

ccm16c test.c

When the file test.c does not exist nothing is expanded.

nexist The nexist function is the opposite of the exist function. It
expands to its second argument if the first argument is not an
existing file or directory.

Example:

$(nexist test.src ccm16c test.c)

Conditional Processing

Lines containing ifdef, ifndef, else or endif are used for conditional
processing of the makefile. They are used in the following way:

ifdef macro-name
if-lines
else

else-lines
endif

The if-lines and else-lines may contain any number of lines or text of any
kind, even other ifdef, ifndef, else and endif lines, or no lines at all.
The else line may be omitted, along with the else-lines following it.
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First the macro-name after the if command is checked for definition. If
the macro is defined then the if-lines are interpreted and the else-lines are
discarded (if present). Otherwise the if-lines are discarded; and if there is
an else line, the else-lines are interpreted; but if there is no else line,
then no lines are interpreted.

When using the ifndef line instead of ifdef, the macro is tested for not
being defined. These conditional lines can be nested up to 6 levels deep.

See also Defining Macros in section 4.5, Make Utility Options, in Chapter
Tools Options of the Reference Guide.

Comment lines

Anything after a "#" is considered as a comment, and is ignored. If the "#"
is inside a quoted string, it is not treated as a comment. Completely blank
lines are ignored.

test.src  : test.c        # this is comment and is

            cm16c test.c  # ignored by the make utility

Include lines

An include line is used to include the text of another makefile (like
including a .h file in a C source). Macros in the name of the included file
are expanded before the file is included. Include files may be nested.

include makefile2

Export lines

An export line is used to export a macro definition to the environment of
any command executed by the make utility.

GREETING = Hello

export GREETING

This example creates the environment variable GREETING with the value
Hello. The macros is exported at the moment the export line is read so
the macro definition has to proceed the export line.
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8.4 ARCHIVER

The archiver arm16c is a program to build and maintain your own library
files. A library file is a file with extension .a and contains one or more
object files (.obj) that may be used by the linker.

The archiver has five main functionalities:

• Deleting an object module from the library

• Moving an object module to another position in the library file

• Replacing an object module in the library or add a new object module

• Showing a table of contents of the library file

• Extracting an object module from the library

The archiver takes the following files for input and output:

assembler

relocatable object file

linker

asm16c

lkm16c

relocatable object library

.a

archiver

arm16c .obj

Figure 8-1: ELF/DWARF archiver and library maintainer

The linker optionally includes object modules from a library if that module
resolves an external symbol definition in one of the modules that are read
before.

8.4.1 CALLING THE ARCHIVER

You can only call the archiver from the command line. The invocation
syntax is:

arm16c key_option [sub_option...] library [object_file]

key_option With a key option you specify the main task which the
archiver should perform. You must always specify a key
option.
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sub_option Sub-options specify into more detail how the archiver should
perform the task that is specified with the key option. It is
not obligatory to specify sub-options.

library The name of the library file on which the archiver performs
the specified action. You must always specify a library name,
except for the option -? and -V. When the library is not in
the current directory, specify the complete path (either
absolute or relative) to the library.

object_file The name of an object file. You must always specify an
object file name when you add, extract, replace or remove an
object file from the library.

Options of the archiver utility

The following archiver options are available:

Description Option Sub-option

Main functions (key options)

Replace or add an object module -r -a -b -c -u -v

Extract an object module from the library -x -v

Delete object module from library -d -v

Move object module to another position -m -a -b -v

Print a table of contents of the library -t -s0 -s1

Print object module to standard output -p

Sub-options

Append or move new modules after existing

module name
-a name

Append or move new modules before

existing module name
-b name

Create library without notification if library

does not exist

-c

Preserve last-modified date from the library -o

Print symbols in library modules -s{0|1}

Replace only newer modules -u

Verbose -v
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Sub-optionOptionDescription

Miscellaneous

Display options -?

Display version header -V

Read options from file -f file

Suppress warnings above level n -wn

Table 8-4: Overview of archiver options and sub-options

For a complete list and description of all archiver options, see section 4.6,
Archiver Options, in Chapter Tool Options of the Reference Guide.

8.4.2 EXAMPLES

Create a new library

If you add modules to a library that does not yet exist, the library is
created. To create a new library with the name mylib.a and add the
object modules cstart.obj and calc.obj to it:

arm16c -r mylib.a cstart.obj calc.obj

Add a new module to an existing library

If you add a new module to an existing library, the module is added at the
end of the module. (If the module already exists in the library, it is
replaced.)

arm16c -r mylib.a mod3.obj

Print a list of object modules in the library

To inspect the contents of the library:

arm16c -t mylib.a

The library has the following contents:

cstart.obj

calc.obj

mod3.obj
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Move an object module to another position

To move mod3.obj to the beginning of the library, position it just before
cstart.obj:

arm16c -mb cstart.obj mylib.a mod3.obj

Delete an object module from the library

To delete the object module cstart.obj from the library mylib.a:

arm16c -d mylib.a cstart.obj

Extract all modules from the library

Extract all modules from the library mylib.a:

arm16c -x mylib.a
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8.5 FLASH UTILITY

With the flash utility flashm16c you can load an ELF, IEEE-695, Intel Hex
or Motorola S-record file in a flash device.

Configure flash settings from EDE

You can configure all flash settings from EDE.

1. From the Project menu, select Project Options...

The Project Options dialog appears.

2. Expand the Flasher entry and select Flasher Settings.

3. Select serial or USB communication.

4. Select the flash actions.

You can perform several actions with the flash tool:

Blank check

Select this to check if the flash device is properly erased.

Full erase

Select this to erase the entire flash memory.

Program

Select this to program the flash device with the specified file.

Verify

Select this to compare a Motorola S-record file (or other absolute file) with
the content of the FLASH.

8.5.1 CALLING THE FLASH UTILITY

You can call the flash utitlity from the command line or from EDE. The
invocation syntax is:

flashm16c [option]... [file]...

If you invoke flashm16c with the -nodialog command line option the
absolute file is directly flashed into the target.
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From EDE, you can start flashing with one click on the Flash an ELF,
IEEE-695, Intel Hex or Motorola S-Rec file button located in
the toolbar.

Options of the flash utility

The following flash utility options are available:

Description Option

Target selection

Default: M16C20 - M16C60 no option

M16C10 -M16C10

R8C10 - R8C13 -R8C10

Flasher settings

Flash actions:

B - Blank check

F - Erase all blocks

P - Program file

V - Verify programmed blocks

-actions=flag...

Flash ID code

Use id to access the flash -id=id

When IDs 00 or FF fail, do not retry with

opposite

-noidretry

Communication settings

Specify baud rate (default: 9600) -baudrate=baudrate

Specify the serial port to use -com{1|2|3|4}

Use USB connection -USB

Set the target board and upload the hex

file to the USB monitor board

-set_USB_target=target

Files

Set working directory -dir dir

Read options from file -f file

Save original contents before overwriting -backup file

Specify start/end address for backup

(default: 0xC0000 - 0xFFFFF)

-backup_range=start, end
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OptionDescription

Append errors to file -err file

Miscellaneous

Do not use the Flash dialog -nodialog

Log level (detail of warnings, 0=none,

3=all)

-level={0|1|2|3}

Display short description of options -h

Show on-board flash program version -version

Example

To erase the flash device and flash the file demo.s at a baud rate of 38400
in a device connected at serial port COM2, using a command line
interface, type:

flashm16c -actions=FP -baudrate=38400 -com2

-id=00.00.00.00.00.00.00 -nodialog demo.s
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1 INTRODUCTION

This appendix discusses Macrovision's Flexible License Manager and how
it is integrated into the TASKING toolchain. It also contains descriptions of
the Flexible License Manager license administration tools that are included
with the package, the license manager log file and its contents, and the
use of options files to customize your use of the TASKING toolchain.

2 LICENSE ADMINISTRATION

2.1 OVERVIEW

The Flexible License Manager (FLEXlm) is a set of utilities that, when
incorporated into software such as the TASKING toolchain, provides for
managing access to the software.

The following terms are used to describe FLEXlm concepts and software
components:

feature A feature could be any of the following:

• A TASKING software product.

• A software product from another vendor.

license The right to use a feature on one specific PC (node-locked
license), or on a network (floating license). FLEXlm restricts
licenses for features by counting the number of licenses for
features in use when new requests are made by the
application software. It also checks if the application is
running on the correct machine.

client A TASKING application program.

daemon A process that "serves" clients. Sometimes referred to as a
server.

vendor daemon
The daemon that dispenses licenses for the requested
features. This daemon is built by an application's vendor, and
contains the vendor's personal encryption code. Tasking is
the vendor daemon for the TASKING software.
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license manager
The daemon process that sends requests from client
processes to the correct vendor daemon on the correct
machine. The same license manager is used by all
applications from all vendors, as this daemon neither
performs encryption nor dispenses licenses. The license
manager processes no user requests on its own, but forwards
these requests to other daemons (the vendor daemons).

server node A computer system that is running both the license manager
and vendor daemon software. The server node will contain
all the dynamic information regarding the usage of all the
features.

license file An end-user specific file that contains descriptions of the
server nodes that can run the license daemons, the various
vendor daemons, and the restrictions for all the licensed
features.

debug log file
A debug log file contains status and error messages useful for
debugging the license server. A license server always
generates debug log output. Some of the debug log output
describes events specific to the license manager and some of
the debug log output describes events specific to each
vendor daemon.

For floating licenses, the TASKING software is granted permission to run
by FLEXlm daemons; the daemons are started when the TASKING
toolchain is installed and run continuously thereafter. Information needed
by the FLEXlm daemons to perform access management is contained in a
license data file that is created during the toolchain installation process. As
part of their normal operation, the daemons log their actions in a log file,
which can be used to monitor usage of the TASKING toolchain.

For node-locked licenses, you only need the license file.

The following sections discuss:

• Installation of the FLEXlm license manager to provide for access to
the TASKING toolchain.

• Customizing your use of the toolchain through the use of an
options file.

• Utilities that are provided to assist you in performing license
administration functions.
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• The debug log file and its contents.

For additional information regarding the use of FLEXlm, refer to the
chapter 1, Software Installation and Configuration.

2.2 PROVIDING FOR UNINTERRUPTED FLEXLM

OPERATION

TASKING products licensed through FLEXlm using floating licenses contain
a number of utilities for managing licenses. These utilities are bundled in
the form of an extra product under the name SW000098 and is only
necessary for floating licences. TASKING products themselves contain
additional files for FLEXlm in a flexlm subdirectory:

Tasking The Tasking daemon (vendor daemon).
lmtools.exe FLEXlm utilities (Windows).

If you have already installed FLEXlm (for example. as part of another
product) then it is not needed to install the bundled SW000098. After
installing SW000098 on UNIX the directory /usr/local/flexlm will
contain two subdirectories, bin and licenses. After installing SW000098
on Windows the directory c:\flexlm will contain the subdirectory bin.
The exact location may differ if FLEXlm has already been installed as part
of a non-TASKING product but in general there will be a directory for
executables such as bin. That directory must contain a copy of the
Tasking daemon shipped with every TASKING product. It also contains
the files:

lmgrd The FLEXlm license manager daemon.
lm* A group of FLEXlm license administration utilities.

License File

A license file must be present containing the information of all licenses.
This file is usually called license.dat. The default location of the license
file is in directory c:\flexlm for Windows and in directory
/usr/local/flexlm/licenses for UNIX. If you did install SW000098
then the licenses directory on UNIX will be empty, and on Windows
the file license.dat will be empty. In that case you can copy the license
file received from Altium by E-mail to this directory.

Be very careful not to overwrite an existing license.dat file because it
contains valuable data.
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Example of a license.dat:

SERVER elliot 5100520c 7594

DAEMON Tasking /usr/local/flexlm/bin/Tasking

FEATURE SW008002-32 Tasking 3.000 1-jan-00 4 0B1810310210A6894 "123456"

If the license.dat file already exists then you should make sure that it
contains the DAEMON and FEATURE lines from your license key. An
appropriate SERVER line should already be present in that case. You
should only add a new SERVER line if no SERVER line is present. The third
field of the DAEMON line is the pathname to the Tasking daemon and
you may change it if necessary.

The default location for the license file on Windows is:

c:\flexlm\license.dat

On UNIX this is:

/usr/local/flexlm/licenses/license.dat

If the pathname of the resulting license file differs from this default
location then you must set the environment variable LM_LICENSE_FILE to
the correct pathname. If you have more than one product using the
FLEXlm license manager you can specify multiple license files by
separating each pathname (lfpath) with a ';' on Windows, or ':' on UNIX:

Windows:

set LM_LICENSE_FILE=lfpath[;lfpath]...

UNIX:

setenv LM_LICENSE_FILE lfpath[:lfpath]...

If you are running the TASKING software on multiple nodes, you have
three options for making your license file available on all the machines:

1. Place the license file in a partition which is available (via NFS on UNIX
systems) to all nodes in the network that need the license file.

2. Copy the license file to all of the nodes where it is needed.

3. Set LM_LICENSE_FILE to "port@host", where host and port come from the
SERVER line in the license file.
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When the main license manager daemon lmgrd already runs it is
sufficient to type the command:

path/lmreread

for notifying the daemon that the license.dat file has been changed.
Otherwise, you must type the command:

path/lmgrd -l /usr/tmp/license.log -local &

Both commands reside in the flexlm/bin directory mentioned before.

2.3 THE OPTIONS FILE

It is possible to customize the use of TASKING software using an options
file. This options file allows you to reserve licenses for specified users or
groups of users, to restrict access to the TASKING toolchain, and to set
software timeouts. The following table lists the keywords that are
recognized at the start of a line of an options file.

Keywords Function

RESERVE Ensure that TASKING software will always be available to

one or more users or on one or more host computer systems.

INCLUDE Specify a list of users who are allowed exclusive access to

the TASKING software.

EXCLUDE Specify a list of users who are not allowed to use the

TASKING software.

GROUP Specify a group of users for use in the other commands.

TIMEOUT Allow licenses that are idle for a specified time to be returned

to the free pool, for use by someone else.

NOLOG Causes messages of the specified type to be filtered out of

the debug log file.

DEBUGLOG Writes debug log information for this vendor daemon to the

specified file.

Table A-1: Options file keywords
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In order to use the daemon options capability, you must create an options
file and list its pathname as the fourth field on the DAEMON line for the
Tasking daemon in the license file. For example, if the daemon options
were in file /usr/local/flexlm/Tasking.opt (UNIX), then you
would modify the license file DAEMON line as follows:

DAEMON Tasking /usr/local/flexlm/bin/Tasking /usr/local/flexlm/Tasking.opt

An options file consists of lines in the following format:

RESERVE number feature {USER | HOST | DISPLAY | GROUP} name

INCLUDE feature {USER | HOST | DISPLAY | GROUP} name

EXCLUDE feature {USER | HOST | DISPLAY | GROUP} name

GROUP name <list_of_users>

TIMEOUT feature timeout_in_seconds

NOLOG {IN | OUT | DENIED | QUEUED}

DEBUGLOG file

Lines beginning with the sharp character (#) are ignored, and can be used
as comments. For example, the following options file would reserve one
copy of feature SWxxxxxx-xx for user �pat", three copies for user �lee",
and one copy for anyone on a computer with the hostname of �terry"; and
would cause QUEUED messages to be omitted from the log file. In addition,
user �joe" and group �pinheads" would not be allowed to use the feature
SWxxxxxx-xx:

GROUP pinheads moe larry curley

RESERVE 1 SWxxxxxx-xx USER pat

RESERVE 3 SWxxxxxx-xx USER lee

RESERVE 1 SWxxxxxx-xx HOST terry

EXCLUDE SWxxxxxx-xx USER joe

EXCLUDE SWxxxxxx-xx GROUP pinheads

NOLOG QUEUED

3 LICENSE ADMINISTRATION TOOLS

The following utilities are provided to facilitate license management by
your system administrator. In certain cases, execution access to a utility is
restricted to users with root privileges. Complete descriptions of these
utilities are provided at the end of this section.

lmborrow

Supports borrowing of floating licenses.

lmdiag

Diagnoses license checkout problems.
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lmdown

Gracefully shuts down all license daemons (both lmgrd and all vendor
daemons, such as Tasking) on the license server.

lmgrd

The main daemon program for FLEXlm.

lmhostid

Reports the hostid of a system.

lmnewlog

Moves existing report log information to a new file name and starts a new
report log file with existing file name.

lmpath

Shows the license path, or sets the license path in the FLEXlm registry
(Windows) or $HOME/.flexlmrc (UNIX).

lmremove

Removes a single user's license for a specified feature.

lmreread

Causes the license daemon to reread the license file and start any new
vendor daemons.

lmstat

Helps you monitor the status of all network licensing activities.

lmswitch

Switches the debug log file.

lmswitchr

Switches the report log file to a new file name.

lmver

Reports the FLEXlm version of a library or binary file.

lmtools (Windows only)

This is a graphical Windows version of the license administration tools.
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3.1 LMBORROW

Name

lmborrow - borrow floating licenses

Synopsis

lmborrow {vendor | all} enddate [time]

lmborrow -clear

lmborrow -status

lmborrow -return [ -c license_file ] [ -d display ] feature

Description

lmborrow supports borrowing of licenses that contain the BORROW
attribute. It must be run on the machine where licenses are borrowed. It is
used to perform the following:

• Initiating borrowing by setting the borrow period.
This has the effect of setting LM_BORROW with the borrow period in
either the registry (Windows) or in $HOME/.flexlmrc (UNIX).

• Clearing the borrow period

• Determining borrow status

• Returning a borrowed license early

Parameters

vendor The vendor daemon name that serves the licenses to be
borrowed (e.g. Tasking), or all specifies all vendor daemons
in that license server.

enddate [time]
Date the license is to be returned in dd-mmm-yyyy format.
time is optional and is specified in 24-hour format (hh:mm)
in the FLEXlm licensed application's local time. If time is
unspecified, the checkout lasts until the end of the given end
date.

feature The name of the borrowed feature to be returned early. Use
lmborrow -status to get a list of borrowed feature names.
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Options

-c license_file
Use the specified license_file. If no -c option is specified,
lmborrow looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, lmborrow looks for the
file c:\flexlm\license.dat (Windows), or
/usr/local/flexlm/licenses/license.dat  (UNIX).

-d display
Used to specify the display from which the borrow was
initiated. Required if your current display is different than
what was used to initiate the borrow. On Windows, it is the
system name or, in the case of a terminal server environment,
the terminal server client name. On UNIX, it is in the form
/dev/ttyxx or the X-Display name.

-clear Clear the LM_BORROW setting in the registry (Windows) or
$HOME/.flexlmrc (UNIX). Clearing the LM_BORROW setting
stops licenses from being borrowed until borrowing is
initiated again. Clearing LM_BORROW does not change the
status for already-borrowed licenses.

-status Print information about borrowed features. The borrowing
system does not have to be connected to the network to
determine the status.

-return Return a borrowed license early. First you have to reconnect
the borrowing system back to the network.
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3.2 LMDIAG

Name

lmdiag - diagnose license checkout problems

Synopsis

lmdiag [ -c license_file ] [ -n ] [ feature [:keyword=value]]

Description

lmdiag allows you to diagnose problems when you cannot check out a
license.

If no feature is specified, lmdiag will operate on all features in the license
file(s) in your path. lmdiag will first print information about the license,
then attempt to check out each license. If the checkout succeeds, lmdiag

will indicate this. If the checkout fails, lmdiag will give you the reason for
the failure. If the checkout fails because lmdiag cannot connect to the
license server, then you have the option of running "extended connection
diagnostics".

These extended diagnostics attempt to connect to each port on the license
server node, and can detect if the port number in the license file is
incorrect. lmdiag will indicate each port number that is listening, and if it
is an lmgrd process, lmdiag will indicate this as well. If lmdiag finds the
vendor daemon for the feature being tested, then it will indicate the
correct port number for the license file to correct the problem.

Parameters

feature Diagnose this feature only.

keyword=value
If a license file contains multiple lines for a particular feature,
select a particular line for lmdiag to report on. For example:
lmdiag f1:HOSTID=12345678 attempts a checkout on the
line with the hostid 12345678.  keyword is one of the
following: VERSION, HOSTID, EXPDATE, KEY,
VENDOR_STRING, ISSUER.
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Options

-c license_file
Diagnose the specified license_file. If no -c option is
specified, lmdiag looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, lmdiag looks for the file
c:\flexlm\license.dat (Windows), or
/usr/local/flexlm/licenses/license.dat  (UNIX).

-n Run in non-interactive mode; lmdiag will not prompt for
any input in this mode. In this mode, extended connection
diagnostics are not available.
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3.3 LMDOWN

Name

lmdown - graceful shutdown of all license daemons

Synopsis

lmdown [ -c license_file ] [ -vendor vendor ] [ -q ] [ -all ] [ -force ]

Description

The lmdown utility allows for the graceful shutdown of all license
daemons (both lmgrd and selected or all vendor daemons, such as
Tasking) on all nodes. You may want to protect the execution of
lmdown, since shutting down the servers causes users to lose their
licenses. See the -p option in Section 3.4, lmgrd.

lmdown sends a message to every license daemon asking it to shut down.
The license daemons write out their last messages to the log file, close the
file, and exit. All licenses which have been given out by those daemons
will be revoked, so that the next time a client program goes to verify his
license, it will not be valid.

When shutting down a three-server redundant license server, there is a
one minute delay before the servers shut down. lmdown shuts down all
three license servers of a set of redundant license servers. If you need to
shut down one of a set of redundant license servers (not recommended
because you are left with two points of failure), you must kill both the
lmgrd and vendor daemon processes on that license server machine.

On UNIX, do not use kill -9 to shut down the license servers. On
Windows, if you must use the Task Manager to kill the FLEXlm service, be
sure to end the lmgrd process first, then all the vendor daemon processes.

Options

-c license_file
Use the specified license_file. If no -c option is specified,
lmdown looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, lmdown looks for the
file c:\flexlm\license.dat (Windows), or
/usr/local/flexlm/licenses/license.dat  (UNIX).
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-vendor vendor
Shut down only this vendor daemon (for example Tasking).
lmgrd continues running.

-q Quiet mode. If this switch is not specified, lmdown asks for
confirmation before asking the license daemons to shut
down. If this switch is specified, lmdown will not ask for
confirmation.

-all If multiple servers are specified, automatically shuts down all
of them. -q is implied with -all.

-force If licenses are borrowed, lmdown runs only from the
machine where the license server is running, and then only if
you add -force.

lmgrd, lmstat, lmreread
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3.4 LMGRD

Name

lmgrd - flexible license manager daemon

Synopsis

lmgrd [ -c license_file ] [ -l [+]logfile ] [-2 -p] [-local]
           [-x lmdown] [-x lmremove] [-z] [-v]

Description

lmgrd is the main daemon program for the FLEXlm distributed license
management system. When invoked, it looks for a license file containing
all required information about vendors and features and starts those
vendor daemons. On UNIX systems, it is strongly recommended that
lmgrd be run as a non-privileged user (not root).

Options

-c license_file
Use the specified license_file. If no -c option is specified,
lmgrd looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, lmgrd looks for the file
c:\flexlm\license.dat (Windows), or
/usr/local/flexlm/licenses/license.dat  (UNIX).

-l [+]logfile Specifies the debug log file to use. With the + character
appends logging entries. Instead of using the -l option you
can use output redirection (> or >>) to specify the name of
the debug log file.

-2 -p Restricts usage of lmdown, lmreread, and lmremove to a
FLEXlm administrator who is by default root. If there is a
UNIX group called "lmadmin" then use is restricted to only
members of that group. If root is not a member of this group,
then root does not have permission to use any of the above
utilities. If -2 -p is used when starting lmgrd, no user on
Windows can shut down the license server with lmdown.
See the -x option how to stop lmgrd.

-local Restricts the lmdown command to be run only from the
same machine where lmgrd is running.
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-x lmdown Disable the lmdown command (no user can run lmdown).
If lmdown is disabled, stop lmgrd via kill pid (UNIX) or
stop the lmgrd and vendor daemon processes (Tasking)
through the Windows Task Manager or Windows service. On
UNIX, be sure the kill command does not have a -9

argument.

-x lmremove

Disable the lmremove command (no user can run
lmremove).

-z Run in foreground. The default behavior is to run in the
background. If -l logfile is present, then no windows are
used, but if no -l argument is specified, separate windows
are used for lmgrd and each vendor daemon.

-v Prints lmgrd version number and copyright and exits.

lmdown, lmstat
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3.5 LMHOSTID

Name

lmhostid - report the hostid of a system

Synopsis

lmhostid [-n] [-type]

Description

lmhostid returns the FLEXlm hostid of the current platform. Invoked
without any arguments, lmhostid displays the default hostid type for the
current platform. Otherwise, the hostid corresponding to the requested
type is displayed, if supported on the current platform.

The output of lmhostid looks like this:

lmhostid - Copyright (c) 1989-2003 by Macrovision Corporation.

The FLEXlm host ID of this machine is "1200abcd"

Options

-n Only the hostid, itself, is returned as a string, which is
appropriate to use with HOSTID= in the license file. Header
text is suppressed.

-type One of the following hostid types. If not specified, the
default hostid for the current platform is displayed.

Option Description

-ether Ethernet address.

-string String id.

-vsn Volume serial number. (Windows platforms only)

-flexid Parallel or USB FLEXid hardware key identification.

(Windows platforms only)

-long 32-bit hostid.

Table A-2: Platform Dependent Hostids
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Option Description

-user Current user name.

-display Current display name. On Windows, it is the system name or,

in case of a terminal server environment, the terminal server

client name. On UNIX, it is in the form /dev/ttyxx or the

X-Display name.

-hostname Current host name.

-internet IP address of current platform in the form  ###.###.###.###.

Table A-3: Platform Independent Hostids
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3.6 LMNEWLOG

Name

lmnewlog - switch the report log file

Synopsis

lmnewlog [ -c license_file ] feature  renamed-file

or:

lmnewlog [ -c license_file ] vendor  renamed-file

Description

The lmnewlog utility switches the report log file by moving the existing
report log information to a new file, then starting a new report log with
the original report log file name. If you rotate report logs with lmnewlog

instead of lmswitchr, you do not have to change the file name in the
REPORTLOG line of the vendor's options file.

Parameters

feature Any feature this daemon supports.

vendor The name of the vendor daemon (such as Tasking).

renamed-file
New file path where existing report log information is to be
moved.

Options

-c license_file
Use the specified license_file. If no -c option is specified,
lmnewlog looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, lmnewlog looks for the
file c:\flexlm\license.dat (Windows), or
/usr/local/flexlm/licenses/license.dat  (UNIX).

lmswitchr
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3.7 LMPATH

Name

lmpath - control FLEXlm license path settings

Synopsis

lmpath {-add | -override} {vendor | all} license_file_list

lmpath -status

Description

The lmpath utility allows direct control over FLEXlm license path settings.
It is used to add, override, or get the current license path settings.

lmpath works by setting the FLEXlm registry entry on Windows or
$HOME/.flexlmrc on UNIX.

Parameters

vendor The vendor daemon name (e.g. Tasking), or all specifies all
vendor daemons in that license server.

license_file_list
A colon-separated list on UNIX and a semicolon- separated
list on Windows. If license_file_list is the null string, "", then
the specified entry is deleted.

Options

-add Prepends license_file_list to the current license file list or
creates the license file list, if it does not exist, initializing it to
license_file_list. Duplicates are discarded.

-override Overrides the existing license file list with license_file_list. If
license_file_list is the null string, "", the specified list is
deleted.

-status Display the current license path settings.
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3.8 LMREMOVE

Name

lmremove - remove specific licenses and return them to license pool

Synopsis

lmremove [ -c license_file ] feature user user_host [ display ]

or:

lmremove [ -c license_file ] -h feature server_host port handle

Description

The lmremove utility allows the system administrator to remove a single
user's license for a specified feature. This could be required in the case
where the licensed user was running the software on a node that
subsequently crashed. This situation will sometimes cause the license to
remain unusable. lmremove will allow the license to return to the pool of
available licenses.

lmremove will remove all instances of user on node user_host on display
display from usage of feature. If the optional -c license_file is specified,
the indicated file will be used as the license file.

The -h variation uses the server_host, port, and license handle, as reported
by lmstat -a.

You can protect the unauthorized execution of lmremove when you start
up the license manager daemon, lmgrd, because removing a user's license
is disruptive.

Options

-c license_file
Use the specified license_file. If no -c option is specified,
lmremove looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, lmremove looks for the
file c:\flexlm\license.dat (Windows), or
/usr/local/flexlm/licenses/license.dat  (UNIX).

lmgrd, lmstat
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3.9 LMREREAD

Name

lmreread - tells the license daemon to reread the license file

Synopsis

lmreread [ -c license_file ] [ -vendor vendor ] [ -all ]

Description

lmreread allows the system administrator to tell the license daemon to
reread the license file and start any new vendor daemons that have been
added. This can be useful if the data in the license file has changed; the
new data can be loaded into the license daemon without shutting down
and restarting it.

The license administrator may want to protect the execution of lmreread.
See the options -p and -x in Section 3.4, lmgrd for details about securing
access to lmreread.

lmreread uses the license file from the command line (or the default file,
if none is specified) only to find the license daemon to send it the
command to reread the license file. The license manager daemon, lmgrd,
will always reread the file that it loaded from the original path. If you need
to change the path to the license file read by the license manager daemon,
then you must shut down the daemon and restart it with that new license
file path.

You cannot use lmreread if the SERVER node names or port numbers
have been changed in the license file. In this case, you must shut down
the daemon and restart it in order for those changes to take effect.

lmreread does not change any option information specified in an options
file. If the new license file specifies a different options file, that
information is ignored. If you need to reread the options file, you must
shut down (lmdown) the daemon and restart it.

To stop and restart a single vendor daemon, use lmdown -vendor

vendor, then use lmreread -vendor vendor, which restarts the vendor
daemon.
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Options

-c license_file
Use the specified license_file. If no -c option is specified,
lmreread looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, lmreread looks for the
file license.dat in the default location.

-vendor vendor
Only this one vendor daemon rereads the license file. lmgrd

restarts the vendor daemon if necessary.

-all If more than one lmgrd is specified, instructs all lmgrds to
reread.

lmgrd, lmdown
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3.10 LMSTAT

Name

lmstat - report status on license manager daemons and feature usage

Synopsis

lmstat [ -a ] [-c license_file ] [ -f feature ] [ -S vendor ]

Description

lmstat helps you monitor the status of all network licensing activities,
including:

• Daemons that are running

• Users of individual features

• Users of features served by a specific DAEMON

• BORROW licenses borrowed

lmstat prints information that it receives from the license server; therefore,
it does not report on unserved licenses such as uncounted licenses. To
report on an uncounted license, the license must be added to a served
license file and the application must be directed to use the license server
for that license file (via @host, port@host or USE_SERVER). Queued users
and licenses shared due to duplicate grouping are also not returned by
lmstat.

Example output of lmstat -a

License server status: 2700@myhost1

License file(s) on myhost1: /usr/local/flexlm/licenses/license.dat:

   myhost1: license server UP (MASTER) v8.4

Vendor daemon status (on myhost1):

   Tasking: UP v8.4

Feature usage info:

Users of SWxxxx-xx: (Total of 99 licenses issued; Total of 1

license in use)

  "SWxxxx-xx" v99.900, vendor: Tasking

  floating license

   rb myhost2 /dev/tty (v99.9) (myhost1/2700 9242), 

      start Wed 5/26 11:42 (linger: 300)
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where:

rb user User name.

myhost2 user_host Host where user is running.

/dev/tty display Display where user is running..

v99.9 version Version of feature.

myhost1 server_host Host where license server is
running.

2700 port TCP/IP port on server_host
where license server is running.

9242 handle License handle.

start Wed 5/26
11:42 (linger:
300)

checkout_time Time that this license was
checked out..

The user, user_host, display, server_host, port, and handle information is
used when removing licenses with lmremove.

Options

-a Display all information.

-c license_file
Use the specified license_file. If no -c option is specified,
lmstat looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, lmstat looks for the file
c:\flexlm\license.dat (Windows), or
/usr/local/flexlm/licenses/license.dat  (UNIX).

-f feature List all users of the specified feature(s).

-S vendor List all users of the specified vendor's features.

lmgrd
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3.11 LMSWITCH

Name

lmswitch - switch the debug log file

Synopsis

lmswitch [ -c license_file ] feature  new-file

or:

lmswitch [ -c license_file ] vendor  new-file

Description

The lmswitch utility switches the debug log file written by a particular
vendor daemon (such as Tasking) by closing the existing debug log for
that vendor daemon and starting a new debug log for that vendor daemon
with a new file name. It also starts a new debug log file written by that
vendor daemon if one does not already exist.

By default, debug log output from lmgrd and all vendor daemons started
by that lmgrd get written into the same debug file. lmswitch allows
companies to keep separate log files for different vendors and control the
size of their debug log file.

If debug log output is not already directed to a separate file for this vendor
daemon, lmswitch tells the vendor daemon to start writing its debug log
output to a file, new-file. If this vendor daemon is already writing to its
own debug log, lmswitch tells the vendor daemon to close its current
debug log file and start writing its debug log output to new-file.

The effect of lmswitch continues only until the vendor daemon is shut
down or its options file is reread via lmreread. When the vendor daemon
is restarted or its options file is reread, it looks for a DEBUGLOG line in the
options file to determine whether or not to write its debug log output into
its own file and, if so, what file to write.

Parameters

feature Any feature this daemon supports.

vendor The name of the vendor daemon (such as Tasking).

new-file Path to new debug log file.
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Options

-c license_file
Use the specified license_file. If no -c option is specified,
lmswitch looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, lmswitch looks for the
file c:\flexlm\license.dat (Windows), or
/usr/local/flexlm/licenses/license.dat  (UNIX).

Section 4, The Debug Log File.
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3.12 LMSWITCHR

Name

lmswitchr - switch the report log file

Synopsis

lmswitchr [ -c license_file ] feature  new-file

or:

lmswitchr [ -c license_file ] vendor  new-file

Description

The lmswitchr utility switches the report log file by closing the existing
report log and starting a new report log with a new file name. It also starts
a new report log file if one does not already exist.

Parameters

feature Any feature this daemon supports.

vendor The name of the vendor daemon (such as Tasking).

new-file Path to new report log file.

Options

-c license_file
Use the specified license_file. If no -c option is specified,
lmswitchr looks for the environment variable
LM_LICENSE_FILE in order to find the license file to use. If
that environment variable is not set, lmswitchr looks for the
file c:\flexlm\license.dat (Windows), or
/usr/local/flexlm/licenses/license.dat  (UNIX).

lmnewlog
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3.13 LMVER

Name

lmver - report the FLEXlm version of a library or binary file

Synopsis

lmver filename

Description

The lmver utility reports the FLEXlm version of a library or binary file.

Alternatively, on UNIX systems, you can use the following commands to
get the FLEXlm version of a binary:

strings file | grep Copy

Parameters

filename Name of the executable of a TASKING product, lmgrd, a
license administration tool or a vendor daemon (Tasking).
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3.14 LICENSE ADMINISTRATION TOOLS FOR WINDOWS

3.14.1 LMTOOLS FOR WINDOWS

For the 32-bit Windows platforms, an lmtools.exe Windows program is
provided. It has the same functionality as listed in the previous sections
but is graphically-oriented. Simply run the program (from the Windows
Start menu, select Programs -> TASKING FLEXlm -> FLEXlm Tools)
and choose a tab for the functionality required. Refer to the previous
sections for information about the options of each feature.

3.14.2 FLEXLM LICENSE MANAGER FOR WINDOWS

lmgrd.exe can be run manually or using the graphical Windows tool
lmtools.exe.

Configure a license manager as a service

To configure a license manager as a service, you must have Administrator
privileges:

1. From the Windows Start menu, select Programs -> TASKING FLEXlm

-> FLEXlm Tools.

The license manager tool appears.

2. Click the Configuration using Services radio button, then click the
Config Services tab.
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3. Enter the information as shown in the image above (enable Use Services

and Start Server at Power Up) and click the Save Service button.

From now on, when the machine is rebooted, the license manager starts
automatically as a Windows service.

Manually control the license manager

Once the license manager service is configured, lmgrd is started by
starting the service from the LMTOOLS interface:

1. From the Windows Start menu, select Programs -> TASKING FLEXlm

-> FLEXlm Tools.

The license manager tool appears.

2. Click the Configuration using Services radio button and select FLEXLM
License Manager for TASKING
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3. Click the Start/Stop/Reread tab, select FLEXLM License Manager for
TASKING.

4. Click on the Start Server button.

The FLEXLM License Manager for TASKING license server starts and
writes its debug log output to c:\flexlm\license.log.
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4 THE DEBUG LOG FILE

The FLEXlm daemons all generate debug log files containing messages in
the following format:

mm/dd hh:mm (daemon) message

Where:

mm/dd hh:mm Is the month/day hour:minute that the message was
logged.

daemon Either lmgrd or the vendor daemon name (Tasking).

In the case where a single copy of the daemon cannot
handle all of the requested licenses, an optional �_"
followed by a number indicates that this message comes
from a forked daemon.

message The text of the message.

The log files can be used to:

• Inform you when it may be necessary to update your application
software licensing arrangement.

• Diagnose configuration problems.

• Diagnose daemon software errors.

The messages are grouped below into the above three categories, with
each message followed by a brief description of its meaning.
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4.1 INFORMATIONAL MESSAGES

Connected to host

This daemon is connected to its peer on host.

CONNECTED, master is host

The license daemons log this message when a quorum is up and everyone
has selected a master.

DEMO mode supports only one SERVER host!

An attempt was made to configure a demo version of the software for
more than one server host.

DENIED: N feature to user

user was denied access to N licenses of feature. This message may indicate
a need to purchase more licenses.

EXITING DUE TO SIGNAL nnn
EXITING with code nnn

All daemons list the reason that the daemon has exited.

EXPIRED: feature

feature has passed its expiration date.

IN: "feature" user (num licenses)

user has checked back in num licenses of feature.

Lost connection to host

A daemon can no longer communicate with its peer on node host, which
can cause the clients to have to reconnect, or cause the number of
daemons to go below the minimum number, in which case clients may
start exiting. If the license daemons lose the connection to the master, they
kill all the vendor daemons; vendor daemons shut themselves down.

Lost quorum

The daemon lost quorum, so will process only connection requests from
other daemons.
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MULTIPLE vendor servers running. Please kill, and restart license
daemon

The license manager daemon, lmgrd, has detected that multiple vendor
daemons for vendor are running. Shutdown lmgrd and all vendor
daemons with the lmdown utility and then restart lmgrd.

OUT: "feature" user (num licenses)

user has checked out num licenses of feature.

RESERVE feature for HOST host
RESERVE feature for USER user

A license of feature is reserved for either user or host.

REStarted vendor (internet port nnn)

Vendor daemon vendor was restarted at internet port nnn.

Retrying socket bind (address in use)

The license servers try to bind their sockets for approximately 6 minutes if
they detect address in use errors.

Selected (EXISTING) master host

This license daemon has selected an existing master host as the master.

SERVER shutdown requested

A daemon was requested to shut down via a user-generated kill

command.

Server started for: "feature-list"

A (possibly new) server was started for the features listed.

Shutting down vendor

The license manager daemon is shutting down the vendor daemon vendor.

SIGCHLD received. Killing child servers

A vendor daemon logs this message when a shutdown was requested by
the license daemon.
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Started vendor

The license daemon logs this message whenever it starts a new vendor
daemon.

Trying connection to host

The daemon is attempting a connection to host.
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4.2 CONFIGURATION PROBLEM MESSAGES

host: Not a valid server host, exiting

This daemon was run on an invalid host name.

host: Wrong hostid, exiting

The hostid is wrong for host.

BAD CODE for feature

The specified feature name has a bad encryption code.

CANNOT OPEN options file file

The options file specified in the license file could not be opened.

Couldn't find a master

The daemons could not agree on a master.

License daemon: lost all connections

This message is logged when all the connections to a server are lost,
which often indicates a network problem.

lost lock, exiting
Error closing lock file
Unable to re-open lock file

The vendor daemon has a problem with its lock file, usually because of an
attempt to run more than one copy of the daemon on a single node.
Locate the other daemon that is running via a ps command, and kill it
with kill -9.

NO DAEMON line for vendor

The license file does not contain a DAEMON or VENDOR line for vendor.

No DAEMON lines, exiting

The license daemon logs this message if there are no DAEMON or VENDOR
lines in the license file. Because there are no vendor daemons to start,
there is nothing for the license daemon to do.
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No features to serve!

A vendor daemon found no features to serve. This could be caused by bad
data in the license file.

UNSUPPORTED FEATURE request: feature by user

The user has requested a feature that this vendor daemon does not
support. This can happen for a number of reasons: the license file is bad,
the feature has expired, or the daemon is accessing the wrong license file.

Unknown host: host

The host name specified on a SERVER line in the license file does not exist
in the network database (probably /etc/hosts).
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4.3 DAEMON SOFTWARE ERROR MESSAGES

accept: message

An error was detected in the accept system call.

Can't allocate server table space

A malloc error. Check swap space.

Connection to host: TIMED OUT

The daemon could not connect to host.

Illegal connection request to vendor

A connection request was made to vendor, but this vendor daemon is not
vendor.

read: error message

An error in a read system call was detected.

select: message

An error in a select system call was detected.

Server exiting

The server is exiting. This is normally due to an error.
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5 FLEXLM LICENSE ERRORS

FLEXlm license error, encryption code in license file is inconsistent

Check the contents of the license file using the license key for the product.
Correct the license file and run the lmreread command. However, do not
change the last (fourth) field of a SERVER line in the license file. This
cannot have any effect on the error message but changing it will cause
other problems.

license file does not support this version

If this is a first time install then follow the procedure for the error message:

FLEXlm license error, encryption code in license file is

inconsistent

because there may be a typo in the fourth field of a FEATURE line of your
license file. In all other cases you need a new license because the current
license is for an older version of the product.

Replace the FEATURE line for the old version of the product with a
FEATURE line for the new version (it can be found on the new license
data sheet). Run the lmreread command afterwards. You can have only
one version of a feature (previous versions of the product will continue to
work).

FLEXlm license error, cannot find license file

Make sure the license file exists. If the pathname printed on the line after
the error message is incorrect, correct this by setting the
LM_LICENSE_FILE environment variable to the full pathname of the
license file.

FLEXlm license error, cannot read license file

Every user needs to have read access on the license file and at least
execute access on every directory component in the pathname of the
license file. Write access is never needed. Read access on directories is
recommended.

FLEXlm license error, no such feature exists

Check the license file. There should be a line starting with:

FEATURE SWiiiiii-jj
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where "iiiiii" is a six digit software code and "jj" is a two digit host code
for identifying a compatible host architecture. During product installations
the product code is shown, e.g. SW008002, SW019002. The number in the
software code is the same as the number in the product code except that
the first number may contain an extra leading zero (it must be six digits
long).
The line after the license error message describes the expected feature
format and includes the host code.
Correct the license file using the license data sheet for the product and run
the lmreread command. There is one catch: do not add extra SERVER
lines or change existing SERVER lines in the license file.

FLEXlm license error, license server does not support this feature

If the LM_LICENSE_FILE variable has been set to the format
number@host then see first the solution for the message:

FLEXlm license error, no such feature exists

Run the lmreread program to inform the license server about a changed
license data file. If lmreread succeeds informing the license server but the
error message persists, there are basically three possibilities:

1. The license key is incorrect. If this is the case then there must be an error
message in the log file of lmgrd. Correct the key using the license data
sheet for the product. Finally rerun lmreread. The log file of lmgrd is
usually specified to lmgrd at startup with the -l option or with >.

2. Your network has more than one FLEXlm license server daemon and the
default license file location for lmreread differs from the default assumed
by the program. Also, there must be more than one license file. Try one of
the following solutions on the same host which produced the error
message:

- type:

 lmreread -c /usr/local/flexlm/licenses/license.dat

- set LM_LICENSE_FILE to the license file location and retry the
lmreread command.

- use the lmreread program supplied with the product SW000098,
Flexible License Manager. SW000098 is bundled with all TASKING
products.
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3. There is a protocol version mismatch between lmgrd and the daemon
with the name "Tasking" (the vendor daemon according to FLEXlm
terminology) or there is some other internal error. These errors are always
written to the log file of lmgrd. The solution is to upgrade the lmgrd

daemon to the one supplied in SW000098, the bundled Flexible License
Manager product.

On the other hand, if lmreread complains about not being able to
connect to the license server then follow the procedure described in the
next section for the error message "Cannot read license file data from
server". The only difference with the current situation is that not the
product but a license management utility shows a connect problem.

FLEXlm license error, Cannot read license file data from server

This indicates that the program could not connect to the license server
daemon. This can have a number of causes. If the program did not
immediately print the error message but waited for about 30 seconds (this
can vary) then probably the license server host is down or unreachable. If
the program responded immediately with the error message then check
the following if the LM_LICENSE_FILE variable has been set to the format
number@host:

- is the number correct? It should match the fourth field of a SERVER
line in the license file on  the license server host. Also, the host
name on that SERVER line  should be the same as the host name set
in the LM_LICENSE_FILE variable. Correct LM_LICENSE_FILE if
necessary.

In any case one should verify if the license server daemon is running.
Type the following command on the host where the license server
daemon (lmgrd) is supposed to run.

On SunOS 4.x:

ps wwax | grep lmgrd | grep -v grep

On HP-UX or SunOS 5.x (Solaris 2.x):

ps -ef | grep lmgrd | grep -v grep

If the command does not produce any output then the license server
daemon is not running. See below for an example how to start lmgrd.
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Make sure that both license server daemon (lmgrd) and the program are
using the same license data. All TASKING products use the license file
/usr/local/flexlm/licenses/license.dat  unless overruled by the
environment variable LM_LICENSE_FILE. However, not all existing
lmgrd daemons may use the same default. In case of doubt, specify the
license file pathname with the -c option when starting the license server
daemon. For example:

lmgrd -c /usr/local/flexlm/licenses/license.dat \

-l /usr/local/flexlm/licenses/license.log &

and set the LM_LICENSE_FILE environment variable to the
license.dat pathname mentioned with the -c option of lmgrd before
running any license based program (including lmreread, lmstat,
lmdown). If lmgrd and the program run on different hosts, transparent
access to the license file is assumed in the situation described above (e.g.
NFS). If this is not the case, make a local copy of the license file (not
recommended) or set LM_LICENSE_FILE to the form number@host, as
described earlier.

If none of the above seems to apply (i.e. lmgrd was already running and
LM_LICENSE_FILE has been set correctly) then it is very likely that there
is a TCP port mismatch. The fourth field of a SERVER line in the license
file specifies a TCP port number. That number can be changed without
affecting any license. However, it must never be changed while the license
server daemon is running. If it has been changed, change it back to the
original value. If you do not know the original number anymore, restart
the license server daemon after typing the following command on the
license server host:

kill PID

where PID is the process id of lmgrd.
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6 FREQUENTLY ASKED QUESTIONS (FAQS)

6.1 LICENSE FILE QUESTIONS

I've received FLEXlm license files from two different companies. Do I
have to combine them?

You don't have to combine license files. Each license file that has any
'counted' lines (the 'number of licenses' field is >0) requires a server. It's
perfectly OK to have any number of separate license files, with different
lmgrd server processes supporting each file. Moreover, since lmgrd is a
lightweight process, for sites without system administrators, this is often
the simplest (and therefore recommended) way to proceed. With v6+
lmgrd/lmdown/lmreread, you can stop/reread/restart a single vendor
daemon (of any FLEXlm version). This makes combining licenses more
attractive than previously. Also, if the application is v6+, using 'dir/*.lic' for
license file management behaves like combining licenses without
physically combining them.

When is it recommended to combine license files?

Many system administrators, especially for larger sites, prefer to combine
license files to ease administration of FLEXlm licenses. It's purely a matter
of preference.

Does FLEXlm handle dates in the year 2000 and beyond?

Yes. The FLEXlm date format uses a 4-digit year. Dates in the 20th century
(19xx) can be abbreviated to the last 2 digits of the year (xx), and use of
this feature is quite widespread. Dates in the year 2000 and beyond must
specify all 4 year digits.

6.2 FLEXLM VERSION

Which FLEXlm versions does TASKING deliver?

We deliver FLEXlm v8.4 on both Windows and UNIX.



User's GuideA-46
F
L
E
X
L
M

I have products from several companies at various FLEXlm version
levels. Do I have to worry about how these versions work together?

If you're not combining license files from different vendors, the simplest
thing to do is make sure you use the tools (especially lmgrd) that are
shipped by each vendor.

lmgrd will always correctly support older versions of vendor daemons
and applications, so it's always safe to use the latest version of lmgrd and
the other FLEXlm utilities. If you've combined license files from two
vendors, you must use the latest version of lmgrd.

If you've received two versions of a product from the same vendor, you
must use the latest vendor daemon they sent you. An older vendor
daemon with a newer client will cause communication errors.

Please ignore letters appended to FLEXlm versions, for example, the "a" in
v8.4a. The appended letter indicates a patch, and does NOT indicate any
compatibility differences. In particular, some elements of FLEXlm didn't
require certain patches, so a v8.4 lmgrd will work successfully with a
v8.4a vendor daemon.

I've received a new copy of a product from a vendor, and it uses a new
version of FLEXlm. Is my old license file still valid?

Yes. Older FLEXlm license files are always valid with newer versions of
FLEXlm.

6.3 WINDOWS QUESTIONS

What Windows Host Platforms can be used as a server for Floating
Licenses?

The system being used as the server (where the FLEXlm License Manager
is running) for Floating licenses, must be Windows NT, 2000 or XP.  The
FLEXlm License Manager does not run properly with Windows 95/98/Me.



Flexible License Manager (FLEXlm) A-47

• • • • • • • •

6.4 TASKING QUESTIONS

How will the TASKING licensing/pricing model change with License
Management (FLEXlm)?

TASKING will now offer the following types of licenses so you can
purchase licenses based upon usage:

License Description Pricing

Node Locked This license can only be used on a

specific system.  It cannot be

moved to another system.

The pricing for this

license will be the

current product pricing.

Floating This license requires a network

(license server and a TCP/IP (or

IPX/SPX) connection between

clients and server) and can be used

on any host system (using the
same operating system) in the

network.

The pricing for this

license will be 50%

higher than the node

locked license.

How does FLEXlm affect future product ordering?

For all licenses, node locked or floating, you must provide information
that is used to create a license key.  For node locked licenses we must
have the host id.  Floating licenses require the host id and host name.
The host id is a unique identification of the machine, which is based upon
different hardware depending upon host platform.  The host name is the
network name of the machine.

TASKING Logistics CANNOT ship ANY orders that do not include the host
id and/or host name information.

What if I do not know the information needed for the license key?

On Windows we have a software utility (licadmin.exe) which will obtain
and display the host id so a customer can easily obtain this information.
This utility is available from our web site, placed on all product CDs
(which support FLEXlm), and from technical support. If you have already
installed FLEXlm, you can also use lmhostid.

On UNIX you can use hostid on SunOS/Solaris or lanscan on HP-UX to
retreive the host id. Use hostname to retreive the host name.

• In the case of a Node locked license, it is important that the customer
runs this utility on the exact machine he intends to run the
TASKING tools on.
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• In the case of a Floating License, the utility to retreive the host id
and/or host name should be run on the machine on which the
FLEXlm license manager will be installed, e.g. the server.

See also section 1.4.7, How to Determine the Hostid and section 1.4.8, How
to Determine the Hostname in chapter 1, Software Installation and
Configuration.

How will the �locking" mechanism work?

• For node locked licenses, FLEXlm will first search for an ethernet card.
If one exists, it will lock onto the number of the ethernet card.  If an
ethernet card does not exist, FLEXlm will lock onto the hard disk serial
number.  If multiple ehternet cards are found, the user can select which
one to use.

• For floating licenses, the ethernet card number will be used.

What happens if I try to move my node locked license to another
system?

The software will not run.

What does linger-time for floating licenses mean?

When the TASKING product starts to run, it will try to obtain a license
from the license server.  The license server keeps track of the number of
licenses already issued, and grants or denies the request.  When the
software has finished running, the license is kept by the license server for
a period of time known as the �linger-time".  If the same user requests the
TASKING product again within the linger-time, he is granted the license
again.  If another user requests a license during the linger-time, his
request is denied until the linger-time has finished

What is the length of the linger-time for floating licenses?

The length of the linger-time for both the PC and UNIX floating licenses is
5 minutes.

Can the linger-time be changed?

Yes.  A customer can change the linger-time to be larger (but not shorter)
than the time specified by TASKING.
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What happens if my system crashes or I upgrade to a new system?

You will need to contact Technical Support for temporary license keys due
to a system crash or to move from one system to another system.  You will
then need to work with your local sales representative to obtain a
permanent new license key.

Can I borrow a floating license?

Yes, you can borrow a floating license if it contains the BORROW keyword.
(Contact your sales representative if you do not have one).

Borrowing allows you to use the floating license while disconnected from
the network. The license will be kept occupied by the license manager for
the duration of the borrowing period.

Use FLEXlm Tools (Borrowing tab of LMTOOLS on Windows) or
lmborrow to initiate borrowing.

6.5 USING FLEXLM FOR FLOATING LICENSES

Does FLEXlm work across the internet?

Yes. A server on the internet will serve licenses to anyone else on the
internet. This can be limited with the 'INTERNET=' attribute on the
FEATURE line, which limits access to a range of internet addresses. You
can also use the INCLUDE and EXCLUDE options in the options file to
allow (or deny) access to clients running on a range of internet addresses.

Does FLEXlm work with Internet firewalls?

Many firewalls require that port numbers be specified to the firewall.
FLEXlm v5 lmgrd and vendor daemons support this.

If my FLEXlm-licensed application dies, does the server free the
license?

Yes, unless the FLEXlm-licensed application's whole system crashes.
Assuming communications is TCP, the license is automatically freed
immediately. If communications are UDP, then the license is freed after the
UDP timeout, which is set by each vendor, but defaults to 45 minutes.
UDP communications is normally only set by the end-user, so TCP should
be assumed. If the whole system crashes, then the license is not freed, and
you should use lmremove to free the license.
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What happens when the license server dies?

FLEXlm applications send periodic heartbeats to the server to discover if it
has died. What happens when the server dies is then up to the application:

• Continue periodic attempts to re-checkout the license when the server
comes back up.

• Attempt to re-checkout a license a few times, and then, presumably
with some warning, exit.

• In the case of GUI applications, present pop-ups to the user
periodically letting them know the server is down and needs to be
restarted.

How do you tell if a port is already in use?

99.44% of the time, if it's in use, it's because lmgrd is already running on
the port - or was recently killed, and the port isn't freed yet. Assuming this
is not the case, then use 'telnet host port' - if it says "Can't connect", it's a
free port.

Does FLEXlm require root permissions?

No. There is no part of FLEXlm, lmgrd, vendor daemon or application,
that requires root permissions. In fact, it is strongly recommended that you
do not run the license server (lmgrd) as root, since root processes can
introduce security risks.
If lmgrd must be started from the root user (for example, in a system boot
script), we recommend that you use the 'su' command to run lmgrd as a
non-privileged user:

su username -c"/path/lmgrd -c /path/license.dat \

            -l /path/log"

where username is a non-privileged user, and path is the correct paths to
lmgrd, license.dat and debug log file. You will have to ensure that the
vendor daemons listed in /path-to-license/license.dat have execute
permissions for username. The paths to all the vendor daemons in the
license file are listed on each DAEMON line.

Is it OK to run lmgrd as 'root' (UNIX only)?

It is not prudent to run any command, particularly a daemon, as root on
UNIX, as it may pose a security risk to the Operating System. Therefore,
we recommend that lmgrd be run as a non-privileged user (not 'root'). If
you are starting lmgrd from a boot script, we recommend that you use
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su username -c "umask 022; /path/lmgrd \

            -c /path/license.dat -l /path/log" 

to run lmgrd as a non-privileged user.

Does FLEXlm licensing impose a heavy load on the network?

No, but partly this depends on the application, and end-user's use. A
typical checkout request requires 5 messages and responses between
client and server, and each message is < 150 bytes.

When a server is not receiving requests, it requires virtually no CPU time.
When an application, or lmstat, requests the list of current users, this can
significantly increase the amount of networking FLEXlm uses, depending
on the number of current users.  Also, prior to FLEXlm v5, use of
'port@host' can increase network load, since the license file is
down-loaded from the server to the client. 'port@host' should be, if
possible, limited to small license files (say < 50 features). In v5+,
'port@host' actually improves performance.

Does FLEXlm work with NFS?

Yes. FLEXlm has no direct interaction with NFS. FLEXlm uses an
NFS-mounted file like any other application.

Does FLEXlm work with ATM, ISDN, Token-Ring, etc.?

In general, these have no impact on FLEXlm. FLEXlm requires TCP/IP or
SPX (Novell Netware). So long as TCP/IP works, FLEXlm will work.

Does FLEXlm work with subnets, fully-qualified names, multiple
domains, etc.?

Yes, although this behavior was improved in v3.0, and v6.0. When a
license server and a client are located in different domains, fully-qualified
host names have to be used. A fully-qualified hostname is of the form:

machine.domain

where machine is the local host name (usually returned by the
'hostname' command or 'uname -n') domain is the internet domain
name, e.g. 'globes.com'.

To ensure success with FLEXlm across domains, do the following:

1. Make the sure the fully-qualified hostname is the name on the SERVER
line of the license file.
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2. Make sure ALL client nodes, as well as the server node, are able to 'telnet'
to that fully-qualified hostname. For example, if the host is locally called
'speedy', and the domain name is 'corp.com', local systems will be able to
logon to speedy via 'telnet speedy'. But very often, 'telnet
speedy.corp.com' will fail, locally.
Note that this telnet command will always succeed on hosts in other
domains (assuming everything is configured correctly), since the network
will resolve speedy.corp.com automatically.

3. Finally, there must be an 'alias' for speedy so it's also known locally as
speedy.corp.com. This alias is added to the /etc/hosts file, or if
NIS/Yellow Pages are being used, then it will have to be added to the NIS
database. This requirement goes away in version 3.0 of FLEXlm.

If all components (application, lmgrd and vendor daemon) are v6.0 or
higher, no aliases are required; the only requirement is that the fully
qualified domain name, or IP address, is used as a host name on the
SERVER, or as a host name in the LM_LICENSE_FILE environment
variable (port@host or @host).

Does FLEXlm work with NIS and DNS?

Yes. However, some sites have broken NIS or DNS, which causes FLEXlm
to fail. In v5 of FLEXlm, NIS and DNS can be avoided to solve this
problem. In particular, sometimes DNS is configured for a server that s not
currently available (e.g., a dial-up connection from a Windows system).
Again, if DNS is configured, but the server is not available, FLEXlm fails.

In addition, some systems, particularly Sun, SGI, HP, require that
applications be linked dynamically to support NIS or DNS. If a vendor
links statically, this can cause the application to fail at a site that uses NIS
or DNS. In these situations, the vendor will have to relink, or recompile
with v5 FLEXlm. Vendors are strongly encouraged to use dynamic libraries
for libc and networking libraries, since this tends to improve quality in
general, as well as making NIS/DNS work.

On PCs, if a checkout seems to take 3 minutes and then fails, this is
usually because the system is configured for a dial-up DNS server which is
not currently available. The solution here is to turn off DNS.

Finally, hostnames must NOT have periods in the name. These are not
legal hostnames, although PCs will allow you to enter them, and they will
not work with DNS.
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We're using FLEXlm over a wide-area network. What can we do to
improve performance?

With the most common uses of FLEXlm, traffic is negligible. In particular,
checkout, checkin, and heartbeats use very little networking traffic. There
are two items, however, which can send considerably more data:

• 'lmstat -a' should be used sparingly. Network traffic increases as
the amount of concurrent users and features increases. As a rule of
thumb, avoid using this command when there are more than 20
concurrent users or features.

• Prior to FLEXlm v5, the port@host mode of the LM_LICENSE_FILE
environment variable should be avoided, especially when the
license file has many features, or there are a lot of license files
included in LM_LICENSE_FILE. The license file information is sent
via the network, and can place a heavy load. Failures due to
port@host generate the error LM_SERVNOREADLIC (-61).
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Symbols
-M option, 3-19
__asm, syntax, 3-20
__asmfunc, 3-37
__atbit(), 3-7
__bita, 3-13
__BUILD__, 3-29
__far, 3-13
__LITTLE_ENDIAN__, 3-29
__MODEL__, 3-29
__near, 3-13
__paged, 3-13
__REVISION__, 3-29
__rom, 3-13
__sfr, 3-13, 3-16
__VERSION__, 3-29

A
absolute address, 3-18
absolute variable, 3-18
addressing modes, 4-6
architecture definition, 7-21
archiver, 8-23

invocation, 8-23
options (overview), 8-24

arm16c, 8-23
assembler, setting options, 6-6
assembler controls, overview, 4-16
assembler directives, overview, 4-14
assembler error messages, 6-9
assembler options, overview, 6-6
assembly, programming in C, 3-20
assembly expressions, 4-7
assembly functions, 3-37
assembly syntax, 4-3
auto_switch, 3-31

B
backend

compiler phase, 5-5
optimization, 5-5

board specification, 7-22
build, viewing results, 2-17
bus definition, 7-22

C
ccall to jump optimization, 5-9
ccm16c, 8-4
CCM16COPT, 8-8
character, 4-4
client, A-3
coalescer, 5-8, 5-9
code checking, 5-16
code generator, 5-5
common subexpression elimination,

5-7
compaction, 5-7
compile, 2-17
compiler

invocation, 5-10
optimizations, 5-5
setting options, 5-11

compiler error messages, 5-18
compiler options, overview, 5-11, 5-12
compiler phases

backend, 5-4
code generator phase, 5-5
optimization phase, 5-5
peephole optimizer phase, 5-5

frontend, 5-4
optimization phase, 5-4
parser phase, 5-4
preprocessor phase, 5-4
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scanner phase, 5-4
conditional assembly, 4-26
conditional jump reversal, 5-8
configuration

EDE directories, 1-7
UNIX, 1-9

constant propagation, 5-7
continuation, 4-18
control flow simplification, 5-7
control program, 8-4

invocation, 8-4
options (overview), 8-5

control program options, overview,
8-5, 8-24

controls, 4-4
copy table, compression, 7-10
creating a makefile, 2-13
CSE, 5-7

D
daemon, A-3
data types, 3-10

bit, 3-12
dead code elimination, 5-8
debug log file, A-4, A-27, A-34
delete duplicate code sections, 7-10
delete duplicate constant data, 7-10
delete unreferenced sections, 7-10
derivative definition, 7-21
directive, conditional assembly, 4-26
directives, 4-4
directories, setting, 1-7, 1-9

E
EDE, 2-3

build an application, 2-17
create a project, 2-11
create a project space, 2-10
rebuild an application, 2-18

specify development tool options,
2-14

starting, 2-8
ELF/DWARF, archiver, 8-23
ELF/DWARF2 format, 7-8
Embedded Development Environment,

2-3
environment variable

CCM16COPT, 8-8
LM_LICENSE_FILE, 1-18

environment variables, 1-9
ASM16CINC, 1-9
CCM16CBIN, 1-9
CCM16COPT, 1-9
CM16CINC, 1-9
LIBM16C, 1-9
LIBR8C, 1-9
LM_LICENSE_FILE, 1-10, A-6
PATH, 1-9
TASKING_LIC_WAIT, 1-10
TMPDIR, 1-10

error messages
assembler, 6-9
compiler, 5-18
linker, 7-38

errors, FLEXlm license, A-41
expression simplification, 5-7
expressions, 4-7

absolute, 4-7
relative, 4-7
relocatable, 4-7

F
FAQ, FLEXlm, A-45
feature, A-3
file extensions, 2-6
first fit decreasing, 7-9
flash utility, 8-27

invocation, 8-27
options (overview), 8-28

flashm16c, 8-27
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Flexible License Manager, A-1
FLEXlm, A-1

borrow floating licenses, A-10, A-49
debug log file, A-34
FAQ, A-45
frequently asked questions, A-45
license administration tools, A-8

for Windows, A-31
license errors, A-41
options file, A-7

floating license, 1-12
flow simplification, 5-7
formatters

printf, 3-45
scanf, 3-45

forward store, 5-8
frontend

compiler phase, 5-4
optimization, 5-4

function, 4-11
syntax, 4-11

function qualifiers
__asmfunc, 3-37
__bankswitch, 3-40
__frame, 3-41
__interrupt, 3-39
__interrupt_fixed, 3-39

functions, 3-32
inline, 3-34
parameter passing, 3-32
return types, 3-33

H
hostid, determining, 1-19
hostname, determining, 1-20

I
IEEE 32-bit single precision format,

3-11
IEEE 64-bit double precision format,

3-11
include files

default directory, 5-15, 6-8, 7-17
setting search directories, 1-7, 1-9

incremental linking, 7-18
initialized variables, 3-30
inline assembly, 3-25

__asm, 3-20
inline functions, 3-34
inlining functions, 5-7
input specification, 4-3
installation

licensing, 1-12
Linux, 1-4

Debian, 1-5
RPM, 1-4
tar.gz, 1-5

UNIX, 1-6
Windows 95/98/XP/NT/2000, 1-3

instructions, 4-4
Intel-Hex format, 7-8
interprocedural register optimization,

5-8
interrupt frame, 3-41
interrupt function, 3-38
interrupt service routine, 3-38

defining, 3-39
intrinsic functions, 3-36
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J
jump chain, 3-31
jump chaining, 5-8
jump table, 3-31
jump_switch, 3-31

L
labels, 4-3, 4-6
libraries

rebuilding, 3-46
setting search directories, 1-8, 1-9

library, user, 7-14
library maintainer, 8-23
license

floating, 1-12, A-3
node-locked, 1-12, A-3
obtaining, 1-12
wait for available license, 1-10

license file, A-4, A-5
default location, A-6
location, 1-18
setting search directory, 1-10

license manager, A-4
licensing, 1-12
linear_switch, 3-31
linker, optimizations, 7-9
linker error messages, 7-38
linker options, overview, 7-12
linker output formats

ELF/DWARF2 format, 7-8
Intel-Hex format, 7-8
Motorola S-record format, 7-8

linker script file, 7-8
architecture definition, 7-21
board specification, 7-22
bus definition, 7-22
derivative definition, 7-21
memory definition, 7-22
processor definition, 7-22

section layout definition, 7-23
linker script language (LSL), 7-8, 7-19

internal memory, 7-26
on-chip memory, 7-26

linking process, 7-4
linking, 7-6
locating, 7-7
optimizing, 7-9

list file, generating, 6-8
LM_BORROW, A-10
LM_LICENSE_FILE, 1-18, A-6
lmborrow, A-10
lmdiag, A-12
lmdown, A-14
lmgrd, A-16
lmhostid, A-18
lmnewlog, A-20
lmpath, A-21
lmremove, A-22
lmreread, A-23
lmstat, A-25
lmswitch, A-27
lmswitchr, A-29
lmver, A-30
local label override, 4-25
lookup table, 3-31
lookup_switch, 3-31
loop transformations, 5-8
lsl, 7-19

M
macro, 4-4

argument concatenation, 4-22
argument operator, 4-22
argument string, 4-24
call, 4-21
conditional assembly, 4-26
definition, 4-19
dup directive, 4-26
local label override, 4-25
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return decimal value operator, 4-23
return hex value operator, 4-23

macro argument string, 4-24
macro operations, 4-19
macros, 4-19
macros in C, 3-28
make utility, 8-9

.DEFAULT target, 8-14

.DONE target, 8-14

.IGNORE target, 8-14

.INIT target, 8-14

.PRECIOUS target, 8-15

.SILENT target, 8-14

.SUFFIXES target, 8-14
conditional processing, 8-21
dependency, 8-13
else, 8-21
endif, 8-21
exist function, 8-21
export line, 8-22
functions, 8-20
ifdef, 8-21
ifndef, 8-21
implicit rules, 8-16
invocation, 8-11
macro definition, 8-11
macro MAKE, 8-18
macro MAKEFLAGS, 8-18
macro PRODDIR, 8-18
macro SHELLCMD, 8-19
macro TMP_CCOPT, 8-19
macro TMP_CCPROG, 8-19
makefile, 8-9, 8-12
match function, 8-20
nexist function, 8-21
options (overview), 8-11
predefined macros, 8-18
protect function, 8-20
rules in makefile, 8-15
separate function, 8-20
special targets, 8-14

make utility options, overview, 8-11

makefile, 8-9
automatic creation of, 2-13
updating, 2-13
writing, 8-12

memory definition, 7-22
memory models, 3-19

large, 3-19
medium, 3-19
small, 3-19

memory qualifiers, 3-12
__bita, 3-13
__far, 3-13
__near, 3-13
__paged, 3-13
__rom, 3-13, 3-30
__sfr, 3-13

memory type qualifiers, 3-13
MISRA C, 5-16
mkm16c. See make utility
Motorola S-record format, 7-8

N
node-locked license, 1-12

O
operands, 4-5
opimizations, size/speed trade-off, 5-9
optimization (backend)

call to jump, 5-9
coalescer, 5-8, 5-9
interprocedural register optimization,

5-8
loop transformations, 5-8
peephole optimizations, 5-9
subscript strength reduction, 5-8

optimization
backend, 5-5
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compiler, common subexpression
elimination, 5-7

frontend, 5-4
optimization (frontend)

compaction, 5-7
conditional jump reversal, 5-8
constant propagation, 5-7
control flow simplification, 5-7
dead code elimination, 5-8
expression simplification, 5-7
flow simplification, 5-7
forward store, 5-8
inlining functions, 5-7
jump chaining, 5-8
reverse inlining, 5-7
switch optimization, 5-7

optimizations
compiler, 5-5
compress ROM image, 7-10
copy table compression, 7-10
delete duplicate code sections, 7-10
delete duplicate constant data, 7-10
delete unreferenced sections, 7-10
first fit decreasing, 7-9

P
parameter passing, 3-32
parser, 5-4
peephole optimization, 5-5, 5-9
pragmas, 3-27

inline, 3-35
noinline, 3-35
smartinline, 3-35

predefined macros in C, 3-28
__CM16C__, 3-29
__CPU__, 3-29
__DSPC__, 3-29
__M16C__, 3-29
__R8C__, 3-29
__SINGLE_FP__, 3-29
__TASKING__, 3-29

printf formatter, 3-45
processor, selecting a core, 5-10, 6-5
processor definition, 7-22
project, 2-7

add new files, 2-12
create, 2-11

project file, 2-7
project space, 2-7

create, 2-10
project space file, 2-7

Q
quality assurence report, 5-17

R
rebuilding libraries, 3-46
register allocator, 5-5
register bank switching, 3-40
register usage, 3-32, 3-33
registers, 4-5, 4-6
relocatable object file, 7-3

debug information, 7-6
header information, 7-6
object code, 7-6
relocation information, 7-6
symbols, 7-6

relocation expressions, 7-7
reserved symbols, 4-6
return decimal value operator, 4-23
return hex value operator, 4-23
reverse inlining, 5-7
rom, 3-13
ROM image, compression, 7-10
ROM monitor, 2-16
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S
scanf formatter, 3-45
scanner, 5-4
section layout definition, 7-23
section names, 3-42
sections, 3-42, 4-17

absolute, 4-18
activation, 4-18
cleared, 4-19
definition, 4-17

server node, A-4
software installation

Linux, 1-4
UNIX, 1-6
Windows 95/98/XP/NT/2000, 1-3

special function registers, define, 3-16
statement, 4-3
storage types. See memory qualifiers
string, 3-30

substring, 4-8
subscript strength reduction, 5-8
substring, 4-8
switch, restore, 3-31
switch optimization, 5-7
switch statement, 3-31
symbol, 4-6
synchronize options with ROM

monitor, 2-16
syntax of an expression, 4-7

T
Tasking vendor daemon, A-3
temporary files, setting directory, 1-10
transferring parameters between

functions, 3-32

U
updating makefile, 2-13
utilities

archiver, 8-23
arm16c, 8-23
ccm16c, 8-4
control program, 8-4
flash utility, 8-27
flashm16c, 8-27
make utility, 8-9
mkm16c, 8-9

V
variables, initialized, 3-30
vendor daemon, A-3
verbose option, linker, 7-17
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